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Notice

This manual is published by Akoya Biosciences, Inc. The information in this document is subject to change without notice
and should not be construed as a commitment by Akoya Biosciences, Inc. Akoya assumes no responsibility for any errors
that may appear in this document. This manual is believed to be complete and accurate at the time of publication. In no
event shall Akoya Biosciences be liable for incidental or consequential damages in connection with or arising from the use
of this manual.

This manual describes how to use inForm software.

For more information contact:

Akoya Biosciences, Inc.
100 Campus Drive, 6th Floor
Marlborough, MA 01752, USA

Phone: +1 855-896-8401 
Fax: +1 855-404-0061 
Email: CustomerCare@akoyabio.com 
Email (outside the US): CustomerCareEMEA@akoyabio.com
Web site: http://www.akoyabio.com

This software covered by US Patent 7,555,155; 7,953,264; 8,280,140; 8,639,043; 10,126,242 and patents pending.
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1 Welcome to inForm
Akoya's inForm® advanced image analysis software has been developed to address the biggest
challenge facing microscopists once quantitative imagery has been acquired: extracting data. The
challenge increases when dealing with multiplexed assays, since signals can be weak and highly mixed.
inForm provides a powerful and fast solution with an intuitive, easy-to-use software interface. What might
have been impossible or have taken days can now be done in minutes.

inForm solves challenging image analysis problems by combining fast and easy learn-by-example
automated image processing with object recognition and data analysis tools. It is based on machine
learning, which means that you can train the program to create an effective solution by simply selecting
examples of what you want to find within the images. inForm then creates an algorithm that you can
subsequently apply across the entire image or across as many images as you want.

Akoya's multispectral images and industry-standard RGB images, including TIFF files generated using
the Akoya Biosciences Quantitative Pathology Imaging and Slide Scanning systems, can be read and
analyzed by inForm.

inForm is for research use only. Not for use in diagnostic procedures.

Getting started – new users

Ø Be sure to review the topics in the Introduction  to familiarize yourself with the features and
specifications of the software.

7
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2 Introduction
The topics in this section provide basic information about inForm, what it is for, and what you can do with
it.

How to get started

Ø See About inForm  for a general overview of the software
features and specifications.

Ø See Software Configurations  to review the available software
configurations and the capabilities of each configuration.

Ø Review Understanding the inForm Work Area  to familiarize
yourself with the program. 

Ø Read through Common Image Analysis Tasks  to familiarize
yourself with the basic capabilities of inForm.

Ø Refer to Key Terms  to view definitions of terms used with
inForm.

Other Information

Ø Find out how to Contact Akoya Bioscience  to place an order
or receive technical assistance.

2.1 About inForm

inForm operates on monochrome, color, or multispectral images of tissue sections. Sections can be
stained with standard stains, immunohistochemical stains (IHC), and immunofluorescence stains (IF,

including Qdot®). Stains can be single or multiplexed up to 40 markers for multi-analyte analyses to
support applications such as signaling pathway research in oncology.

inForm is available in different configurations, each providing additional capabilities for different
applications. 

· inForm Tissue Finder can be trained to find virtually any tissue type or structure, such as tumor,
fibrosis, inflammation, stroma, granuloma or vessels. 

· inForm Cell Analysis can be used to assess IHC or IF staining levels, on a cell-by-cell basis, for cell
prototyping. It can also generate object counts.

· inForm Viewer can visualize component data, and reconstruct the unmixed signals into a composite
image.

7
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Features

Ø Compatibility with Akoya's digital slides (.qptiff) up to 40 channels,  Akoya's multispectral images
(.im3) and with conventional color images (.tif, .jpg, etc.).

Ø Full range of software configurations which can include capabilities from simple tissue area
measurements to cell-as-a-unit multiplexed molecular phenotyping. To view the levels of inForm
and the capabilities of each level, see Software Configurations .

Ø Computationally efficient; runs on a standard laptop. 

Specifications

ØOperates on Akoya Biosciences multispectral images (.im3), digital slides (.qptiff) up to 40
channels, and monochrome or color images (TIFF, BMP, JPEG, PNG)

ØComputer Specifications: Microsoft® Windows® 10, 64-bit with 32GB RAM recommended. 

(Minimum: Microsoft® Windows® 10, 64-bit with 8GB RAM)

9
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2.2 Software Configurations

inForm is available in the following software configurations. Each configuration enables specific tasks for
viewing, selecting, segmenting, and counting.

The following inForm software configurations are available:

Viewer

inForm Viewer includes the following features:

· View images

· Unmix images

· View components and their signals

· View a composite of the component images

· Export images

Cell Analysis

inForm Cell Analysis includes all of the features available in inForm Basic Analysis, plus the following
features:

· Manually segment tissue

· Create threshold maps

· Create colocalization maps

· Generate quantitative data for threshold and colocalization maps 

· Save projects and algorithms

· Batch process images

· Export data tables

· Use cell segmentation to identify cells and cellular compartments

· Assign phenotypes to segmented cells

· Score segmented cells

· Use object segmentation to identify objects
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Tissue Finder

inForm Tissue Finder includes all of the features available in inForm Cell Analysis, plus the following
features:

· Train the Tissue Segmenter to automatically identify tissue categories 

· Automatically segment the image into tissue categories

· Merge data files from a set of images or slides into summary data files

Steps Available in Each Software Configuration

The table below specifies which algorithm steps and software features are available in each software
configuration.

Viewer Cell Analysis Tissue Finder

Prepare Images X X X

Manual Tissue Segmentation X X

Trainable Tissue Segmentation X

Threshold X X

Colocalization X X

Cell Segmentation X X

Object Segmentation X X

Phenotyping X X

Score (only used with Cell Segmentation) X X

Export X X X

Batch Processing X X

Review/Merge X
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2.3 Key Terms

The followingtab;e lists key tersm that are core to using the inForm software. Refer to the terms below
when using the software.

Algorithm Algorithms include all steps in processing an image, from image preparation,
tissue segmentation and/or cell segmentation, object counting or scoring, to
export. Algorithms may also include threshold or colocalization settings,
depending on the project created to analyze the images.

Processing
Region

Processing regions are user-drawn regions of interest. Use processing regions to
only process specific regions on an image. All areas outside of the marked
processing regions are ignored.

Processing Set A set of images that will be processed using the settings in the Manual Analysis
tab. Images in the processing set display a green square on the image thumbnail
when viewing images in Single mode. All images added to a project are included
in the processing set by default. To add or remove images from the processing
set, right-click the large image in the image display area and click Processing
Set. You can also click the Image List Editor button to open the Available Images
window and then click the Load Images button.

Project inForm projects include the images that were added to the project and the
settings for each step in the algorithm. A new project that contains only the
Prepare Images and Export Step is automatically created when opening inForm.
You can work in the new default project, create a new project, or open a saved
project.

Spectral Region Spectral regions are user-drawn regions that identify autofluorescence on an
image. Spectral regions can be used to create inForm spectral libraries that are
exported for use with Lamina systems.

Tissue Category Tissue Categories identify structures such as tumor cells vs. healthy cells that
are present in the tissue samples. Regions in the image can be marked manually
using inForm Basic Analysis or higher. Use inForm Tissue Finder to use the
Tissue Segmenter to automatically classify tissue.

Tissue
Segmenter

The Tissue Segmenter automatically identifies regions of tissue or regions that
correspond to specific types of tissue. When you “train” a tissue segmenter, it
learns how to identify structures in the images based on the training regions
within each tissue category. The tissue regions or areas detected with the tissue
segmenter can then be segmented to detect cells and perform IHC or IF scoring,
or can be used for object counting. Only available with inForm Tissue Finder.

Training Set The set of images used to train the Tissue Segmenter to identify tissue categories
automatically. Images are automatically added to the training set if a training
region is drawn on the image. To remove an image from the training set, right-click
the large image in the image display area and click Training Set. When an image
is removed from the training set, the training regions on the image are not used
when training the Tissue Segmenter. (The training regions are not deleted from the
image, so the image can be added back to the training set if desired.) You can
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also use the Available Images window to add or remove images from the training
set.

2.4 Using Online Documentation

This manual contains detailed information about the inForm application. It is designed to be used as a
reference tool in your everyday work with inForm. The manual explains how to use inForm through
detailed explanations of features and step-by-step procedures for common tasks using realistic
scenarios. The PDF file can be read online or can be printed for reference.

inForm also includes complete documentation in an HTML-based help system, which includes all of the
information in this User’s Manual. Online help provides three ways of locating information: Use the
Contents tab to navigate through the document, the Index tab to find topics by keyword, or the Search
tab to look up topics that contain specific words or phrases.

2.5 Installing and Starting inForm

Close all applications that are running before beginning the inForm installation. Installation requires an
administrator account.

Installing the Software:

inForm requires R 3.1.0 and several R packages to be present on the machine prior to installation. If you
have not done so already, please download and install R from the inForm section of the Akoya
Biosciences software downloads site at
https://www.akoyabio.com/support/software/#inform_tissue_analysis_software.

Once R is installed, launch the inForm installer. Follow the wizard prompts to install the software. inForm
requires the Microsoft .NET 4.5 framework. The installer will install Microsoft .NET 4.5 if it is not already
installed. 

The installer asks which fluorophores are commonly in use at your lab. Selecting these choices sets the
defaults for available Measured and Synthetic Spectra. You can change this default in Stain Store
Management . 

Starting inForm:

Select Start > Akoya Biosciences > inForm
OR

double-click the inForm shortcut on the Windows® desktop.

To use any software configuration other than inForm Viewer, see Activating the License .

31
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2.6 Activating the License

After installing inForm, only the options for inForm Viewer are available. The customer license must be
activated to enable any purchased software options. License activation requires an administrator
account.

To activate a customer license:

1. Log into the computer using an account with Windows® Administrator permissions. 

2. Start the inForm Licensing Application. Start > Akoya Biosciences > inForm > inForm
License App

Figure 1. inForm License App

3. Click the Activate button. The Activate the Software window opens.

4. Select the Activate option and click the OK button.

5. Enter your 20 character license number.

6. If available, use the online activation method to complete your activation.

7. If online activation is not available, click the Copy to Clipboard button to copy the text onto the

Windows® clipboard.

8. Email the copied text to the email address shown in the Activation window.

9. Click the Cancel button to close the Activation window.

10. Wait to receive the email that contains the text for the response key.

11. Type or paste the response key from the email into the Activation window and click the OK
button. 

12. Close the license application and start inForm.
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Transferring a Software License

You can transfer the inForm license from one computer to another computer. The same version of inForm
must be installed on both computers. When the license is transferred to the new computer, the license
is removed from the current computer, leaving only the inForm Viewer options.

Transferring a license requires an administrator account on both computers, a USB thumb drive, and an
available USB port on each computer.

Please reach out to support@akoyabio.com for assistance transferring an inForm license from one
computer to another computer.

To transfer the license:

1. Log into the unlicensed computer with an administrator user name and password. 

2. Plug the USB drive into an available USB port on the unlicensed computer.

3. Start inForm.

4. Click the Activate button or select License ® Activate. The Activate the Software License
window opens.

Figure 2. Activate the Software Window

5. Select the Transfer option and click the OK button. The Check Transfer Directory window asks
if you have created a transfer directory.

mailto:support@akoyabio.com


Introduction 15

Figure 3. Check Transfer Directory Window
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6. Click the No button. The Create Transfer Directory window instructs you to create a transfer
directory on the USB flash drive.

Figure 4. Create Transfer Directory Window

7. Click the OK button. The Browse for Folder window opens.

8. Browse to the USB drive and create a new directory. There are no restrictions on the name of
the directory, but choose a name that is easy to identify.

9. Select the name of the new directory and click the OK button. The Transfer License Out window
opens. Leave this window open, DO NOT click the OK button yet.

Figure 5. Transfer License Out Window

10. Remove the USB drive. (Leaving the Transfer License Out window open.)

11. Plug the USB drive into the licensed computer.

12. Start inForm on the licensed computer.

13. Select License ® Transfer ® Transfer Out. The Check Transfer Directory window asks if you
have created a transfer directory.

Figure 6. Check Transfer Directory Window

14. Click the Yes button. The Transfer License window asks if you want to transfer the license.

Figure 7. Transfer License Window

15. Click the Yes button. The Browse for Folder window opens.
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16. Browse to the transfer directory on the USB drive and click the OK button. The License Error
window displays a message that the software was unable to obtain a license.

Figure 8. License Error Window

17. Click the OK button. The inForm software closes.

18. Remove the USB drive from the licensed computer.

19. Plug the USB drive into the unlicensed computer. The Transfer License Out window is still open
on this computer. 

20. Click the OK button. The Transfer License In window opens.

Figure 9. Transfer License In Window

21. Click the OK button. The Browse for Folder window opens.

22. Browse to the transfer directory, select the directory name, and click the OK button.

23. The license is copied to the unlicensed computer and the Restart Required window opens.

Figure 10. Restart Required Window

24. Click the OK button. The inForm software restarts with the licensed options available.
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2.7 Contacting Akoya Biosciences

For more information, contact Akoya Biosciences or your local authorized distributor:

Akoya Biosciences, Inc.

100 Campus Drive, 6th Floor

Marlborough, MA 01752, USA

Technical Support:

Phone: +1 855-896-8401

Fax: +1 855-404-0061

Akoya Biosciences Web Site: http://www.akoyabio.com

Email: CustomerCare@akoyabio.com

Email (Outside the US): CustomerCareEMEA@akoyabio.com

http://www.akoyabio.com
mailto:customercare@akoyabio.com
mailto:CustomerCareEMEA@akoyabio.com
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3 Understanding the inForm Work Area
The inForm work area contains the step bar, process editor panel, image display toolbar, and image
display area. The example below shows the Manual Analysis tab with a brightfield image that has been
segmented into two tissue categories.

Figure 11. inForm Work Area with an unmixed composite image from a multiplexed fluorescence
slide.

A. Step Bar

The Step bar displays an icon for each processing step included in the project that is open in the
Manual Analysis tab. The Step bar only displays when the Manual Analysis tab is selected. A new
project is automatically created when inForm opens. By default, the new project only includes the
Prepare Images and Export steps. To create a new project with additional steps, see Creating
Projects . To add, remove, or change the steps in the open project, see Configure a Project . 

Click the icons in the step bar at the top of the work area to display the settings for each step in the
Manual Analysis tab. For example, click Prepare Images to display the Image Preparation Settings
panel in the Manual Analysis tab; click Export to display the Export Settings panel.

Configure button - Opens the Configure Project window to change the steps in the

current project. See Creating Projects  for instructions. Vectra® Tissue Finder and
Vectra HPF Finder projects cannot be configured.

Prepare Images - Use to specify the image format and sample format, change the
image resolution, load a spectral library, convert images to optical density, and unmix
images. See Preparing Images  for instructions.

41 41

41
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Manual Classification - Use to create tissue categories and manually draw tissue
regions on the images in the project. Exported data includes position, shape, and
component signal statistics for each segmented tissue region. See Manual Tissue
Segmentation  for instructions. This feature is available with inForm Basic Analysis or
higher.

Segment Tissue - Use to train the automated tissue segmenter and automatically
segment the images. Exported data includes position, shape, and component signal
statistics for each segmented tissue region. See Trainable Tissue Segmentation  for
instructions. This feature is only available with inForm Tissue Finder.

Threshold - Use to create and analyze threshold maps. Exported data includes
position, shape, and component signal statistics for each thresholded region. See
Threshold  for instructions. This feature is available with inForm Basic Analysis or
higher.

Colocalize - Use to create and analyze colocalization maps. Exported data includes
position, shape, and component signal statistics for the colocalization region, as well as
position, shape, and component signal statistics for the underlying component regions.
See Colocalization  for instructions. This feature is available with inForm Basic
Analysis or higher.

Segment Cells - Use to segment cell nuclei and optionally segment cytoplasm and
membrane. Exported data includes position, shape, and component signal statistics for
each segmented cell. See Segmenting Cells  for instructions. This feature is available
with inForm Cell Analysis or higher.

Phenotype Cells - Use to create a phenotyping algorithm that can automatically
phenotype cells after segmentation. See Phenotyping Cells for instructions. This feature
is available with inForm Cell Analysis or higher.

Score IHC or IF - Use to quantify IHC or IF staining levels in segmented cells. The
tools provided are intended to automate visual assessment (Positivity, 0-3+, 10-bin, 50-
bin, and Double Positivity) and to provide histogram data of staining levels. Exported data
includes the score for each selected cell compartment. See Scoring IHC or IF  for
instructions. This feature is available with inForm Cell Analysis or higher.

Count Objects - Use to segment objects other than cells. Exported data includes the
position, shape, and component signal statistics for each segmented object. See
Counting Objects  for instructions. This feature is available with inForm Cell Analysis
or higher.

Export - Use to select the export directory, the images to export, the data to export,
and the file name options. See Exporting the Data  for instructions.

B. Manual Analysis Tab

The Manual Analysis tab on the left displays the settings for each step. Use these panels to select
the settings for the algorithm or project. These settings can only be edited when viewing a single
image, and not while viewing images in Gallery mode. See also Image Display Area .

65
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C. Toolbar

The toolbar enables you to adjust the image zoom level, draw processing regions, draw training
regions, and adjust the view settings. The tools available on the toolbar change based on the current
processing step. The toolbar displays in the Manual Analysis tab.

Select: Return the cursor to the default pointer mode. Click and drag to pan around the
image. Use the mouse wheel to zoom in and out at the cursor location.

View Data: Hover over the image to display the signal intensity of each component at
any location, as well as any object information at that location.

Zoom In: Click on the image to re-center the image and to zoom in. Click and drag to
zoom in on a specific region of the image.

Zoom Out: Click on the image to re-center the image and to zoom out. Double-click the
on image with this tool to return magnification to 100%.

Zoom to Full: Click to view the image at 100%.

Pan: Click and drag the image to view the desired region in the window.

Draw Processing Regions: Click and drag to outline the desired processing region.
Only the areas of the image within the processing regions are analyzed.

Draw Region of Disinterest: Click and drag to outline an area to ignore within the
image. This area will not be processed.

Delete a Region: Click inside a processing region, region of disinterest, or training
region to remove the region.

Draw Training Regions: Click and drag to identify regions of the image that represent
the selected tissue category when training the tissue segmenter. This tool selects
automatically when you select a tissue category from the category list. When in draw
mode, you can continue drawing training regions. Only available during the Segment
Tissue step.

Draw Classification Regions: Click and drag to identify regions of the image that
contain the selected tissue category. Only available during the Manual Classification
step.

Edit the Tissue Segmentation: Click the button to select the tissue category and then
click and drag to manually draw the selected tissue category over an area. After
segmenting the images, inspect the images to make sure the tissue regions are
segmented as you intended. If areas are under the wrong masks (the tumor mask over
non-tumor cells, for example), use this tool to draw the desired mask over an area. Only
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available during the Segment Tissue step. Select Clear Edits to clear all manual edits to
the tissue masks.

Select Regions to Unclassify: Click and drag to outline the area on the image to
unclassify. Only available during the Manual Classification step.

Select Pixels to Unclassify: Click and drag over the specific pixels to remove from the
classification region. Only available during the Manual Classification step.

White Picker: Click a white area on a Brightfield image to select the white background
spectra prior to converting the image to OD (optical density). Available only during the
Prepare Images step.

Autofluorescence Picker: Click and drag on an area of autofluorescence in the image to
add autofluorescence to the spectral library. Available only during the Prepare Images
step when creating a spectral library.

Spectral Curves: Hover over an area to see the spectral curve of that particular pixel.
Available only during the Prepare Images step when the Spectral Library Window is
open, and in the Build Libraries tab.

Add to Thresholded Regions: Click the button to select the desired unmixed
component and then click and drag to outline the area on the image to be added to the
selected threshold map. Only available during the Threshold step.

Erase Thresholded Regions: Click the button to select the desired unmixed component
and then click and drag to outline the region to remove from the threshold map. Only
available during the Threshold step.

Edit Phenotypes: Click on a segmented cell to assign a phenotype. Available only
during the Phenotype Cells step.

Color Button: Click to select the conventional color view of your image. It performs the
same function as selecting Color Image from the Data Displayed drop-down menu in the
View Editor.

Component Button: Click to select the which unmixed component to view from a drop-
down list. If inForm can identify a DAPI or hematoxylin counterstain, it will display the
component as a conventional brightfield IHC stain on a hematoxylin counterstain. As a
convenience, the up and down arrow keys on your keyboard let you switch rapidly
amongst each component in the display window.

Composite Button: Click to select the composite image of the unmixed fluorescence
image in the Image Display Area. See Displaying the Extracted Data  for more detailed
information on viewing your color and unmixed component images.

View Editor: Click to open the View Editor Window  to choose the type of image or
table to view and to change the display settings. You can also view or hide cells, masks,

109
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and regions. Buttons to quickly show or hide image maps are available on the left side of
the image display area.

Show/Hide Map Options: Click to show or hide the image maps. You can show or hide
segmentation maps, training regions, and processing regions. (Most Show/Hide options are also
available on the View Editor .) The buttons include:

 Tissue Segmentation Map - Click to show/hide the Tissue Segmentation Map.

 Nuclear Segmentation Map - Click to show/hide the Nuclear Segmentation Map.

 Cytoplasm Segmentation Map - Click to show/hide the Cytoplasm Segmentation Map.

 Membrane Segmentation Map - Click to show/hide the Membrane Segmentation Map.

 Phenotype Map - Click to display a menu which allows you to show/hide individual

phenotypes.

 Training Regions - Click to show/hide the Training Regions.

 Processing Regions - Click to show/hide the Processing Regions.

 Spectral Regions - Click to show/hide the Autofluorescence Regions.

  Legend - Click to show/hide the Legend of Components in view.

25
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D. Image Display Area

 

The image display area in the Manual Analysis tab has two modes -- Single and
Gallery. 

· Single mode displays one image in the large Image area, and displays a row of
thumbnails of all other open images below the large image. The image name and
current display are listed below. Click any thumbnail to view the image in the
display area. A blue square on a thumbnail indicates that the image is included in
the training set; a green square indicates the image is in the processing set. The
Algorithm settings in the left-hand panel can only be edited in Single mode. 

· Gallery mode displays all the project images in the large Image area. Use the
Image Size slider at the top of the workspace to adjust the number of open images
shown in the image display area. In Gallery mode, all Algorithm settings are read-
only. Gallery mode is for image and table review only; you cannot edit the Algorithm
settings in this mode.

Right-Click Shortcut Menu

The following actions are accessible by right-clicking on an image in the Image
Display area:

· Save: Saves a copy of the image (as shown in the Image Display Area) to a file in
the selected format (.tif, .jpg, .png, .gif, or .bmp). (Default is the last selected image
format.)

· Delete Region: Deletes the region that you right-clicked on. (Only available if you
right-clicked on a region.)

· Delete Regions: Provides options to delete all training regions, all processing
regions, or both, from an image. (Only available if training regions and/or processing
regions have been created on the image.)

· Show Regions: Provides options to show/hide all training regions, processing
regions, or both, on an image.

· Processing Set: Adds or removes the image from the processing set. If checked,
the image is included in the processing set. If cleared, the image is not included in
the processing set. Click the option to toggle the check mark.

· Training Set: Adds or removes the image from the training set. If checked, the
image is included in the training set. If cleared, the image is not included in the
training set. Click the option to toggle the check mark. Only displays if training
images have been drawn on the image. (Draw training regions on the image or use
the Available Images Window  to add images without training regions to the
training set.)

· View Editor: Opens the View Editor  to select the display options.

· Remove from Project: Removes the image from the project.
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E. Batch Analysis Tab

After a suitable project or algorithm for processing images has been created, validated, and saved,
use the Batch Analysis tab to process large numbers of images. Use the Batch Analysis Editor
to select a project or an algorithm for batch processing, select export directory/folder preferences,
and select the image/table options. (This feature is available with inForm Basic Analysis or higher.) 

F. Review/Merge Tab

After completing a batch run, which often generates large numbers of output files, use the
Review/Merge Editor  to combine the data from multiple output files into a single file for detailed
and quantitative analysis. The Review/Merge Editor  has tools to filter out data from samples that
are inadequately prepared, stained, and/or segmented, so that merged data sets are reliable. (This
feature is only available with inForm Tissue Finder.) 

G. Build Libraries

The Build Libraries  tab allows you to characterize stains and fluorophores by extracting the pure
spectral information from them and adding them to the Stain Store. This allows you to build up your
libraries of spectral data and easily separate multiplexed stains and fluorophores in single tissue
sections. Stains and fluorophores in the Stain Store may be re-used with new images, so long as
the images are from specimens that were prepared and imaged in the same manner.

3.1 View Editor

Use the View Editor to select the display options for images or data tables after processing. The images
and data tables available are determined by the steps in the project. The steps available are determined
by the inForm license. This section lists the views that are available for each software configuration. For
definitions of the options, see Displaying the Extracted Data . To open the View Editor, click the View
Editor button on the image toolbar.
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Views Available In Viewer

Color Image - Shows the original color
image plus the regions selected in the
Image Options.

Component Image - Shows an image of a
single unmixed component.

Composite Image - Shows a reconstructed
image of components selected for viewing. 

Figure 12. Views Editor

Views Available In Cell Analysis

Includes all views in Viewer plus:

Tissue Segmentation Data - This table is available when an algorithm contains a manual
segmentation step. The table provides information on the manually segmented tissue regions.
(See Viewing the Tissue Segmentation Data Table  for detailed information.) 

Quant Data - This table is available when an algorithm contains a threshold or colocalization
step. The table provides information on the thresholded regions. (See Viewing the Quant Data
for detailed information.)

Colocalization Data - These tables are available when an algorithm contains a colocalization
step. (See Viewing the Colocalization Data  for detailed information.) There are three tables:

· Colocalization Table - Shows colocalization data of the selected components and positivity
data for each selected component.

· In Channel Table - Shows the positivity of one component within another for all selected
colocalization components.

· Quant Table - Shows stats for the whole image and colocalization region.

Cell Segmentation Data - This table is available when an algorithm contains a cell
segmentation step. The table provides information on the segmented cells. (See Viewing the Cell
Segmentation Data  for detailed information.) If the algorithm contains a phenotyping step, this
table will contain the cell's phenotype information.
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Object Segmentation Data - This table is available when an algorithm contains an object
segmentation step. The table provides information on the segmented objects. (See Viewing the
Count Data  for detailed information.)

Score Data - This table is available when an algorithm contains a score step. The available data
changes depending on the type of scoring (positivity, 0-3+, 10-bin, 50-bin, and Double Positivity).
(See Viewing the Score Data  for detailed information.)

Views Available In Tissue Finder

Includes all views in Cell Analysis. Tissue Segmentation data displays in the Tissue
Segmentation Table. (See Viewing the Tissue Segmentation Data  for detailed information.)

3.2 Available Images Window

Use the Available Images Window to view a list of
all images in the project and to add images to or
remove images from the processing set or the
training set. (The training set is only supported in
inForm Tissue Finder when training the Tissue
Segmenter.) Access this via Tools > Image List
Editor.

To load additional images into the project, click
the Load Image button. The new images must be
compatible with the Prepare Images settings in
the current project. New images must have the
same spectral wavelength characteristics as the
existing images in the project.

To remove an image, right-click the image name
and click the Remove button.

Figure 13. Availab le Images Window
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3.3 New Project Window

Use the New Project Window to select the steps to include in the project. Certain steps are only
available if a software option has been purchased and installed. (For available software configurations,
see Software Configurations ).

Figure 14. New Project Window

The New Project window contains the following options and buttons:

Prepare Images - Required for all projects. Specifies the Image Format and Sample format, changes
the image resolution, loads a spectral library, unmixes the spectral components, and removes haze from
the images. See Preparing Images  for details.

Segment Tissue - Segment the image into specific tissue categories.

· Manual Tissue Segmentation - Tissue categories are manually drawn on each image. See
Manual Tissue Segmentation  for details.

· Trainable Tissue Segmentation - The tissue segmenter is trained to identify different tissue
types in the images. Processing the images automatically assigns the appropriate tissue
categories. See Trainable Tissue Segmentation  for details.

Find Features - Find features in the images using thresholds or segmentation algorithms.

· Adaptive Cell Segmentation - Identifies individual cells or subcellular objects in the image using
an adaptive thresholding method. This algorithm is best suited for fluorescence imagery with
membrane staining. See Segmenting Cells  for details.

· Cell Segmentation - Identifies individual cells or subcellular objects in the image using either
thresholded or algorithmic segmentation. See Segmenting Cells  for details.

· Object Segmentation - Identifies objects on an image using either thresholded or algorithmic
segmentation. See Counting Objects  for details.
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· Colocalization - Identifies regions on an image where multiple unmixed component thresholds
overlap. Threshold values for each component are specified individually. See Colocalization  for
details.

· Threshold - Identifies regions on an image where a component is above a specific threshold. See
Threshold  for details.

Phenotyping - Assign phenotypes to cells.

· Phenotyping - Train a phenotyping algorithm by assigning a few cells to each phenotype.
Processing the images will automatically assign phenotypes to the remaining cells. See
Phenotyping Cells for details.

· Rules-Based Phenotyping - Use a predefined algorithm that assigns phenotypes based on

signals and exclusion rules. Available only when phenotyping the MOTiFTM Opal PD-a/PD-L1 Lung
and Melanoma Panel kits.

Score - Score cells based on intensity thresholds.

· Scoring - Scores the segmented nuclei, cytoplasm, and/or membrane to count the percent
positive of a specific component above a specified threshold. See Scoring IHC or IF  for details.

Export - Save the table data and imagery

· Export - Required for all projects. Specifies the export settings for images and data tables after
processing is complete. See Exporting the Data  for details.

3.4 Spectral Library Window

Use the Spectral Library window to view graphs of the emission spectral curve for each stain selected for
unmixing. Viewing the spectral library can help when troubleshooting unexpected unmixing results.
Ideally, the spectra should be easily distinguishable in each of the imaging bands. Typically, one filter is
used for each stain. If the Spectral Library uses multiple filters, one graph displays for each filter. The
figure below shows a spectral library with DAPI, CY3, and CY5 with good separation in each graph. The
Spectral Library window updates dynamically if the Image Preparation Settings are changed. 

To open this window, click the View button under the Spectral Library list box in the Prepare Images
step after selecting a spectral library.
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Figure 15. Spectral Library with multiple filters

Spectral Library Name: If a Nuance spectral library is loaded, displays the name of the current spectral
library above the chart. The spectral library name is not displayed when an inForm spectral library is
loaded.

Chart: The spectral library display can contain multiple graphs; one graph for each imaging band. Each
graph displays the spectral segments within an imaging band. If there is only one data point in each
band, all of the spectral segments display in one graph. Brightfield images only have one imaging band,
so only one graph displays. After loading a library, select the check boxes for the spectra you want to
use for unmixing in the Prepare Images step. The Spectral Library window automatically updates to show
only the selected spectra. Hovering over the line in a spectral curve displays the name, wavelength (x
value), and signal strength (y value) of the nearest data point. By default, the chart opens with Unmix
Units and Scale to Max (equal scales) selected. 

· X Axis - Spectral wavelength of light in nanometers.

· Y Axis - The units selected in the Units drop-down list.

Units drop-down list - Specifies the units on the Y Axis on the graphs. Only the units valid for the
spectral library are available. For example, if a spectral library does not contain Raw units, the Raw
option is not available.

· Raw Counts - Pixel intensity in unit counts. Typical Fluorescence values are from 0 to 4095.
Typical Brightfield values are from 0 to 255. 

· Unmix Units - Displays the signal used for unmixing. Can show artifacts that are not visible in
other views. Usually the best unit for evaluating a spectral library.

· Normalized for Exposure - Signal is displayed in counts/second. Used to compare signal
strength across bands. (Fluorescence libraries only)

· OD - Optical Density units (Brightfield libraries only)
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Display drop-down list - Specifies the Y Axis scaling option for the graphs.

· Scale to Max (equal scales) - All graphs are scaled to the same value, which is the maximum
signal value in all of the bands.

· Scale to Max (varying scales) - Each graph is scaled individually to the maximum signal unit for
that graph. (This option is not available when there is only one imaging band, when the library is
for a brightfield image, or when the units are OD.)

· Normalized - Each graph is scaled individually on the Y Axis to 1. Additionally, the signals are
scaled so each spectrum has a maximum of 1. (This option is not available when units are Unmix
Units.)

Save Chart Button - Opens the Save Chart window to specify the location, name, and file format for
saving a graphic of the graphs displayed in the Spectral Library window. The chart can be saved as a
.bmp, .gif, .png, .tif or .jpg and saved to a computer or network location. The graphic file includes the
legend.

Legend - Displays the color for each stain in the chart. The colors are selected when the Spectral
Library is created and cannot be changed in this view.

3.5 Stain Store Management

inForm has a set of factory-supplied synthetic fluorophores to choose from, as well as the capability to
store new measured stains and fluorophores from your slides. All stains and fluorophores, synthetic or
measured, can be grouped together under names of your own choosing.

The Stain Store Manager allows you to:

· Create and organize Groups of Stains and Fluorophores

· Designate which types of Stains and Fluorophores Your Lab Uses

· Manage Your Own Measured Spectra

· Manage Your Synthetic Spectra

Go to the top menu bar of inForm and choose: Tools > Stain Store Manager.
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Figure 16. The home screen for the Stain Store Manager allows you to manage your stains and fluorophores
from an intuitive interface, selecting only the stains and fluorophores that you use and allowing you to group

them yourself, eliminating clutter and saving valuable time.

3.5.1 Managing Groups

To make finding the right stain or fluorophore easier, you can arrange them into Groups by clicking on
Manage Groups.  By default there are Groups named Favorites, Synthetic, and Measured present.
These default Groups cannot be deleted, but they can be hidden by making them inactive. You can
create new Groups using the New button, as well as Rename and Delete Groups. Only checked
Groups will appear in the Select Fluors list.
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Figure 17. Manage Groups lets you arrange your stains and fluorophores into convenient
Groups.

3.5.2 Choosing Stains and Fluors

Click Choose Which Types of Stains and Fluors Your Lab Uses in order to select from among a list
of common stains and fluorophores grouped into families. For example, if you only use CY3 and CY5,
you can uncheck CY3.5 and CY5.5 from the list in the Cyanine family. Only checked stains and
fluorophores will appear in the Select Fluors list. This eliminates clutter and can save you time identifying
the choosing the right stains and fluors for your particular experiment.

When the ‘Other (User Specified)’ family name is selected, clicking on the New button lets you add a
new custom stain or fluorophore. Only custom stains and fluorophores can be deleted.

NOTE: You cannot add new Synthetic Spectra. But you can, of course, add new measured
spectra using the New button in the Choose Stains and Fluors window.



34 Akoya Biosciences, Inc.

Figure 18. Stains and fluorophores are arranged by Family or can be seen all at once.
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Figure 19. Adding a new stain or fluorophore can be done from within the Choose Stains and Fluors
window.

See Building Libraries  for details on how you can measure and extract the signal and then save it to

the Stain Store.
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3.5.3 Managing Your Measured Spectra

Clicking on Manage Your Measured Spectra lets you see a list of all of the stains and fluorophores
that you have acquired and measured. Only checked stains and fluorophores will appear in the Stains &
Fluors list. Highlighting a particular stain or fluorophore will display the following characteristics on the
right side of the window:

· Name of the stain or fluorophore

· Groups you have assigned to the spectrum

· Creation Date of the spectrum

· Location of the Source file (.im3)

· Notes that you can include for your own reference

Figure 20. Manage Measured Spectra lets you select the spectra that you have measured.

You can:

· Assign one or more measured spectra to a group or groups

You can assign spectra to existing groups, or you can create a
new group if needed.  Each spectrum can belong to multiple
groups.

· Delete a measured spectrum

Figure 21. Assigning a new group.
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· Locate the original source file from which you took your
measurement, if it is present on your local system

· Import spectra from other inForm algorithms, projects,
and Stain Store export files

To import measured spectra, click the Import button. Browse to the file containing the desired spectra.
You can import from algorithms, projects, and .SSE files previously exported. After opening the file, you
will be able to preview and select the spectra for import. Selected spectra will be added to the Stain
Store and will be available to your projects.

· Export spectral data files

To export, click the Export button and select one or more measured spectra. You can save an .SSE file
containing the spectra to a location of your choice. This can be very useful if you have done work on a
single inForm workstation to develop ideal spectra for your experiment and then want to deploy the same
spectra to multiple inForm workstations.

NOTE: You cannot export synthetic spectra

3.5.4 Managing Synthetic Spectra

Click Manage Your Synthetic Spectra and see a list of all the synthetic spectra that are available for
your imaging system.

Figure 22. Choose which Synthetic Spectra will be displayed to choose for a spectral lib rary in
the Prepare Images step.
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Check boxes in the Active column let you select which Synthetic Spectra in the Fluor column will be
displayed for use in the Prepare Images step. You can click the Assign Groups… button to assign a
particular Fluor (or a group of Fluors by highlighting more than one) to a new or existing Group. Each
Fluor can be a member of more than one Group if you desire. If you would like to see the filters available
to create the Synthetic Spectra, click the Show Filters… button.

Figure 23. Assigning a Fluor to a new or existing Group is easy. You can specify the name of a
Group and assign stains and fluorophores to multiple groups.
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Figure 24. The list of filters availab le to
generate Synthetic Spectra.

NOTE: Under normal circumstances, you would capture images from single-stained slides in
order to build up a ‘library’ of spectra (precise colors that are really unique multispectral

profiles of your stains). To help get you started, Akoya Biosciences® includes some
commonly used and characterized fluorescence spectra, referred to as ‘synthetic’ stains

because they were not captured and characterized on your particular Mantra™ or
Vectra™ system. However, because of the variability of stains and the staining process
in brightfield IHC, there are no synthetic spectra provided for brightfield microscopy.
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4 Common Image Analysis Tasks
Use inForm to create automated image analysis routines to accurately extract data from Akoya images
(QPTIFF, im3), or conventional RGB images (TIF, BMP, or PNG). (While it is also possible to process
JPG images, this is not recommended. JPGs can contain compression artifacts that could adversely
affect segmentation performance.)

Some common inForm image analysis tasks: 

· inForm uses an AI-powered feature-based recognition algorithm to automatically identify and
segment tissue types using training regions drawn by the user.

· inForm performs pixel-based analysis to quantitatively obtain component data. inForm can set
thresholds (pixel-based) for all component signals and quantitate the thresholded component
signals. 

· inForm performs colocalization, which locates areas where components are simultaneously
expressing on a pixel level. 

· inForm identifies cells and finds nuclei, membrane, and cytoplasm, quantitates the component
signal within those cell compartments and calculates consistent scoring judgments based on that
quantitation.

· inForm identifies non-cellular objects, and can provide quantitative statistics.

Features can be combined to perform more advanced analysis, such as computing the double positivity
of cells within a cancer region, or computing the colocalization of a multi-stained tissue sample.

The basic workflow to manually process images in inForm can be similar to the steps shown below:

1. Open a new project (see Working with Projects and Algorithms) . Follow the steps at the top
of the window to process the images. 

2. Open the desired images (see Opening Images) .

3. To use processing regions, draw the desired regions (see Drawing Processing Regions) .

4. Prepare the images for unmixing (see Preparing Images) .

5. If segmenting tissue, see either Manual Tissue Segmentation  or Trainable Tissue
Segmentation .

6. Refer to the sections for the steps in the project ( Threshold , Colocalization , Segmenting
Cells , Scoring IHC or IF , and Counting Objects .

7. After images are processed, see Displaying the Extracted Data .
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5 Working with Projects and Algorithms
An inForm project includes the images in the project, the algorithm to process the images, and any
processing regions, training regions, manual tissue regions, and spectral regions. 

The topics in this section describe how to create, open, and save projects, how to change the project
settings, and how to open and save an algorithm.

An algorithm is used in batch mode to process images the same way each time. 

· A project includes all the images so that you can go back and modify algorithm settings, including the
trainable tissue classifier. 

· An algorithm can be saved in a protected format so it cannot be edited.

Working with Projects and Algorithms

Ø Creating Projects

Ø Opening a Project , includes:

· Saving Projects

· Changing Project Settings

Ø Opening an Algorithm

Ø Saving an Algorithm

5.1 Creating Projects

Each time inForm starts, a new project is created automatically. The new project contains only the
Prepare Images step and the Export step. To create a project with additional steps, either Create a
New Project  or Configure the Open Project . The name of the current project displays in the inForm
title bar. Specify the desired project name when creating a new project or when configuring the project.

Create a New Project

The steps available when creating a new project are determined by the software configuration used
to create the project. See Software Configurations  for information on the features available for
each software configuration.

To create a new project:

1. Select File > New > Project. If an unsaved project is open already, inForm prompts you
to save the current project. If you choose No, all unsaved settings are lost. The New
Project window opens as shown in the figure below. Prepare Images and Export are
automatically included in all projects. 
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Figure 25. New Project Window

2. Type a name for the new project in the New Project Name text box.

3. To segment tissue, select the desired option under Segment Tissue:

a. Select Manual Tissue Segmentation to manually mark tissue categories on the
images. 

b. Select Trainable Tissue Segmentation to train the tissue segmenter to
automatically identify areas as specific tissue categories.

c. Select Skip This Step to skip tissue segmentation.

4. To find specific features, select the desired option under Find Features:

a. Select Adaptive Cell Segmentation to identify cellular features, such as finding the
nucleus, cytoplasm, and membrane for each cell using an adaptive thresholding
algorithm.

b. Select Cell Segmentation to identify cellular features, such as finding the nucleus,
cytoplasm, and membrane for each cell.

c. Select Object Segmentation to identify objects of interest.

d. Select Colocalization to identify areas on the images where selected components are
colocated.

e. Select Threshold to identify the areas on the images where the strength of a
component at each pixel exceeds a specific threshold.

f. Select Skip This Step to skip finding features.

5. If Cell Segmentation was selected, select Phenotyping to assign phenotypes to each
cell.

6. If Cell Segmentation was selected, select Scoring to calculate score statistics for the
cells.

7. Click the Create button to create a new project with the selected steps.
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8. See Opening Images  to add the desired images to the project.

Configure a Project

You can configure a project to add or remove steps from the project. inForm retains as many
settings as possible, depending on which steps are added or removed from the project. For
example, if you created a project without tissue segmentation and later decide that you want the
project to include manual tissue segmentation, you can modify the project to add Manual Tissue
Segmentation. Settings that are not affected by the changes are retained, but some settings may
need to be adjusted due to the changes to the project.

The steps available when configuring a project are determined by the software configuration used to
configure the project. See Software Configurations  for information on the features available for
each software configuration.

1. Select Tools > Configure Project or click the Configure button. 

2. Use the Configure Project window to select the desired steps. The Configure Project
window contains the same options as the New Project Window .

3. Click the Configure button and inForm reconfigures the project.

4. Verify that all of the desired settings are selected in each step.
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5.2 Opening a Project

To open a saved inForm project:

1. Select File > Open > Project, select the name of the project, and click the Open button. The
images in the project open in Gallery mode as shown in the figure below. The View Editor and
the Available Images window close if either one was open in the previous project. 

Figure 26. Gallery View

2. To edit algorithm settings, click the Single button to change to Single mode. 

Saving Projects

Saved projects include the images, created composite views, the algorithm to process the images,
and any processing regions, training regions, or manual tissue regions.

1. Select File > Save > Project. 

2. Type a new file name, if desired, select the desired location, and click Save. A project file (.ifr)
is saved in the specified location. A folder named <ProjectName>_TrainingImages is created in
the same folder as the project file. Local copies of all the images in the project are saved in the
training images folder. (To save only the algorithm and not the images, see Saving an
Algorithm .)

NOTE:   Digital Slide projects do not store the images locally. Should the location of the data
change, inForm will prompt you to find the slide data. When transferring data, please
make sure that the study folder and its contents are moved as a unit.

46
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Figure 27. Data File
Structure

Changing Settings

After a project has been created, the settings in the steps can be changed. Changing settings may
require you to reprocess the images for later steps in the project.
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5.3 Opening an Algorithm

Algorithms include all steps in processing an image: image preparation, image analysis, and export. You
can load an algorithm into inForm and then open the images you want to process, or load the images
first, and then apply the algorithm.

Algorithms can be used in Batch Processing  to automatically process multiple images at the same
time using the same analysis settings. If a project is opened for use in Batch Processing, the project's
algorithm is used to process the images.

To open an algorithm, select File > Open > Algorithm. If a project or image is already loaded, inForm
warns you that all images will be reset to their initial state. Click Yes to discard all training regions,
tissue regions, cell regions, object regions, thresholds, and component images. Select the desired
algorithm, and click Open.

Open the desired images if they are not already open. To prepare the image(s), click the Prepare
Image or Prepare All button. To review or change the settings in each algorithm step, click the
Advance button to advance through each step or click the step buttons at the top of the window.

When algorithm development is complete, see Saving an Algorithm .

5.4 Saving an Algorithm

inForm Algorithms allow you to reuse the same settings to process compatible images or sets of images
without re-selecting the settings for each new project. (Saving the project saves the images with the
steps, see Saving a Project .) 

To save the algorithm, select File > Save > Algorithm. Or to save the algorithm in a protected format
that cannot be edited, select Locked Algorithm. Type the desired algorithm name, select the desired
location, and then click Save.
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6 Opening Images
The topics in this section describe how to open images in a project and describes the viewing options
available.

Opening Images

Ø Opening Images in a Project

Ø Viewing Images

6.1 Opening Images in a Project

Add the images to the project as described below. The images in a project can be included in the
Processing set (the images to be processed by the algorithm) and/or can be included in the Training set
if training a Tissue Segmenter.

The number of images that can be opened in a project depends on the size of the images (width and
height in pixels) and the operating system. 

Opening Images

To open the desired images:

1. Select File > Open > Image. The Select Image window opens. The Files of Type selector
at the bottom of this window specifies the types of images to display: Digital Slides (.qptiff),
Digital Slide Extract (.qpexport), Multispectral Fields (.im3), or other common image files
such as TIFFs, BMPs, JPGs, etc. 

2. Navigate to the location of the image files.

· When loading Digital Slides, inForm will load all stamp annotations designated for
inForm projects.

3. Select the desired image files. The image files must all be of the same image type
(.qptiff, .im3, RGB, or Monochrome). Ctrl + click to select multiple image files. Shift + click
to select a range of files.

4. Click the Open button to add the images to the project. The images are automatically
included in the Processing set .

NOTE:  If a single image exceeds 16 megapixels (32-bit systems) or 110 megapixels (64-bit
systems), the Change Resolution window opens and prompts you to select an image
reduction factor to use to reduce the image resolution. The window also displays the
number of images of a similar size that can be open at the same time. Select the
desired factor and click  the OK button to change the image resolution and open the
image.
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Figure 28. Change Resolution
Window

5. To change the view of the images, see Viewing Images .

6. To process only part of an image, see Drawing Processing Regions .

7. To change the image resolution of all open images, convert to optical density, or unmix the
images, see Preparing Images .

Opening Images Using the Available Images Window

You can add images to the project using the Available Images window.

1. Click the menu option Tools > Image List Editor. The Available Images Window
opens. 

2. Click the Load Image button. The Select Image window opens,

3. Select the desired images and click the Open button.

You can also use the Available Images window to select which images are in the training and
processing sets by selecting or clearing the check boxes next to each image name.

Adding Additional Images to a Project

After images have been added to a project, only files of the same type (Digital Slide, Digital Slide
Extract, Multispectral Field, RGB, or Monochrome) can be added to the project. Add images to an
open project either by selecting File > Open > Image or by clicking the Load Image button in
the  Available Images Window .
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Removing Images from a Project

To remove images from the open project:

In Single mode, click the thumbnail of the image to be removed to show the image in the
Image Display Area. Right-click the image in the image display area and select Remove from
Project.

In Gallery Mode, right-click the image in the gallery and choose Remove from Project. 

Images can also be removed from the project by right-clicking the image name in the Available
Images Window  and selecting Remove Image.

6.2 Viewing Images

Images are viewed in the Image Display area in the inForm Window. View images in Single Mode to
zoom in on an image, draw regions on an image, or edit the algorithm settings. View images in Gallery
Mode to compare all the images in the project or to quickly locate specific images.

Gallery Mode

To view a gallery of images, click the Gallery button at the lower left of the display area. Note that when
in Gallery mode, you cannot edit the  Step settings.

Adjust the display by moving the Image Size slider at the top of the Image Display Area. Move the
slider to the left to fit more images in the display area. Move the slider to the right to fit fewer images in
the display area.

Figure 29. Gallery View
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Single Mode

To view an image in Single Mode, click the Single button at the lower left of the display area.

Click the thumbnail of the image to view the image in the display area.

Figure 30. Single View

Cube Image

Select Tools > Show Cube Image to see more information about the selected image. Depending on
how the image was taken, this may include image size, wavelengths acquired, exposure times, and
instrument response data.
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7 Drawing Processing Regions
Processing regions enclose areas of the image that will be processed using the steps in the project or
algorithm. Areas of the image outside of the processing regions are ignored and are not included in any
calculations or statistics. Processing regions are manually drawn on the images and cannot be used for
Batch Processing .

To draw processing regions on an image:

1. In the open project, click the Single Mode button, and then click the desired image in the image
thumbnails. 

2. If desired, use the Zoom In button to zoom in on the image or the Pan button to move the image
in the image display area.

3. Click the Draw Processing Region button on the toolbar. 

 

4. Click and drag to outline the desired area of the image. Release the mouse button to connect the
endpoint to the start point of the processing region. An ID number is assigned to the processing
region and displays in the middle of the region. The ID number identifies the region in data tables.

5. Repeat step 4 to draw multiple processing regions on the same image.

6. Click each image and repeat steps 2 through 5 to define all desired processing regions on each
image in the project.

Deleting Processing Regions

If a processing region doesn't enclose the desired region, delete the processing region and draw a new
processing region.

To delete a processing region:

1. Click the Delete Regions button on the toolbar. 

 

2. Click the processing region that you want to delete. The processing region is removed and the
remaining processing regions with ID numbers higher than the deleted region are re-numbered.

You can also delete a processing region by right-clicking on the processing region and selecting
Delete Region on the shortcut menu.

To delete all processing regions on an image:

1. Right-click anywhere on the image. 

2. Select Delete Regions > Delete Processing Regions on the shortcut menu.
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8 Preparing Images
The first processing step in an algorithm is the Prepare Images step. This section describes how to
prepare the images for segmentation or analysis by changing image resolution, converting brightfield
images to optical density, and unmixing the images.

Preparing Images

Ø Selecting the Image Format

Ø Choosing a Spectral Library  includes:

· Converting to Optical Density

· Choosing Spectra for Unmixing

· Removing "Haze" Spectra

Ø Component Units

Ø Completing the Prepare Images Step

8.1 Selecting the Image Format

The Image Preparation Settings panel displays the Image Format, Sample Format, and Change
Resolution options.

Figure 31. Image Format and
Sample Format

Image Format

Before image analysis can begin, inForm needs to know the type of images in the project. Possible
image types are Digital Slide (.qptiff), Digital Slide Extract (.qpexport), Multispectral Field (.im3), RGB, or
Monochrome.

If you open a new project and then immediately add new images to the project, inForm automatically
selects the correct Image Format. If you open TIFF, BMP, JPG, or PNG images, inForm recognizes the
images as either RGB or Monochrome images.

Additionally, all images added to the project must be acquired at the same resolution. When using
Vectra Polaris, imagery acquired at a resolution of 0.5um/pixel (20x) is fundamentally different than
imagery acquired at 0.5um/pixel (20x binned from 40x); these images cannot be processed within the
same project.
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Sample Format

All images in the project must be the same sample format. For any RGB images and for Multispectral
Field (.im3) images created with early versions of Nuance, you must select the correct Sample Format
(Brightfield or Fluorescence). Monochrome images do not use a Sample Format. For all other image
formats, inForm automatically detects the Sample Format.

For Vectra version 2.0.6 and earlier, and all Nuance versions, the imagery must have been acquired

using the same filters in the same order.  Later versions of Vectra™ and Mantra™ can vary in their filter
order.

If desired, you can select the Image Format and Sample Format before adding images. In this case, only
images that match the selected Image Format and Sample Format can be opened.

Change Resolution

Select the Change Resolution check box to change the resolution of all images in the project. You can
lower the image resolution to increase the speed of training and tissue segmentation. If the set of images
is so large that all of the images cannot be held in memory, lower the image resolution prior to unmixing.
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8.2 Choosing a Spectral Library

inForm uses a process called spectral unmixing to decompose the image into its various components.
For a simple example, a color image can be unmixed into its red, green, and blue components. But more
powerfully, an image can also be unmixed into its stain components such as Hematoxylin and DAB for
Brightfield images, which describe the contribution of each stain to the overall signal. The contributions of
each stain are based on a spectral library that shows the characteristic color distribution of light
associated with each stain. A fluorescence example could consist of stain components such as DAPI
and FITC; the spectral library can additionally include the color distribution associated with tissue
autofluorescence.

· For Multispectral Fluorescent Digital Slides, the spectral library can be synthetic, or extracted
from singly stained samples.

· For other Fluorescent Digital Slides, a spectral library is not used.

· For Brightfield Digital Slides, a spectral library can be extracted from singly stained samples.

· For Multispectral Field .im3 images acquired with Mantra, Vectra 3, or Vectra Polaris,
inForm can extract the spectrum from singly stained samples.  In addition, a synthetic spectral
library can be used for fluorescence imagery. 

· For all other Multispectral Field .im3 images, the spectral library is created in the Nuance
software.

· For RGB images, the spectral library can be created in the Nuance software or you can use the
default RGB spectral library that is included with inForm.

· For Monochrome Images, spectral libraries are not used.

· For Brightfield PKI TIFF Extracts, the default RGB spectral library included with inForm can be
used if desired.  Spectral libraries are not used for fluorescent PKI TIFF Extracts.

Selecting an inForm Library

If you have previously created spectra by Building
Libraries , you can select those spectra for use
with your images.  You must have an image
loaded to select inForm libraries.

Select inForm as the Spectral Library Source.  

Choose the spectra that represent the stains or
fluorophores in your sample.  

If this is a fluorescence sample, you may wish to
select autofluorescence by drawing on an
unstained portion of tissue with the

Autofluorescence Picker. 

If you need to reselect your stains or
fluorophores, click the Select Stains/Fluors...
button.

Figure 32. Select inForm as the
Spectral Library Source to choose

spectra created in inForm.
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While choosing your stains or fluorophores, you
can narrow your choices by selecting one or more
Groups.  Selecting All will show all spectra
compatible with your imagery.

You can sort your spectra by name, creation
date, and selection by clicking the column
headers.

Figure 33. Availab le stains can be selected for
preparing images.

You can preview the spectral shape for the highlighted stain or fluor, as well as your selected spectra, in
the spectral chart. The details of the highlighted stain or fluor, including the acquisition date, groups, and
notes, are shown below the listing.  Clicking on a stain or fluor in the legend will highlight that stain and
show its details.

Clicking the Locate Original Image button will bring up the folder containing the stain or fluorophore's
source image, if available.

Selecting a Synthetic Spectral Library

If you have a fluorescence image taken

with Vectra Polaris, Mantra™ or Vectra
2.0.7 and higher, you can use synthetic
libraries within inForm.

Akoya Biosciences® includes some
commonly used and characterized
fluorescence spectra, referred to as
‘synthetic’ stains because they were not
captured and characterized on your
particular  system. 

Select inForm® as the Spectral Library
Source.  Select the Synthetic Group
to limit your spectra to synthetic only.  

Choose the spectra that represent the
fluorophores in your sample and click
the OK button.

You may wish to select
autofluorescence by drawing on an
unstained portion of tissue with the

Autofluorescence Picker. 

Figure 34. Selecting the Synthetic Group will only display synthetic
fluors.
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Selecting a Nuance Library

To select the spectral library:

1. For Brightfield RGB or for multispectral field .im3 images
acquired with early versions of Vectra, convert to Optical
Density as described in Converting to Optical Density
(below). Images acquired with recent versions of Vectra
are already converted to Optical Density. 

2. In the Spectral Library Source drop-down list, select
Nuance. The Open Spectral Library window opens.

3. Select the desired Spectral Library (.csl) and click the
Open button. The name of the selected spectral library
displays. The components in the spectral library display
in the Spectra for Unmixing list box. (Click the Browse
button to change the selected spectral library.)

4. If this is a fluorescence sample, you may wish to select
autofluorescence by drawing on an unstained portion of

tissue with the Autofluorescence Picker. 

Figure 35. Load Spectral Library

5. For fluorescence images, see Remove Haze  for details on removing the background haze
before unmixing.

6. In the Spectra for Unmixing list box, select the check boxes for the components that you want
to unmix. (See Choosing Spectra for Unmixing  for more information.)

7. To view the selected Spectral Library, click the View button under the Spectra for Unmixing list
box and see Viewing a Spectral Library .

Editing Markers

You can add the names of your markers to the
spectra listed in the Spectra for Unmixing box
in the Manual Analysis tab. Click the Edit
Markers and Colors… button below the
Spectra for Unmixing box. The Edit Markers
and Colors button brings up the Edit Markers
and Colors window, which allows you to enter
the marker names and change the colors
associated with your spectra.

Figure 36. Edit Markers and Colors
button

You can type your marker name in each text
box to the right of the name for each
spectrum. You can also select the default
color used for unmixing using the color drop-
down list.
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If you know that CD4 is your marker for FITC,
type CD4 in the text box to the right of FITC in
the Edit Markers and Colors window. This puts
the fluorophore name into parentheses next to
the marker name in the list of spectra for
unmixing.

Figure 37. Enter the names of your markers next to
the names of your spectra.

Converting to Optical Density

Brightfield multispectral and RGB images of IHC-stained
samples need to be converted to optical density if the goal
is to quantify stain "intensity" (optical density). Typically,
brightfield multispectral images acquired with Nuance and
recent versions of Vectra are already converted to optical
density and do not need conversion as part of Prepare
Images. Brightfield multispectral images acquired with
early versions of Vectra are not converted to optical density
when acquired, and require conversion as part of Prepare
Images.

Selecting a "Reference White" for Optical
Density conversion:

1. Select the Convert to Optical Density check box. 

2. If the white areas on the image are small, zoom in on a
white area.

Figure 38. Convert to Optical
Density

3. Click the White Picker button. 
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4. Move the cursor (a white box) over a white region on the image and click. “White Selected”
displays under the Convert to Optical Density check box. If the image appears very light, you
may have clicked on an area that was not completely white. Clear the Convert to Optical
Density check box to return to the original image, and then repeat the steps above. 

Note: The optical density conversion is required if you are work ing with brightfield images and
plan to segment cells and measure stain intensity.

Choosing Spectra for Unmixing

The Spectra for Unmixing list box is populated from the
selected spectra or library. Check the stains you wish to
use to unmix. If you have more than one spectral example
from the same stain (e.g. multiple DAB spectra) in your
list, you will only be able to use one for unmixing.

For Brightfield RGB images, if you do not load a library, the
spectra for unmixing default to Blue, Green, and Red.

NOTE: If Scale Views Based on Selected Images is
selected in the View Editor  and then
changes are made to the selected Spectra for
Unmixing, the image scaling is reset to Scale
Views Equally for All Images in the Project
(default). 

Figure 39. Spectra for Unmixing

Removing the “Haze” Signal

In fluorescence images, image contrast and unmixing
accuracy can sometimes be improved if the general haze
in the image, which has a characteristic spectra, is
subtracted from the images first. When creating the
spectral library for the images, create the background or
“haze” spectrum and add it to the library. When the library
is loaded, you can select the haze spectrum and remove it
from the images.

To remove haze:

1. Check the Remove Haze check box. 

2. Select the Haze Spectrum to remove. 

Haze is removed numerically (without scaling or other
changes in value), wavelength-by-wavelength, from every
pixel of the image. This alters the spectral shape of the
remaining signals and their overall intensity. The magnitude
of these changes depends on the intensity of the spectral
signal being subtracted. Typically, when background
spectra are small compared to the signals, spectral library
entries derived from unsubtracted data sets can still be

Figure 40. Remove Haze
Spectrum
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used, but this should be validated when quantitative results
are required. Ideally, the remaining spectra in the library
should also have the haze spectrum subtracted (in
Nuance).

Clicking the Prepare Images button will apply your settings and display the composite view.
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8.3 Viewing a Spectral Library

The Spectral Library window displays graphs of the spectral segments in each imaging band in a
spectral library. Only one graph displays for brightfield images or for fluorescent images with only one
data point in each imaging band.

To view the spectral library:

1. Open the desired spectral library. 

2. Select the spectra that will be used to unmix the images in the Spectra for Unmixing list box.

3. Click the View button below the Spectra for Unmixing list box to open the Spectral Library
Window .

4. Select the desired Units to display the graphs in the chart. See Spectral Library Window  for
complete descriptions.

5. Select the desired Display options for the chart.

6. To save an image of the chart with the currently selected display options, click the Save Chart
button, type the desired name for the image file, select the desired image format, and click the
Save button.

7. Click the Close (X) button in the upper right corner to close the Spectral Library window.

If a chart cannot be displayed because no spectra are selected or there are no compatible units, a
message displays in place of the graphs.
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8.4 Component Units

The components produced by unmixing are calculated
using the settings selected in the Select Reported Units
and Weighting drop-down lists. The Reported Units can
be: Raw counts, counts Normalized for Exposure, or OD
(optical density) units. The Weighting can be Total, Mean,
or Peak. Figure 41. Component Units

Brightfield versus Fluorescence

Brightfield and fluorescence images use different measuring schemes because of the inherent differences
of the images. 

· For brightfield images, darker pixels indicate a higher expression of the biomarker. 

· For fluorescence images, brighter pixels indicate a higher expression of a biomarker or reporter
protein. 

Therefore we use optical density for brightfield images and fluorescence counts (either raw or normalized)
for fluorescence images. 

Select Reported Units

Monochrome (black and white) images and RGB color images produce signals in counts. 

For multispectral images that are not converted to optical density, component signal counts are
either raw or normalized for exposure. 

· Raw Counts reports the measured signal associated with a given component (such as DAPI, FITC,
etc.). 

· Normalized for Exposure reports the number of counts in the image, after accounting for all the
camera settings in use (gain, binning, bit-depth, well depth, and exposure time). Using Counts
Normalized for Exposure allows you to compare images taken using different camera settings or
exposures, with the assurance that signal levels indicate the actual brightness at the sample,
regardless of the instrument settings.

Counts Normalized for Exposure = (counts x relative well depth)/ {2bit depth x exposure time
x gain x binning area}, where relative well depth is the well depth of the camera sensor relative to
a nominal Akoya sensor at the chosen gain setting, bit depth is the bit depth of the imagery,
typically 8-bit (256 levels of gray) or 12-bit, exposure time is in seconds, gain is the gain setting of
the camera, and binning area is 1 for 1x1, 4 for 2x2, etc.

The values are small when using Mean weighting, and it may be hard to develop an intuition about
what is normal. Selecting Total weighting (default) produces larger values.

For brightfield images that are converted to Optical Density, inForm produces unmixed component
signals in OD (Optical Density) units. Optical Density indicates the amount of absorbing material
present at a location. Optical Density = -log10 (pixel value / white reference pixel value).

Note: If Scale Views Based on Selected Images is selected in the View Editor  and then
changes are made to the Reported Units, the image scaling is reset to Scale Views
Equally for All Images in the Project (default). 
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Weighting

Specifies whether to use the Mean, Peak, or Total signal to calculate the displayed units. 

Total - The sum of all signals of the selected component across all wavelengths. Available for all images
except images converted to Optical Density. (Default for fluorescence images.)

Mean - The average of all signals of the selected component across all wavelengths. Available for all
units except Counts for Monochrome images. This is the equivalent of the settings in versions of inForm
prior to V2.0.2. Examples: For RGB color images, inForm reports the average signal across the three
color planes (red, green, and blue). A pure blue pixel with 240 counts would have a component strength
of 80 (= 240 counts / 3 planes). For multispectral images, the signal is averaged across all wavelengths
measured. So a pixel having a DAB signal of OD = 0.60 in the blue, OD = 0.20 in the green, and OD of
0.10 in the red would report a signal of 0.30 OD units (= [0.60 + 0.20 + 0.10] summed OD / 3 planes).

Peak - The peak signal of the selected component across all wavelengths. Available for images
converted to Optical Density and for fluorescent multispectral images. (Default for brightfield images.)

Weighting Example

The simplified example below explains the difference between the three weighting options. (The example
uses only two fluors and ignores noise and other sources of error.)

This example uses a spectral library with just two elements, Fluor A and Fluor B, and eight wavelengths
(420, 460, 500, 540, 580, 620, 660, 700). The spectral library is shown in the figure below.

Figure 42. Spectral Library Example
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If an image pixel expresses one part Fluor A and three parts Fluor B, the signal at the pixel is shown in
the figure below.

Figure 43. Signal at a Pixel

Unmixing recovers the original spectra, scaled according to the measured expression at the pixel as
shown in the figure below.

Figure 44. Original Spectra, Scaled

The challenge for the unmixed component image is to represent the unmixed spectrum using a single
value. The three weighting options correspond to three possibilities for how to do this. 

· Peak weighting represents the spectrum as the signal level at the brightest wavelength of the
spectrum. In the example, this gives component values of

Fluor A = 0.5739
Fluor B = 1.5216
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· Total weighting represents the spectrum as the sum of the signals at all wavelengths. In the
example, this gives component values of

Fluor A = 2.551
Fluor B = 7.7514

· Mean weighting represents the spectrum as the average signal across wavelengths. In the
example, this gives component values of

Fluor A = 0.3189
Fluor B = 0.9689

Notice that Total weighting is the Mean weighting multiplied by the number of wavelengths (eight in this
example).

The figure below shows scaled spectra annotated with the weighting values:

Figure 45. Weighting Values

8.5 Completing the Prepare Images Step

After all of the desired settings have been selected in the Image Preparation Settings panel, process the
images using any of the methods below and then advance to the next step in the project.

· Click the Prepare Image button to apply the selected settings to the currently selected image.

· Click the Prepare All button to apply the selected settings to all images open in the project.

· Click the Advance button to apply the selected settings to all images open in the project and then
display the next step in the project.

· Click the next step in the project in the Step Bar  at the top of the inForm window. All images are
processed using the current settings, and then the settings panel for the next step displays.
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9 Manual Tissue Segmentation
The topics in this section describe how to manually draw tissue categories on an image. The tissue
categories can then be used to generate data or can be used during the Cell Segmentation, Scoring, or
Object Counting steps. Algorithms that include a Manual Classification step cannot be used in Batch
processing. 

Manual Tissue Segmentation

Ø Creating Tissue Categories

Ø Drawing Tissue Category Regions

Ø Editing Tissue Category Regions

9.1 Creating Tissue Categories

Tissue categories divide the image into specific areas that correspond to specific types of tissue (for
example, cancer, necrosis, stroma, etc.) or occasionally other structures of interest. The Manual
Classification step (available in inForm Basic Analysis or higher) enables you to draw the appropriate
tissue categories over areas of each tissue type on the images. Cell segmentation, scoring, and object
counting can all be restricted to a specific tissue category.

1. Click the Manual Classification step to display the Tissue Segmentation panel. 

2. Click the New button under the Tissue Categories section to create a new tissue category.

Figure 46. Tissue Categories - New
Button

3. To change the tissue category name, highlight the name and then type the desired name for the
tissue category.

4. To change the display color for the tissue category, click the Color pull-down and select the
desired color.

5. Repeat steps 2 through 4 to create all of the desired tissue categories.

6. See Drawing Tissue Category Regions .
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9.2 Drawing Tissue Category Regions

Draw tissue categories around the areas on the image that contain each defined tissue type. A single
area on the image cannot belong to more than one tissue category.

To draw tissue category regions on an image:

1. Select the Draw radio button next to the desired tissue category. 

2. Click and drag to outline the desired area on the image.

3. If the region intersects another region in the same tissue category, the two regions are merged
into one region.

4. If the new region intersects a region in a different tissue category, the area becomes part of the
new tissue category.

5. The unselected parts of the image file are covered with a gray mask. This may make it difficult to
see the image to select additional tissue categories. To temporarily hide the tissue categories
and the gray mask, click the Show/Hide Tissue Segmentation Map button. 

After the next tissue category is drawn on the image, the tissue segmentation map displays
again. 

6. See Editing Tissue Category Regions   if necessary.

7. When all of the desired tissue categories have been drawn, continue with the next processing
step in the project. Either click the Advance button or click the next step button.

9.3 Editing Tissue Category Regions

After tissue categories have been drawn on an image, you can edit the regions to add areas to a region,
remove areas from a region, or remove individual pixels from a region. 

To add an area to manually selected tissue categories:

1.  Zoom in or out on the image to the desired magnification.

2. Click the option button next to the tissue category that you want to add an area to.

3. If desired, use the Tissue Segmentation Map button to show or hide the tissue masks. Hiding
the tissue masks makes it easier to see the colors on the original image.

4. If Processing Regions have been defined, use the Process Regions button to show or hide the
process region masks.

5. Click and drag to outline the area to be included, intersecting the defined tissue classification
areas as desired. 

6. Release the mouse button to connect the end point to the start point. The outlined area is
assigned to the specified tissue category.

To remove an area from the tissue category:
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1. Click the Select Regions to Unclassify button. 

 

2. Click and drag to enclose the area from which you want to remove the tissue classification.

3. Release the mouse button to connect the end point to the start point. The outlined area is
removed from the tissue category. 

To remove single pixels from the tissue category:

1. Zoom in on the image. 

2. Click the Select Pixels to Unclassify button. 

3. Click a single pixel to remove it from the tissue classification region.

4. Click and drag to remove a line of pixels from the tissue classification region.
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10 Trainable Tissue Segmentation
The topics in this section describe how to automatically classify tissue using the tissue segmenter. To
set up the tissue segmenter, add tissue categories and draw training regions on images in the training
set, train the tissue segmenter, segment images, and then fine tune the segmenter based on initial
results.

Trainable Tissue Segmentation

Ø Adding Tissue Categories

Ø Drawing Training Regions

Ø Training the Tissue Segmenter

Ø Adding Images to the Training Set

Ø Editing Masks and Re-Training

Ø Completing the Automated Tissue Segmentation
Step

10.1 Adding Tissue Categories

Tissue categories divide the image into specific areas that correspond to specific types of tissue (for
example, cancer, necrosis, stroma, etc.) or occasionally other structures of interest. The Segment
Tissue step (only available in inForm Tissue Finder) enables you to draw training regions around
representative areas of tissue on images and then train the tissue segmenter to automatically locate
similar regions of tissue in each image.

The Tissue Segmentation Training panel is used to define tissue categories, train segmenters, and
segment images in the image processing set.
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Creating Categories

1. Click the Segment Tissue step to display the
Tissue Segmentation Training panel. 

2. Decide how many tissue categories you want to
segment the images into. 

3. Click the New button and type the desired name of
the tissue category in the text box.

4. Create the desired number of tissue categories for
the images in the project.

5. To change the display color for a tissue category,
click the Color pull-down and select the desired
color. Figure 47. Creating Tissue Categories

Deleting Categories

To remove a category, select the category’s radio button and click the Remove button.

To clear all tissue categories and start over, click the Clear button.

10.2 Drawing Training Regions

Training regions teach the tissue segmenter which cells should be included in each tissue category. It is
important that you already know what to look for and are able to visually recognize structures
characteristic of the tissue category. For example, if there are tumor cells present in any image that are
negative (i.e., not stained), be sure to include those also. It is important to train on the full range of
appearances of the tissue category, as in the example, where negatively-stained as well as the
positively-stained cells are included.

To draw the training regions:

1. In the Tissue Segmentation Training panel, select the Draw radio button for a tissue category. 

2. Click and drag to draw regions around groups of cells. (For example, if the tissue category is
named Tumor, draw regions around groups of tumor cells). 
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Figure 48. Drawing Training Regions

3. To delete a region, either click the Delete Region button and click inside the region to be
deleted, or right-click the region and select Delete Region from the pop-up menu. (This menu
also lets you delete all training regions or all within a selected category.)

4. When you are finished drawing regions for the first category, switch to the next category (e.g.,
non-tumor regions) and draw regions around cells characteristic of the next tissue category. Be
sure to capture visual anomalies such as areas slightly out of focus, folds, bubbles, etc. Also
capture stroma regions that have differing qualities of shape or orientation.

5. Repeat this process for all of the images in the training set.

6. When all training regions have been drawn, see Training the Tissue Segmenter .

10.3 Training the Tissue Segmenter

Only images that are included in the Training set are used to train the tissue segmenter. Images that
have been removed from the training set are not used to train the tissue segmenter, even if the images
include training regions.
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Selecting Components for Training

Select the components that you want to use for training the
tissue segmenter.

Components that provide distinguishing pattern information that
is independent of signals to be quantified are preferred. For
example, the counterstain component plane (e.g., DAPI or
Hematoxylin) should be tried first for training because the
counterstain reveals the structure of the tissue, and is less
likely to produce a segmenter biased by the presence of the
molecular marker you are trying to quantify. For example, if

measuring the positivity of cells stained with Alexa Fluor® in a

sample stained with both DAB and Alexa Fluor®, you would not
want the segmenter to be dependent on the Alexa stain
because that would bias the outcome.

Figure 49. Components for
Training

On the other hand, sometimes in brightfield applications where the presence of an IHC stain such as
DAB blocks the staining of the counterstain, using both the counterstain and the IHC stain
component planes for training yields a more robust tissue segmenter, even for the negative cases. In
these cases where the target label is included in the training, it is important to include abundant
negative cases in the training set.

Also, you should generally avoid using components that provide information unrelated to the desired
segmentation.

Selecting a Pattern Scale

The recommended approach is to start with the default Large pattern scale. Once you have drawn
training regions and trained a tissue segmenter, if segmentation accuracy for the training regions is
low (<85%), increasing Pattern Scale may improve accuracy. However, the pattern scale needs to
be compatible with the size of the training regions. Pattern scale refers to the spatial extent of
patterns that are measured to support machine learning and image analysis. 

If the selected pattern scale (e.g., Maximum) is too large for the drawn training regions, a grey mask
displays on training regions that are too small after training and those training regions are not used
to train the tissue segmenter.

You should use as large a pattern scale as is compatible with the training regions that you draw. If
most of the training regions have gray masks over them after training, reduce the pattern scale 
(.e.g., from Large to Medium), and then retrain.

For example, if analyzing tumors in tissue sections in a 20x magnification image, the architecture is
fundamentally on a large scale, and you probably want to select Large. For items with inherently fine
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scale structures, select Small or Medium. An understanding of the different scales can be learned by
seeing what size training regions are masked with grey after training.

Train the Segmenter

Click the Train Tissue Segmenter button to begin training the segmenter. The training process
may take some time, so be patient.

The percent accuracy of the new tissue segmenter displays. If, for example, the segmenter was 99%
accurate, this would mean that if the new segmenter was to be applied to all of the images used in
training the segmenter, it would classify the pixels in the training regions with 99% accuracy. (Fewer
than 1% of the pixels in all the drawn regions would be misclassified.)

The software continues to try to improve the accuracy. Click the Stop button to stop training when
an acceptable level of accuracy is reached or the accuracy has stabilized. In general, segmenters
should be at least 80% accurate. If the accuracy reaches 100%, a Done button displays to close
the Algorithm Training dialog.

Recent Trainings

The Recent Trainings box records a history of segmenters trained using the current segmentation
settings. For example, the first time you train is named “Attempt 1,” the second training is named
“Attempt 2,” and so on. To re-classify the images using a previous segmenter, select the desired
training attempt (i.e., segmenter) from this drop-down list. If you change any settings, the history of
segmenters is cleared.

Segmentation Resolution

The Segmentation Resolution determines the resolution of the tissue category segmentation.
There is a trade-off between resolution and segmentation speed, with an approximately 4x increase
in segmentation speed for every step in resolution reduction. Select Coarse if you want to segment
the images more quickly. Although the edges of the segmented regions appear pixelated, the
segmenter still accurately differentiates structures well (e.g., tumor from stroma). Select Fine if the
segmented regions need to have smoother edges, such as images for use in publications.
Segmenting with Fine resolution takes longer than with Coarse resolution. Also, if you selected a
small Pattern Scale, the Resolution must be set to Medium or finer.
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Segmenting the Tissue in the Training Images

After you have trained the segmenter, you can segment the tissue in the current image or all of the
images in the training set. You can segment just the current image first, to test the tissue
segmenter. Then make any desired adjustments to the training parameters and retrain the
segmenter. To see the Tissue Category mask on all images, click the Segment All button. When
you are ready, advance to the next step in the project.

Fine Tuning the Segmenter

Observe the training regions following the segmenter training. As mentioned above, if the software
grays out any region, this indicates that the region is too small for the selected Pattern Scale and
was not used to train the tissue segmenter. You can ignore this if segmentation performance is
adequate, delete the region and redraw a larger one, or try selecting a smaller pattern scale.

The Trim Edges option can be used to "erode" a tissue segmentation by removing the specified
number of pixels from the periphery of the selected tissue category, making it smaller. This is useful
if the tissue segmenter has a tendency to include pixels extending beyond the edges of objects or
tissue categories of interest (e.g., tumor or vessels). For example, if you notice cancer regions
extending into non-cancerous areas, select the Trim Edges option, choose the cancer tissue
category, and enter the number of pixels you want to trim from the borders of the cancer regions.

The Minimum Segment Size option is an adjustable parameter (in pixels) that removes segments
that have fewer pixels than this value. The removed segment is replaced by the tissue segment that
is most abundant around the segment that was removed.

If the Discard if Touching Image Border check box is selected, tissue regions touching the edge
of the image or process region are discarded. If not selected, all tissue regions are included.

10.4 Adding Images to the Training Set

When selecting images for the training set, it is recommended that you start with one image per distinct
appearance. The training set should represent the range of staining levels and tissue architectures that
you want to train the tissue segmenter to identify.

Whenever you draw a training region on an image (see Drawing Training Regions ), inForm
automatically adds the image to the training set. You can also add or remove images from the training
set manually as described below. 

1. Click the Image List Editor button to open the Available Images Window . 

 

2. Select the Training Set check box next to the images to add the image to the Training set. 

3. Clear the Training Set check box next to an image to remove the image from the Training set.

4. Close the Available Images window.

5. When you switch to Single mode, a small blue square on each thumbnail image at the bottom of
the screen (see figure) indicates images are included in the training set. A green square
indicates that the image is in the processing set.
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Figure 50. Training Set and Processing Set Indicators

6. See Drawing Training Regions  to add training regions to the desired images in the training
set.

69
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10.5 Editing Masks and Re-Training

After reviewing the segmented images, you might discover that some structures were not segmented
correctly, or the segmenter may have selected some unwanted regions. The Tissue Segmentation
masks should accurately cover their respective tissue categories. 

To correct the tissue masks, you can either edit the mask manually, or you can re-train the tissue
segmenter to detect the desired regions.

Manually Editing the Tissue Segmentation Mask

If the experiment or study involves few enough images, you can manually edit the Tissue Segmentation
mask. Manual editing does not change the tissue segmenter and if the images are re-segmented, the
changes to the Tissue Segmentation masks are lost.

To manually add areas to a Tissue Segmentation mask:

1. Click the Edit Tissue Segmentation button on the
toolbar. 

2. From the drop-down list, select the tissue segmentation
mask you want to edit.

3. Draw around the areas on the image that you want to
include in the selected Tissue Segmentation mask.

4. To continue processing the images using the edited
Tissue Segmentation masks, advance to the next step
without re-segmenting the images.

5. If the project contains a cell segmentation step and cell
segmentation was performed before the mask was edited
(see Segmenting Cells ), you should click the
Segment Images button in the Cell Segmentation
editor to re-segment the cells in the edited tissue
segmentations.

Figure 51. Editing Tissue
Segmentation Masks

Re-Training the Tissue Segmenter

If some areas of the image were not classified as the desired tissue type, you can re-draw the training
regions around the areas that were incorrectly classified and re-train the Tissue Segmenter. 

To re-train the tissue segmenter:

1. In the Tissue Segmentation Training panel, select the Draw radio button for the tissue category
that you want to draw additional training regions for. 

2. Draw training regions around areas that were incorrectly classified.

3. Re-train the tissue segmenter and then re-segment the image. Verify that the desired regions
are now correctly classified in the desired Tissue Segmentation mask.

4. To see the tissue segmentation on all images, segment all images. (Note that re-segmenting an
image after retraining the tissue segmenter deletes any manual edits to the Tissue
Segmentation mask.)
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10.6 Completing the Automated Tissue Segmentation Step

After all of the desired settings have been selected in the Tissue Segmentation Training panel and the
Tissue Segmenter has been trained, process the images using any of the methods below and then
advance to the next step in the project.

· Click the Segment Image button to segment the currently selected image.

· Click the Segment All button to segment all images open in the project.

· Click the Advance button to display the next step in the project. (The tissue is segmented the next
time images are processed.) 

· Click the next step in the project in the Step Bar  at the top of the inForm window. The settings
panel for the next step displays. (The tissue is segmented the next time images are processed.)

19
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11 Threshold
Use the Threshold step to set threshold values for any of the unmixed components in an image and then
to view the regions on the image that are above the threshold. Statistics are calculated for the
thresholded regions and are displayed in the Quant Data table.

To set the thresholds and calculate the threshold statistics for the images:

1. Click the Threshold button in the step bar. 

2. In the Components to Threshold list, select each of the image components you want to create
a threshold map for.

3. Click the Auto button to calculate a preliminary value for the Threshold Max and to choose a
preliminary Threshold value. The Threshold Max is set to the value of the brightest pixel in the
component. The slider range is set to (0 - Threshold Max). The threshold is set to an optimal
value, based on the component values. (The threshold max and threshold can be set manually
without clicking the Auto button, if desired.)

4. Set the desired Threshold for each unmixed component. Move the slider, type the desired value
or click the up and down arrow buttons to select the threshold. The image display shows the
areas that are above the threshold value as the slider is adjusted.

5. To change the color displayed for the regions, click the Color button and select the desired
color.

6. To change the minimum size of the thresholded regions:

· Click the More button under the name of the Threshold map that you want to change.

· Set the desired value for Minimum Connected Pixels by either clicking the Up or Down
arrow buttons or typing the value in the text box. The Minimum Connected Pixels specifies a
minimum region size based on the number of pixels. Only regions that are larger than the
Minimum Connected Pixels value are considered. Regions with fewer than this number of
pixels are ignored.

7. If there are multiple images in the project, either select each image and apply the current
settings to the image by clicking the Accept for Image button or click the Accept for All
button to apply the Threshold settings to all of the images in the project. Verify that the threshold
settings are appropriate for all images in the project and adjust if necessary.

8. If desired, change the threshold map view  or edit the threshold maps .

9. To view the statistics for the generated regions in the Quant data table, see Viewing the Quant
Data Table , or to export the data, see Exporting the Data .
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Changing the Threshold Map View

The threshold maps for each component are stacked in layers on top of the original graphic, with the top
component in the Simple Threshold Settings panel as the uppermost layer in the image display. You can
change the order of the threshold maps or hide threshold maps.

1. To hide a threshold map, clear the Visible check box under the component that you want to
hide. 

2. To move a threshold map up or down in the stack of maps, click the Up or Down arrows on the
left of the Color button.
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Editing Threshold Maps

Threshold maps can be edited manually. Additional areas can be drawn onto the threshold map or
undesired areas can be erased from the threshold map. This procedure describes how to use the editing
tools on the Simple Threshold Settings panel. The Add Thresholded Regions and Erase Thresholded
Regions buttons on the toolbar can also be used.

1. To view editing options, click the More button under the name of the Threshold map that you
want to edit. 

2. To draw additional threshold regions, click the Add button under the component name and draw
the desired regions on the threshold map.

3. To remove threshold regions, click the Erase button and draw around the area to be removed.
Only the threshold areas for the selected component are erased. 

4. To clear all manual edits from a threshold mask, click the Clear button under the name of the
component. Only the manual edits on the threshold map for that component are cleared.

To clear all manual edits from all threshold maps:

1. Click the down arrow next to the Erase Threshold Regions button and click Clear Edits. 

2. Click Yes in the Clear Mask Edits window.
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12 Colocalization
Colocalization is a pixel-based analysis used to find overlapping components in images based on
thresholds set for each component. Colocalization of multiple markers can be determined and displayed
both visually and statistically. It is designed for analyzing and quantitating molecular markers and can be
used to determine the amounts of colocalization of multiple markers.

1. Click the Colocalization button in the step bar. 

2. Under Markers for Colocalization, select the
markers for which you want to see overlap
(colocalization) and positivity percentages.

3. Under Denominator (Counterstain), select the
marker(s) to use as the counterstains. To see
colocalization of markers throughout the entire image
and not just within a particular counterstain, select All
Image Pixels.

4. For each component selected in the Markers or
Denominator, a Threshold settings area displays
below the Denominator check boxes.

5. To adjust the Threshold for each component:

a. Click the Auto button to calculate a preliminary
value for the Threshold Max and to choose a
preliminary Threshold value. The Threshold Max
is set to the value of the brightest pixel in the
component. The slider range is set to (0 -
Threshold Max). The threshold is set to an optimal
value, based on the component values. (The
threshold max and threshold can be set manually
without clicking the Auto button, if desired.) 

b. Set the desired Threshold for each unmixed
component. Move the slider, type the desired
value, or click the up and down arrow buttons to
set the threshold. The image display shows the
areas that are above the threshold value as the
slider is adjusted.

c. To change the color of a threshold mask, click the
Color button and select the desired color.

Figure 52. Colocalization Settings

6. To view the threshold for each component, clear the Visible check box for all components
except the component that you are adjusting. Clear the Visible check box for Colocalization.
Adjust the Threshold for the component until all of the desired areas are marked as positive. 
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7. If there are small regions that are marked as positive that should not be included, or if smaller
regions should be marked as positive and are not, click the More button and adjust the
Minimum Connected Pixels value as desired.

8. Under Colocalization, click the Visible check box to show the colocalization map. If
desired, click the Color button and select the color to use to indicate areas of colocalization.

9. To view the Colocalization statistics, see Viewing the Quant Data Table  and Viewing the
Colocalization Data Table . 

10. To export the data, see Exporting the Data .
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13 Segmenting Cells
The Segment Cells step is only available in inForm Cell Analysis and inForm Tissue Finder.

NOTE: Cells are considered to be an assembly of associated cellular components (nucleus,
cytoplasm, and membrane). If you are segmenting tissue, some cells may straddle two
segmented tissue regions. If a cell is not entirely contained within a single region, the
“containing region” is undefined, and the Region ID in the Data tables is #N/A (see Displaying
the Extracted Data ).

inForm contains two approaches for segmenting cells:  

1. Adaptive Cell Segmentation uses an adaptive thresholding algorithm to identify nuclear pixels,
and is able to use both nuclear and membrane signals to guide nuclear splitting. It performs best
on fluorescence imagery, especially imagery that contains membrane staining (see Adaptive
Cell Segmentation ).  

2. Cell Segmentation uses classical segmentation methods to locate the nuclear, cytoplasmic and
membrane compartments. It may outperform the Adaptive Cell Segmentation on brightfield
imagery (see Cell Segmentation ). 

13.1 Adaptive Cell Segmentation

Adaptive Cell Segmentation allows you to use algorithms that account for variations in staining and
background levels within and across images to identify cellular compartments from multiple image
planes. These features provide improved segmentation performance when images contain mixtures of cell
types with very different nuclear morphologies.

Adaptive cell segmentation consists of following steps. We recommend that you optimize the settings at
each step before moving on to the next one. 

1. Select cellular compartments and image planes to aid segmentation. See Selecting
Segmentation Components . 

2. Detect nuclear pixels using image planes associated with one or more nuclear stains. See
Detecting Nuclear Pixels .

3. Split clusters of detected nuclear pixels into individual nuclei using:

a. Image planes associated with nuclear stains (splits occur at valleys between nuclear signals).
See Splitting Nuclear Clusters Using Nuclear Component Images .

b. (optional) Image planes associated with assisting cytoplasmic or membrane stains (splits
occur at ridges of positive membrane or cytoplasmic signal). See Splitting Nuclear Clusters
Using Membrane or Cytoplasm Component Images .

4. Refine nuclear shapes. See Refining Nuclear Shapes . 

5. (optional) Define cytoplasm and membrane around all nuclei. See Defining Cytoplasm  and
Defining Membrane . 

Use the Cell Segmentation Settings panel to set parameters for segmenting cells into their respective
compartments. This allows you to extract and analyze data on a per-cell or per-compartment basis.
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13.1.1 Selecting Segmentation Components and Detecting Nuclear Pixels

Use the following steps to choose which cellular compartments to segment, configure image planes, and
detect nuclear pixels:

1. Choose which cellular compartments you want to
segment: Nuclei, Cytoplasm, and/or
Membrane. (Note: Adaptive Cell Segmentation
can only detect cells with nuclear signal, so
‘Nuclei’ cannot be unselected). You can also
choose to segment Cytoplasm and/or Membrane.
 

NOTE: We recommend that you wait to add
Cytoplasm and Membrane options until
you have optimized Nuclei detection and
splitting settings. This will reduce visual
clutter in the image. Adding those two
options later will not alter any parameter
adjustments to Nuclei settings.

Figure 53. Adaptive Cell Segmentation
Settings

2. Click the Add… button to add image components
to be used for segmentation. Then select the
image component name from the drop-down list.
Choose your strongest, most abundant nuclear
component first. You can repeat this step to
include additional nuclear, cytoplasmic, and/or
membrane components if they will aid
segmentation. Only add components that
show strong, specific staining. Adding
components with weak or nonspecific signal
can lead to undesired segmentation results.
All image components can still be analyzed
within the segmented cell compartments even if
those components are not configured to aid in
segmentation here.  

NOTE:  Priority will be given to nuclear splitting
lines that are attributed to image
components higher up in the list of
components. So we recommend you add
your strongest and most specifically
stained components first in this list. 

Figure 54. Adaptive Cell Segmentation
Components
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3. Configure each component by pressing the ‘...’
button. Select the compartment where this
component is located. 

4. For nuclear components, use the Typical
Intensity slider to adjust the threshold used to
detect nuclear pixels. This threshold is adaptive
and is measured relative to nearby background.
Increase this value if too much background is
being detected as nuclear. Lower this value if faint
nuclei are being missed. At this point, do not
focus on whether nuclei are correctly split from
each other (splitting will be addressed in
subsequent steps). Only focus on whether the
correct pixels are being detected as nuclear. 

NOTE: When adjusting the Typical Intensity
slider, you can monitor whether all the
intended pixels are being detected by
viewing only the image plane associated
with the nuclear component you are
configuring. Use the View Editor  to
change the image view. Use the
show/hide regions button to blink  the
segmentation masks on and off as
needed.

Figure 55. Adaptive Cell Segmentation
Configuration

5. Once at least one image component has been
configured, a live preview region will appear in the
current image. This preview provides live feedback
as you adjust settings such as the Typical
Intensity. Click and drag the region to preview
other areas in the image. Click and drag the
image outside the preview region to drag the
entire image. 

Figure 56. Live Preview Image

6. Click Hide Preview to hide the preview. Click
the same button to show the preview again. The
preview is only available when the selected
segmentation settings are valid. 

Figure 57. Hide Preview

25
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7. If a component belongs to the cytoplasm or
membrane, you can also select the Use this
signal to assist in nuclear splitting check box.
If that box is checked, signals in the associated
image plane will be used to generate potential
split lines within clusters of nuclei. We
recommend only checking this box for image
components that have strong, specific signals. 

NOTE: All nuclear component planes are used to
assist nuclear splitting regardless of
which other cytoplasmic or membrane
components have been selected. We
recommend you wait to check the Use
this signal to assist in nuclear splitting
box until after you optimize nuclear
splitting for nuclear component planes
first. You may also want to assess the
changes to the segmentation results after
each box is checked individually so the
added value of each component is more
obvious. 

Figure 58. Use this Signal to Assist in
Nuclear Splitting

13.1.2 Splitting Nuclear Clusters into Individual Nuclei

Clusters of nuclear pixels will be split into individual nuclei using image planes from nuclear components
and from image planes from assisting membrane and cytoplasm components (if selected).

Splitting Nuclear Clusters Using Nuclear Component Images

Use the Nuclear Component Splitting panel to adjust
splitting parameters used for image planes associated with
nuclear components:

NOTE: These settings will be applied to all nuclear
components.

Figure 59. Nuclear Component Splitting
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1. Configure the splitting sensitivity by clicking the ‘…’
button. Choose the radio button that best describes
the staining quality of all the selected nuclear planes
(you may need to experiment with this.) Then use the
slider bar to adjust the splitting threshold. Lower
values will result in more splitting. 

2. Set the Minimum Nuclear Size (in number of pixels).
Splitting lines that generate nuclei smaller than this
size will be ignored. Any isolated nuclei that are
smaller than this value will also be discarded. 

NOTE: You can position your cursor over segmented
compartments in the image to display
characteristics of the compartment, including
nuclear size. This may help you choose an
appropriate Minimum Nuclear Size.

Figure 60. Nuclear Splitting Settings

Splitting Nuclear Clusters Using Membrane or Cytoplasm Component Images

Use the Assisting Component Splitting panel to adjust
parameters for cytoplasmic and/or membrane image planes:

NOTE: These settings will be applied to all
cytoplasmic and membrane components that
were selected with the Use this signal to
assist in nuclear splitting check boxes.
This panel will only be visible if at least one
assisting component was selected. 

1. Click the ‘…’ button to configure the splitting
sensitivity. Choose the radio button that best
describes the staining quality of all the assisting
membrane and cytoplasmic planes (you may need
to experiment with this). Then use the slider bar to
adjust the splitting threshold. Lower values will result
in more splitting. 

Figure 61. Assisting Component Splitting

2. Set the Minimum Nuclear Size (in number of pixels).
The system will ignore splitting lines that generate
nuclei smaller than this size. If you are more
confident in the splitting lines generated by the
assisting components than those generated by the
nuclear components, (or if the cells that have
membrane signals tend to be smaller than those that
do not), you may want to set this value to be smaller
than the Minimum Nuclear Size selected in the
Nuclear Component Splitting panel. 

NOTE: For help choosing an appropriate Minimum
Nuclear Size, you can position your cursor
over segmented compartments in the image Figure 62. Assisting Component

Splitting Settings
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to display characteristics of the
compartment, including nuclear size. 

13.1.3 Refining Nuclear Shapes

After optimizing detection and splitting of nuclei, use the
Other Settings panel to further refine the results:

1. If you find that some nuclei contain empty
‘holes’, increase the Fill Holes Smaller Than
value until those holes are filled. 

2. If you find that the detected membrane shapes
are more jagged or angular than desired, check
the Refine cells after segmentation box to
compact the cells into rounder shapes.

Figure 63. Other Settings

13.1.4 Defining Cytoplasm

Use the Cytoplasm Settings panel to segment
Cytoplasm:

1. Adjust the Cytoplasm Thickness to define the
distance (in pixels) from the boundary of each
cell’s nucleus to the outer boundary of its
cytoplasm. For each cell, all pixels between the
nuclear boundary and the cytoplasm outer
boundary will be defined as cytoplasm. This
distance should be adjusted based on visual
inspection of the results, so that cytoplasm
segmentation approximately matches the average
size of cells.  

NOTE: Cytoplasm segmentation does not take
into account any signals from cytoplasm
component images. 

Figure 64. Cyptoplasm Settings

13.1.5 Defining Membrane

Use the Membrane Settings panel to segment Membrane:

1. Adjust the Membrane Search Distance to define the
distance (in pixels) from the boundary of each cell’s
nucleus to search for membrane signals. 

· If positive signals are detected between the
nucleus boundary and the Membrane Search
Distance, the membrane will be drawn where
the positive signal is detected.

· If no positive signal is found between the
nucleus boundary and the Membrane Search

Figure 65. Membrane Settings
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Distance, the membrane will be drawn at the
nearest of three stop points:

o Membrane Search Distance

o A neighboring cell membrane

o Cytoplasm Thickness (if Cytoplasm

segmentation was selected)

NOTE: By setting the Membrane Search Distance to
be larger than Cytoplasm Thickness, you allow
the algorithm to search a large distance for
true positive membrane signals, but to
collapse back to a smaller cell size if no
positive signals are found. For this added
flexibility, you may want to include Cytoplasm
segmentation even if you are not directly
interested in the Cytoplasm compartment.

NOTE: If the membrane is drawn at positive
membrane signals found at a distance
between the Cytoplasm Thickness and the
Membrane Search Distance, the resulting
cytoplasm will span the entire area between
the nucleus and the membrane, even if that
results in a cytoplasm thicker than the chosen
Cytoplasm Thickness value.

2. Click the ‘…’ button to configure the sensitivity of
membrane signal detection. Select the best
description of the staining quality of the configured
membrane components (you may need to experiment
with this). Then use the slider bar to adjust the
membrane detection threshold. Lower values will result
in detecting weaker signals. 

NOTE: These settings will be applied to all
components configured as ‘Membrane’.

Figure 66. Membrane Signal
Detection

NOTE: If you selected both Cytoplasm and
Membrane, you can set both via the
Membrane and Cytoplasm Settings panel.

Figure 67. Membrane and
Cytoplasm Settings
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13.2 Cell Segmentation

Use the Segment Cells panel to set parameters for segmenting cells into their respective categories so
that data can be extracted and analyzed on a per-cell basis.

To segment cells:

1. Select the desired cell components to segment: Nuclei, Cytoplasm, and Membrane. Cytoplasm
and Membrane can only be selected after Nuclei is selected. 

2. Select Discard if Touching an Edge to discard any cell where any cell component touches the
edge of the image, process region, or tissue region, if applicable. Only the cells that are entirely
within the image, a process region, if applicable, and the selected tissue category, if applicable,
are included in the segmentation map. If not selected, cells are clipped at the edge of the image
or region. If a cell is clipped at the edge of a process region or tissue category region, the size of
the nucleus or cytoplasm inside the region may be smaller that the specified Minimum Size.

3. If Nuclei is selected, click the Nuclei tab and select the desired parameters. Use the preview
window to determine the optimal parameters for segmentation. See Segmenting Nuclei  for
descriptions of the parameters.

4. If Cytoplasm is selected, click the Cytoplasm tab and select the desired parameters. Use the
preview window to determine the optimal parameters for segmentation. See Segmenting
Cytoplasm  for descriptions of the parameters.

5. If Membrane is selected, click the Membrane tab and select the desired parameters. Use the
preview window to determine the optimal parameters for segmentation. See Segmenting
Membrane  for descriptions of the parameters.

6. Click the Segment Image button to segment the current image using the selected parameters.

7. If desired, change the parameters to obtain the desired results.

8. Click the Segment All button to segment all of the images.
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13.2.1 Segmenting Nuclei

At the top of the Cell Segmentation Settings panel, select Nuclei in the Compartments to Segment
box. (You can also select Cytoplasm and Membrane if you intend to find those as well.) Click the
Nuclei tab.

Selecting a Tissue Category

Select the Tissue Category in which to find the cell
nuclei or select All Categories to find cell nuclei in all
tissue categories. Cells that are outside the chosen
category are ignored. This option only displays if
tissue has been manually or automatically
segmented.

Tissue categories of interest might be tumor regions
in oncology samples, and islet cells in pancreas
samples. 

Figure 68. Cell Segmentation Settings for
Nuclei

Selecting an Approach

· Select the Pixel-Based (Threshold) approach when

there is a reliable nuclear counterstain, and nuclear

pixels can be found by applying a simple threshold.

This approach is purely pixel-based. This approach can

also be used for other image analysis needs that can

be satisfied with a simple threshold, such as detecting

all pixels within a tissue category that stain positive for

an IHC stain.

· Select the Object-Based approach if the nuclear
counterstain does not provide consistent and specific
staining of nuclear objects, and more advanced
morphometry-based approaches are needed to detect
nuclei.

Figure 69. Cell Segmentation Approach
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Pixel and Object-Based Settings

· Auto Scale: Select Auto Scale if you want the
software to automatically scale each nuclear
counterstain component plane individually before
performing nuclei segmentation. This approach is a
good place to start, and is useful if nuclear
counterstain signals vary widely. Auto Scale is
often sufficient for fluorescence applications.

· Fixed Scale: If you need better nuclear
segmentation performance, and counterstain
signals are consistent and reliable, you might get
better results by selecting the Fixed Scale option.
(The units are in parentheses.) This requires
entering a scaling value, which can be determined
by choosing the View Component Data tool from
the toolbar and "mousing around" on the brightest
nuclei to see the signal levels of the component
being used for nuclear segmentation. Everything in
a nuclear segmentation (indicated by a green
region) should be nuclei. 

o Reduce the maximum OD or Counts value if

nuclear segmentations are smaller than the
nuclei, or if no nuclear segmentations occur
when the segmenter is finished.

o Increase the scale if segmentation is too

sensitive and is finding many objects that are
weakly stained and not nuclei. Adjust the scale
until the unwanted regions are not detected. 

Figure 70. Signal Scaling

You can further add to what you consider nuclear
pixels by including other components in the
underlying signal. Pick an individual component
signal as the primary, and then select secondary and
tertiary components if desired. Enter a minimum
signal value for each component. In Auto Scale
mode, the signal range for each component is 0 to 1.
If you selected the Fixed Scale option, the range for
each component is from 0 to 2 for OD images, 0 to
255 for 8-bit images, and 0 to the Fixed Scale value
for all other images. Also, whenever you switch
between auto scale and fixed scale, the values are
reset to zero.

Only pixels above the minimum signal value are
counted as nuclei. Using secondary and tertiary
components is primarily useful in brightfield IHC
applications where nuclear IHC stains are dark or
"intense" and substantially block the Hematoxylin
counterstain. In these cases, performing nuclear

Figure 71. Components for Nuclear
Segmentation
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segmentation on the logical intersection of the
Hematoxylin and nuclear IHC signals is more
effective. This approach does not work if the dark IHC
stains reside outside the nucleus.

Once at least one component has been selected, a
live preview region will appear in the current image.
This preview provides live feedback as you adjust
settings.

Click and drag the region to preview other areas in the
image. Click and drag the image outside the preview
region to drag the entire image.

Figure 72. Live Preview Image

Click Hide Preview to hide the preview. Click the
same button to show the preview again. The preview
is only available when the selected segmentation
settings are valid.

Figure 73. Hide Preview

Set the Minimum Size. If too many small, unwanted
structures (e.g., not nuclei) are found during
segmentation, try increasing the minimum size value.
Any nuclei that have fewer pixels than this number
are not segmented, and no associated data is
collected. If a nucleus is clipped at the edge of a
Process region or Tissue Category region, the original
size of the nucleus is used to determine if it meets
the minimum size threshold; the clipped size is
reported in the tables. For images taken at 20x
magnification, 100 is a good starting value.

If appropriate, set the Maximum Size. This is
required if you intend to select the Refine Splitting
clean-up option discussed below. This sets an upper
limit on nuclear segmentations (in number of pixels).
Nuclear segmentations larger than this number are
ignored. This can be useful if you want to ignore large
clusters of nuclei, or if there are other objects in the
classified region of interest that are not nuclei.

Figure 74. Size Range

Select Fill Holes when some nuclei end up
segmented with “holes” in them. This results from a
common effect in tissue sections where nuclei appear
hollow. Checking this check box automatically fills
holes in nuclei.

If you want only those nuclei holes that are smaller
than a certain size to be filled in, select Max. Hole
Size (pixels) and enter the maximum number of

Figure 75. Clean-up options
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pixels. Nuclei with holes that are larger than this
value are not filled.

If you select Refine Splitting, nuclei that are
touching each other are split into separate nuclei
instead of being detected as one large nucleus. This
option is available only if Maximum Size is selected.
Cell segmentation may take considerably longer
when using this function. If you do not select Refine
Splitting, nuclei that touch are detected as a single
nucleus.

Select Roundness: Minimum circularity to find
only nuclei that are more round. Zero returns any
shape. Higher decimal values (up to 1) restrict
selections to more round objects only.
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13.2.2 Segmenting Cytoplasm

At the top of the Cell Segmentation Settings panel, select the Cytoplasm check box in the
Compartments to Segment box. (Note that you must segment the nuclei in addition to segmenting
cytoplasm. inForm only searches for cytoplasm where nuclei have been found.) Click the Cytoplasm
tab.

Selecting Cytoplasm Shape Parameters

Ø Inner distance to nucleus: The distance (in pixels) from
the edge of nuclear segmentations to the inner edge of the
cytoplasm annular regions drawn around nuclei. This
buffer distance should be large enough to ensure that
imperfections in the nuclear segmentation do not lead to
signal from nuclei inadvertently becoming part of
cytoplasm signals.

Ø Outer distance to nucleus: The distance (in pixels) from
the edge of the nuclear segmentation to the outer
boundary of cytoplasm segmentation. This distance
should be adjusted based on visual inspection of the
results, so that cytoplasm segmentation approximately
matches the average size of cells. This distance can be
set large enough to include membrane signals if desired.
In this case, it is important to note that the signal
extracted from the segmenter for cytoplasm is a mixture
of membrane and cytoplasm signal.

Figure 76. Cell Segmentation
Settings for Cytoplasm

Ø Minimum Size: The minimum cytoplasm sample size (in pixels). If cytoplasm segmentations for
detected nuclei have fewer pixels than this number, those cells are excluded from the analysis.
This is common in cases where cells are tightly packed together without much space between
nuclei for cytoplasm areas to be segmented. If the cytoplasm is clipped at the edge of a Process
region or Tissue Category region, the original size of the cytoplasm is used to determine if it
meets the minimum size threshold; the clipped size is reported in the tables.
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Selecting Components to Include

You can further restrict what you consider “valid” cytoplasm
based on the underlying signal. You can pick an individual
component signal as the First, and then select a Second, a
Third, and even a Fourth components if desired, and enter a
signal range for each one. Or select "Every Component" or “Any
component” and specify a signal range. Only pixels that fall
within that signal range are counted as cytoplasm. (The signal
range varies based on image type.)

Figure 77. Cytoplasm Pixel
Validation
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13.2.3 Segmenting Membrane

At the top of the Cell Segmentation Settings panel, select the Membrane check box in the
Compartments to Segment box. (Note that you must segment the nuclei in addition to segmenting
membrane. inForm only searches for cytoplasm where nuclei have been found.) Click the Membrane
tab.

Selecting Components for Membrane Segmentation

1. Select the First component signal for membrane
segmentation. 

2. Select the Second, Third, and Fourth component if
desired.

3. For each component, set the Full Scale:

· Select an image that is typical of all of the images to
be analyzed.

· Click the Auto button to find the brightest pixels in the
image for each of the selected components. The
brightest value for each component displays in the Full
Scale box for each component. (The units can be
counts or OD.)

Figure 78. Components for
Membrane Segmentation

Specifying a Maximum Cell Size

The Distance to Membrane value specifies the maximum
size of the cells, defined here as the distance (in pixels) from
the edge of the nucleus to the outer edge of the membrane. A
value of 12 for images taken at 20x magnification is usually a
good starting value. If the algorithm is finding a membrane
that is either too large or too small based on your knowledge
of the nucleus/cell size, then try reducing (or increasing) the
Distance to Membrane value. This value limits how far from
the nucleus the algorithm is permitted to go when segmenting
the cell membrane.

Figure 79. Maximum Cell Size

Earlier versions of inForm provided a "Membrane Priority" option.  This has been set to always prioritize
membrane.  New membrane splitting options are available in Segmenting Nuclei .90
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14 Phenotyping Cells
You must have first performed cell segmentation in order to proceed with phenotyping. Naturally,
accurate cell segmentation is required in order to obtain accurate cell phenotyping. Like inForm’s tissue
segmentation features, inForm’s phenotyping feature is trainable, saving you from the burden of directly
writing algorithms and manually programming the software. 

Load a project if one is not already open in inForm, and configure the project to include the Phenotyping
step. Perform your segmentation operations if you have not already done so. When you advance to the
Phenotyping step, you will see the Phenotyping Settings to the left of the image display area.

Figure 80. After you have performed your cell segmentation, you can advance to the Phenotyping step. Here a
new phenotype is being added to a Phenotyping Schema named CK. The new phenotype is named Other and

assigned the color Gray.
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You can train multiple classifiers in the

Phenotyping step. Multiple classifiers are

recommended when phenotyping cells

identifiable as “double positive” or “triple positive”,

e.g., CD3+/CD8+/PD-1+, to improve phenotyping

accuracy. Each classifier is described by a

Phenotyping Schema, which includes a list of

possible phenotypes and an Associated View.

 

Figure 81. Phenotyping Settings for a
project with two Phenotyping Schemas.

For each Phenotyping Schema, the Associated

View drop-down list allows you to select from a

list of available Composite Views. This

Associated View will be automatically selected

when you select a Phenotyping Schema from the

drop-down list. It is helpful to choose an

Associated View that shows channels relevant to

the phenotypes you plan to include in a given

Phenotyping Schema. If you switch to a different

view, inForm will alert you and allow you to

quickly return to the Associated View using the

Show It button.

Figure 82. If you change the display to a view
other than the Associated View, inForm will alert

you.

Editing Phenotyping Schemas
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When you first add the Phenotyping step, inForm
will create an Unnamed Phenotyping Schema. 

To rename, add, or delete Phenotyping
Schemas, select Edit… in the Phenotyping
Schema drop-down to reveal the Phenotyping
Schemas Editor.

Click Rename to change the name of the
selected Phenotyping Schema.

Click Add to create additional Phenotyping
Schemas. You will be prompted to input a name
for each new Schema. After typing a name,
select OK.

NOTE: You cannot click  Phenotype All
to apply a trained classifier to all
images in a project unless you
have trained classifiers for all
existing Phenotyping Schemas.
So, we recommend that you
successfully train your first
Schema before adding another
Schema.

Click Delete to permanently remove a
Phenotyping Schema. To prevent accidental
deletion of a Schema, you will be prompted to
click the OK button in a confirmation dialog
before a Schema is permanently deleted.

Figure 83. Phenotyping Schemas Editor

Training a Phenotyping Classifier

Within each Phenotyping Schema, use the Add… button to add phenotypes to the Phenotypes list. You

can select a color for the phenotype. Selecting a phenotype Selected radio button and clicking the

Remove button will remove that phenotype. Clicking the Clear button will remove all phenotypes.

Below the phenotype selection area is the Train Classifier button and the Training table that lists each
phenotype, the number of cells of each phenotype that you have selected for training purposes, and the
total number of cells that you have selected.

Click Edit Phenotypes to assign a phenotype to a cell. Click a particular cell to bring up a drop-down
menu, allowing you to choose the phenotype and then move on.

NOTE: You need to identify at least five (5) cells in each phenotype in order to proceed. Akoya
Biosciences recommends choosing 25 or more cells of each phenotype for optimal
results. You may wish to start with a small number of cells, then add mis-classified cells
to the training set by correcting their phenotype.

You may choose cells across multiple images if, for example, you cannot find many cells of a particular
phenotype in one image. Of course, you should choose images from the same tissue or from tissue
sections that you are confident have been stained and then segmented identically or very similarly.

If you decide to Add, Remove or Clear phenotypes after you have already started training the classifier,

you will need to begin training again.
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Figure 84. Click on a cell and choose a phenotype from the drop-down menu. It
may help to turn off the visualization of the nuclei. You can also toggle back and

forth amongst the viewing modes to help identify the cell type.

You may find that turning off the visualization of the nuclei allows you to better select the cell phenotypes
that you recognize. When you are done selecting your your training cells for a given Phenotyping
Schema, click the Train Classifier button.

NOTE: The first time you train a classifier, the training step may take longer than subsequent
steps because the features that inForm has been trained to recognize are cached in
memory for use in training steps after the first time.

Once the classification process is finished, you
can move your cursor over any particular cell to
reveal the phenotype that inForm has assigned,
as well as the confidence level in percent of that
classification. You will see a phenotype and
confidence entry for each Phenotyping Schema
with a trained classifier.

Each cell's phenotype and confidence can also
be viewed in the Cell Segmentation Data table.

Figure 85. Cell phenotype and confidence.
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If you wish to correct errors in classification, you
can click Edit Phenotypes, click any particular
cell, and then choose the phenotype that you
believe to be the correct one. inForm will then
re-classify that cell at 100% confidence in your
choice and add that cell to the training set. You
can also remove cells from a training set. You
may also add correctly classified cells to the
training set by selecting their (correct)
phenotype from the drop-down menu.

Figure 86. You can remove cells from
training if you do not know which
phenotype it should belong to.

The actual parameters for classification can be viewed in the inForm log file, accessed from Help >
View Log… The parameters are logged after training and can be found in the log written on the date of
the training. The log shows the normalized non-zero coefficients used in the linear classifier for each
phenotype. Normalized coefficients are scaled by the standard deviation of the associated feature. This
puts all the coefficients on the same scale and allows comparing the relative importance of features. A
confidence level, in percent, is reported for each phenotype with 25 or more training examples. See
Appendix C: Phenotype Classification by Multinomial Logistic Regression  for a detailed description
of the phenotyping algorithm and the parameters in the log file.

153
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15 Scoring IHC or IF
After segmenting nuclei, cytoplasm, and membrane, the detected cell compartments are quantified. The
options in the Score IHC or IF Settings panel provide functionality similar to that which is done
manually or visually when users assess chromogenic immunohistochemical stain levels. The Score IHC
or IF settings specify the component thresholds and “score” the images.

1. Tissue Category - Select the tissue category to use
for scoring. Cells that are outside the chosen tissue
category are ignored. This option only displays if
tissue has been segmented. Only tissue categories
in which cells have been segmented are available. 

2. Scoring Type - There are five Histogram score
types, which are used to assess the intensity of each
label. Select a score type from the Scoring box.
Descriptions of each method are given below.

3. Compartment - Select whether you want to score
the Nuclei, the Cytoplasm, or the Membrane cell
compartment. If desired, you can score the nuclei,
save the data, and then score the cytoplasm and/or
membrane separately. The scoring data is a result of
binning a histogram of all pixels within the selected
compartment. 

4. Component - Select the component to use for
calculating scoring data. 

Figure 87. Score IHC or IF Settings

5. Threshold Max - Click the Auto button to calculate the Threshold Max for the selected
component. The Threshold Max specifies the maximum value of the Threshold sliders. If
necessary, adjust this value up or down as needed. For OD converted images, 3.0 is the
maximum possible value. 

6. Positivity Threshold - Specifies the threshold values for the selected Scoring Type. Drag the
slider, type the desired value in the text box, or click the up and down arrow buttons to change
the Positivity Threshold value. See Scoring Types  for descriptions of each Threshold.

7. Show Score Colors - If selected, the score colors display on the image and around the results
percentage text boxes. If not selected, the colors do not display on the image or around the
results percentage text boxes.

8. Change Color - Opens the Change Color window to select the colors for each bin or to restore
the default colors to the bins.

9. When you score the image(s), the results display at the bottom of the Score IHC or IF settings
panel. See Scoring Types  for descriptions of the results for each scoring type.

102
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Scoring Types

Positivity

This bins the spectrally unmixed nuclear, cytoplasm, or membrane signals into two bins, negative or
positive, with a single threshold. (See Figure 30 above.) It provides data in percent. Decreasing the
Positivity Threshold slider increases the percent positivity. 

The Score Results (Percent) box shows the negativity and positivity percentages of the cell nuclei,
cytoplasm, or membrane.

Double Positivity (2x2-bin)

Select this scoring method to classify cells, according to co-
expression, into four classes: double negative, single
positive for one marker, single positive for another marker, or
double positive. The Negativity and Positivity percentages for
each of the two markers are also shown. 

Double Positivity contains the same options as Positivity
with the addition of the following:

Second Marker Settings: Select the Compartment,
Component, Threshold Max, and Positivity Threshold for the
second marker after selecting the first marker settings.

Show Score Colors: Select the score colors to display on
the image: Double Positivity, First Marker, or Second
Marker.

To select the Double Positivity settings:

1. If the tissue has been manually or automatically
segmented, select the Tissue Category as described
above. 

2. Select Double Positivity (2 x 2-bin) in the Scoring list
box.

3. Under First Marker Settings, select the Compartment
and Component, and then click the Auto button.

4. Under Second Marker Settings, select the
Compartment and Component, and then click the
Auto button.

5. To adjust the First Marker Threshold, select First
Marker in the Histogram Results box and then adjust
the First Marker Positivity slider or type the desired
value in the Positivity text box. Positive regions are
indicated by the Single Positive 1 color. Negative regions
are indicated by the Double Negative color.

6. To adjust the Second Marker Threshold, select Second
Marker in the Histogram Results box and then adjust
the Second Marker Positivity slider or type the desired

Figure 88. Double Positivity Scoring
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value in the Positivity text box. Positive regions are
indicated by the Single Positive 2 color. Negative regions
are indicated by the Double Negative color.

7. To view the double positivity colors, select Double
Positivity in the Histogram Results box.

 0-3+ (4-bin)

This option bins spectrally unmixed signals in nuclei,
membrane, or cytoplasm into four bins. This score type can
be used to calculate H-scores with nuclear stains.

0/1+ Threshold: Specifies the value below which to include
cellular objects in the 0 bin.

1+/2+ Threshold: Cellular objects above the 0/1+ threshold
and below the 1+/2+ threshold are included in the 1+ bin.

2+/3+ Threshold: Cellular objects above the 1+/2+
threshold and below the 2+/3+ threshold are included in the
2+ bin. Cellular objects above this value are included in the 
3+ bin.

Score Results (Percent): Shows the percentage positivity
of the cell nuclei, membrane, or cytoplasm within each bin.

H-Score: The calculated H-Score of the image. The H-Score
is calculated using the percentages in each bin and ranges
from 0 to 300.

Figure 89. 0-3+ Scoring
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Ten-bin

This histogram bins the data into ten bins for more
quantitative work. The 10th Bin Nominal Level slider
specifies the ninth bin lower threshold. The other eight
thresholds are equally spaced between zero and the ninth
threshold.

The Histogram Results boxes display the percentages of
pixels falling into the bins determined by the nominal level
slider position.

Figure 90. 10-b in Scoring
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Fifty-bin

Divides signals into 50 equal bins. 

The 50th Bin Nominal Level slider specifies the lower
threshold for the 50th bin. The remaining thresholds are
equally spaced between zero and the 50th bin threshold.

For display, the 50 values are summed into 10 values, each
value being the sum of 5 bins. The actual values for all 50
individual bins display in the Score table.

Figure 91. 50-b in Scoring
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16 Counting Objects
Count Objects locates individual irregularly-shaped objects within an image field or within a selected
tissue category if tissue has been segmented. 

1. Click the Count Objects button in the step bar to display
the Object Counting Settings panel. 

2. To exclude any objects that are touching the edge of the
image, process region, or tissue region, select the
Discard Object if Touching an Edge check box.

3. If tissue has been segmented, select the Tissue
Category in which you want to find the objects. Objects
outside of the selected tissue category are not counted.
(This option only displays if the project includes a Manual
Classification or Segment Tissue step.)

4. Select the desired Approach to use to identify objects:
Object-Based or Pixel-Based (Threshold). Select the
Pixel-Based (Threshold) approach when there is a
reliable or consistent stain, and object pixels can be found
by applying a simple threshold. This approach is purely
pixel-based. Select the Object-Based approach if the
stain does not provide consistent and specific staining of
objects, and more advanced morphometry-based
approaches are needed.

5. Select the desired Signal Scaling: 

· Auto Scale: Automatically scales each component plane
individually before performing object segmentation.

· Fixed Scale: If you need better segmentation
performance, and stain signals are consistent and reliable,
you might get better results by selecting the Fixed Scale
option.

Figure 92. Object Counting Settings

6. Select the Primary component for object segmentation from the drop-down list. 

7. Adjust the Minimum Signal value for the primary component to the desired threshold value.

8. If desired, select Secondary and Tertiary components and minimum signal values.

9. To exclude objects smaller than a specific number of pixels, increase the value in the Minimum
Size (pixels) text box. 

10. To exclude objects larger than a specific number of pixels, select the Maximum Size (pixels)
check box and specify the largest object size in pixels.

11. To automatically fill holes in objects, select Fill Holes. To limit the size of the holes that are
automatically filled, select the Max Hole Size check box and specify the size in pixels of the
largest holes that should be filled.
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12. To detect objects that touch other objects as individual objects, instead of as one object, select
the Refine Splitting check box. The Maximum Size (pixels) check box must be selected to
enable this option.

13. To exclude objects based on the roundness of the object, select the Roundness check box and
specify the desired Minimum Circularity. Zero returns any shape. Higher decimal values (up to
1) restrict selections to more round objects only.

14. After processing, use the View Editor  to view the resulting data tables. You can also export
the Count Data table by advancing to the Export step (Exporting the Data ).
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17 Displaying the Extracted Data
After analyzing the images, use the View Editor  to customize the view of the images and extracted
data. These options do not change the underlying images, they only change how the images are
displayed. The options below are available in the Data Displayed list (depending on which software
configuration is installed and which steps are included in the project):

Displaying the Extracted Data

Ø Viewing the Color Image

Ø Viewing the Component Image

Ø Viewing the Composite Image

Ø Viewing Data Tables

Ø Viewing the Tissue Segmentation Data Table

Ø Viewing the Cell Segmentation Data Table

Ø Viewing the Score Data Table

Ø Viewing the Colocalization Data Table

Ø Viewing the Count Data Table

Ø Viewing the Quant Data Table

Ø Image Options

Ø Component Stats

Ø TMA Core Info

Ø Slide Info

Ø Position Stats

Ø Shape Stats

25
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17.1 Viewing the Color Image

Select Color Image in the Data Displayed list, then choose the desired options.

The following options are available for the Color
Image:

Rendering Options

· Brightness - Change the value to change the
brightness of the selected image. Lighten or
darken the image using the Brightness percentage
slider.

· Contrast - Change the value to change the
contrast between light and dark portions of the
selected image. Increase or decrease the contrast
using the Contrast percentage slider.

· Use Enhanced Contrast - Select to artificially
increase the vividness of the image.

· Use Equal RGB Color Weighting - (only for
Fluorescence images) Select to distribute the
wavelength range equally in the red, green, and
blue components. If not selected, the image
displays as it looks to the human eye.

· Reset to Default button - Click to reset the
Rendering Options back to the default settings.

Image Options - See Image Options .

Figure 93. View Editor (Color Image)
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17.2 Viewing the Component Image

Select a Component in the Data Displayed list, then choose the desired options.

The following options are available for the Component
Image:

Rendering Options

Show As:

· Brightfield - Select to display the component as
if it were conventionally stained along with a
counterstain. Stains will be displayed as DAB,
autofluorescence will be displayed as eosin, and
DAPI will be displayed as hematoxylin. This style
is available when inForm can identify a
hematoxylin or DAPI counterstain. If no
counterstain is apparent, inForm will display the
component signal only.

· Fluorescence - Select to display only the
component signal on a black background

Component Color- 

When a component is shown without its counterstain,
you can select the display color for the component.

· Black and White - Select to show the component as
a white signal against a black background.

· Color - Select to show the component in color. This
color is calculated from the spectral shape of the
component, i.e. the color you would see when viewed
through a microscope.

Scaling -

· Scale Views for each Image Individually - Select
to show each image scaled individually. Dim images
are brightened to show the components. The relative
brightness of components cannot be compared
between images.

· Scale Views Equally for All Images in the Project
- Select to show the brightness of components for
each image all scaled relative to each other. Bright
components appear bright and dim components
appear dim. All images are rescaled relative to all
images in the project whenever images are removed
from or added to the project.

Figure 94. View Editor (Component Image)

· Scale Views Based on Selected Images - Select to show the brightness of components for each
image based on the brightness range of the selected images. Bright components appear bright and
dim components appear dim. The first time the option is selected, all current images in the project are
selected. The scaling limits remain the same even if images are added to or removed from the project.
Click the Reset button to open the Scaling Image Selection Window  to change the images113
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selected to determine the scaling limits. See Scaling based on Selected Images  for the suggested
workflow.

When this option is selected, the scaling limits are saved with the algorithm and project. If the
algorithm or project is used in Batch Mode, then all images processed in the batch job use the saved
scaling limits.

NOTE: If Scale Views Based on Selected Images is selected and then changes are made to the
selected Spectra for Unmixing or to the Reported Units in the Prepare Images step, the
image scaling is reset to Scale Views Equally for All Images in the Project (default). 

Brightness - Change the value to change the brightness of the selected image. Lighten or darken the
image using the Brightness percentage slider.

Contrast - Change the value to change the contrast between light and dark portions of the selected
image. Increase or decrease the contrast using the Contrast percentage slider.

Reset to Default button - Click to reset the Rendering Options back to the default settings.

Image Options - See Image Options .

Scaling Based on Selected Images

Images with bright signals in each component, such as positive controls or positively expressing images,
should be used to scale all images in the project. 

When Scale Views Equally for All Images or Scale Views Based On Selected Images is selected,
the scaling limits are saved with the algorithm and project. If the algorithm or project is used in Batch
Mode, then all images processed in the batch job use the saved scaling limits. 

1. Load only the images of the positive controls for the images. 

2. Process the images as desired. 

3. Open the View Editor and select any component in the Data Displayed drop-down list.

4. Select the Scale Views Based on Selected Images option. The scaling limits are set based
on the positive control images that are open in the project.

5. Save the algorithm and/or the project.

6. Use the settings for batch processing by loading the algorithm or project in the Batch tab.

7. If the positive controls change, open the project and click the Reset button on the View Editor.
Select the new positive controls in the Scaling Image Selection window  to set the new
scaling limits.
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Scaling Image Selection Window

Use the Scaling Image Selection Window to choose the images used to scale the brightness of all
images in the project. The images that are brightest in at least one component are at the top of the list
and are selected by default. Images must be unmixed to be used for the scaling calculations. If an image
is not unmixed, it displays at the bottom of the list and the Select For Scaling check box is disabled.

Figure 95. Scaling Image Selection Window

Select For Scaling Check boxes - The scaling limits are calculated using all selected images. These
scaling limits are saved and used when processing images in Batch Mode.

Use the Thumbnail and Image Names to identify the images in the project. The Image Name column
also identifies images that are the brightest for each component.

Cancel button - Closes the Scaling Image Selection Window without recalculating any image scaling
limits. The limits do not change.

Done button B Recalculates the image scaling limits using the selected images and then closes the
window.
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17.3 Viewing the Composite Image

Select Composite Image in the Data Displayed list, then choose the desired options.

The following options are available for the Composite
Image:

Rendering Options

· Show As:

· Brightfield - Select to display the composite
image on a white background.

· Fluorescence - Select to display the composite
image on a black background.

· Scaling:

· Scale Views for each Image Individually -
Select to show each image scaled individually.
Dim images are brightened to show the
components. The relative brightness of
components cannot be compared between
images.

· Scale Views Equally for All Images in the
Project - Select to show the brightness of
components for each image all scaled relative to
each other. Bright components appear bright and
dim components appear dim. All images are
rescaled relative to all images in the project
whenever images are removed from or added to
the project. (Default.)

· Scale Views Based on Selected Images -
Select to show the brightness of components for
each image all scaled relative to the selected
images. Bright components appear bright and dim
components appear dim. The first time the option
is selected, all current images in the project are
selected. The scaling limits remain the same even
if images are added to or removed from the
project. Click the Reset button to open the
Scaling Image Selection Window  to change
the images selected to determine the scaling
limits. 

NOTE: If Scale Views Based on Selected
Images is selected and then changes
are made to the selected Spectra for
Unmixing or to the Reported Units in the
Prepare Images step, the image scaling
is reset to Scale Views Equally for All
Images in the Project (default). 

Figure 96. View Editor (Composite Image)
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· Display Intensity: Select True to display each
component in the composite image at the original
intensity. For example, if Component A is dimmer
than Component B, they display that way in the
composite. Select Adjustable to display each
component in the composite image at the intensity
selected on the slider.

· Display Color: Select True Color to display each
component in the calculated color from the spectral
shape of the component. Select False Color to
display each component in the selected false color.
Select the False Color using the color picker next to
each component (only visible when False Color is
selected). 

· Component check boxes: Select to display each
component. If not selected, the component does not
display. (The Intensity Slider for each component only
displays if the Display Intensity is Adjustable. The
Color Selector for each component only displays if the
Display Color is False Color.)

· Reset to Default button - Click to reset the
Rendering Options back to the default settings.

Image Options - See Image Options .

17.4 Viewing Data Tables

The data tables that are available to view are determined by the steps selected in each project. To view a
data table, select the desired table in the Data Displayed drop-down list in the View Editor . 

Changing the selections in the View Editor immediately changes the columns and rows displayed in the
table.

To sort the table, click anywhere in the desired column header. The up or down arrow in the column
header indicates the sort order of the data. If summary rows are displayed, the summary rows remain at
the top of the table.
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17.5 Viewing the Tissue Segmentation Data Table

The Tissue Segmentation Data Table is available when an algorithm contains a manual tissue
segmentation or trainable tissue segmentation step. The table provides information on the manually or
automatically segmented tissue regions. Select Tissue Segmentation Data in the Data Displayed list,
then choose the desired options under Table Contents. Each option you select adds one or more data
columns or rows to the table.

During image analysis, segmented tissue categories are assigned ID numbers. These numbers are used
in the data tables to identify the tissue category for stats such as area (pixels), area (percent), etc.

The following options are available for the Tissue
Segmentation Data Table:

Components - Select all or individual components for
which to display component statistics. Each selected
component creates one column for each component
stat selected.

Tissue Categories - Select all or individual tissue
categories for which to display data. An entry row is
created for each Region ID in the tissue category. 

Component Stats - Select the values to display for
each component signal. See Component Stats  for
descriptions of each option.

Position Stats - Select which values to display for
each segmented object. See Position Stats  for
descriptions of each option.

TMA Core Info - Select the options to include in the
data table. See TMA Core Info  for descriptions of
each option.

Shape Stats - Select the options to include in the
data table. See Shape Stats  for descriptions of
each option.

Coordinate Units - Select the unit of measure for
your table statistics, microns or pixels. This option is
only available for for imagery taken with Mantra,
Vectra 3, and Vectra Polaris.

Figure 97. View Editor (Tissue Segmentation
Data)
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17.6 Viewing the Cell Segmentation Data Table

The Cell Segmentation Data Table is available when an algorithm contains a cell segmentation step. The
table provides information on the segmented cells. Select Cell Segmentation Data in the Data
Displayed list, then choose the desired options under Table Contents. Each option you select adds a
data column or row to the table.

The table only shows statistics for cell compartments that have been segmented (nuclei, cytoplasm,
membrane). For example, if cytoplasm is not segmented, the Cytoplasm column is not included in the
table.

The following options are available for the Cell
Segmentation Data Table:

Components - Select all or individual components
for which to display component statistics. Each
selected component creates one column for each
component stat selected. If there is no data for a
component, the component will not be displayed in
the list.

Tissue Categories - Select all or individual tissue
categories for which to display data. If selected, a
Tissue Category column displays in the Cell
Segmentation table to specify the Tissue Category
for each cell. This selection does not display if
there is only one Tissue Category defined or if
there is no Segment Tissue step in the project.

Note: Rarely, small areas of tissue are not
classified by the tissue
segmentation step. Cells within
these unclassified areas are not
reported in the table.

Component Stats - Select the values to display
for each component signal. See Component
Stats  for descriptions of each option. Each
selection adds one column for each segmented
cell component and one column for the entire cell. 

For Entire Cell statistics:

· Statistics are calculated using the
segmented compartments; for example, if
cytoplasm is not segmented, the statistics
do not include that compartment in the
calculation.

· Statistics are calculated using over the
entire pixel area of the cell; so the Min stat
looks at all pixels across the available
compartments in the cell.

Figure 98. View Editor (Cell Segmentation Data)

When calculating the mean, averaging across all pixels is equivalent to taking the weighted average
of the compartment means, where the weight is the pixel area of the compartment. This can be
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verified in Excel®; computing:

Cell Mean = [(Nucleus Area * Nucleus Mean) + (Cytoplasm Area * Cytoplasm Mean) +
(Membrane Area * Membrane Mean)]/Cell Area

results in the same number as the reported Cell Mean.

TMA Core Info - Select the options to include in the data table. See TMA Core Info  for descriptions
of each option.

Position Stats - Select which values to display for each segmented object. See Position Stats  for
descriptions of each option.

Shape Stats - Select the options to include in the data table. See Shape Stats  for descriptions of
each option.

Coordinate Units - Select the unit of measure for your table statistics, microns or pixels. This option is
only available for for imagery taken with Mantra, Vectra 3, and Vectra Polaris.

The columns below are always visible in the Cell Segmentation Data table:

· Cell ID - Displays a unique ID number for each cell, based on the location of the nuclei within each
tissue category, if tissue has been segmented.

· Total Cells - The total number of cells scored in the image.

· Tissue Category Area (Pixels) - If tissue has been segmented (either automated or manual), the
area of the selected tissue category, measured in number of pixels. If there is no tissue segmenting
step, this column is the total number of pixels in the whole image. 

· Cell Density (per megapixel) - If tissue has been segmented (either automated or manual), displays
the cell density for each tissue category: the number of cells in the tissue category area / (the number
of pixels in the tissue category area / 1,000,000). If there is no tissue segmenting step, displays the
cell density for the entire image: Total cells / (the number of pixels in the image / 1,000,000).

· Phenotype and Confidence - If the algorithm contains a Phenotype Cells step, cell phenotypes and
confidence levels are automatically added to the table. If you have more than one Phenotyping
Schema, there will be a Phenotype and Confidence column for each Schema where the Schema name
is appended to the end of the column name.
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17.7 Viewing the Score Data Table

The Score Data Table is available when an algorithm contains a Score step. The available data changes
depending on the type of scoring. Select Score Data in the Data Displayed list, then choose the desired
options under Table Contents. Each option you select adds a data column to the table.

Table Contents - Select the options to include in
the data table. See TMA Core Info  for
descriptions of each option.

The columns below are always visible in the Score
Data table:

· Tissue Category - If tissue has been
segmented (either automated or manual), the
tissue category used for scoring displays in the
table. If there is no tissue segmenting step, this
column is blank.

· Tissue Category Area (Percent) - If tissue has
been segmented (either automated or manual),
the area of the selected tissue category displays
in the table. If there is no tissue segmenting
step, this column is 100% (the whole image). 

· Number of cells - The number of cells scored in
the image.

· (First) Cell Compartment - The cell
compartment used for scoring.

· (First) Stain Component - The stain used to
create the threshold for scoring.

Figure 99. View Editor (Score Data)

The following additional columns are visible when Positivity (2-bin) scoring is selected: 

· Positivity - The scored positivity.

· Positivity Threshold - The threshold value used to set the positivity.

The following additional columns are visible when Double Positivity (2x2) scoring is selected: 

· Second Cell Compartment - The secondary cell compartment used for scoring 

· Second Stain Component - The secondary stain used to create the threshold for scoring. 

· Double Negative - The percent of cells that is negative (less than the threshold) for both
components. 

· Single <Component1> - The percent of cells that is positive for component 1 and negative for
component 2. 

· Single <Component2> - The percent of cells that is positive for component 2 and negative for
component 1. 

· Double Positive - The percent of cells that is positive for both markers. 

· <Component1> Threshold - The threshold used for component 1. 
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· <Component2> Threshold - The threshold used for component 2. 

The following additional columns are visible when 0-3+ (4-bin) scoring is selected: 

· 0+ - The percentage of cells whose component strength is less than the first threshold.

· 1+ - The percentage of cells whose component strength is greater than or equal to the 0/1+ threshold
and less than the 1/2+ threshold. 

· 2+ - The percentage of cells whose component strength is greater than or equal to the 1/2+ threshold
and less than the 2/3+ threshold. 

· 3+ - The percentage of cells whose component strength is greater than or equal to the 2/3+ threshold. 

· H-score - The calculated H-Score of the image. The H-Score is calculated using the percentages in
each bin and ranges from 0 to 300.

· Threshold 0/1+ - Clicking the Auto button sets this value to 1/4 of the Threshold max. This value can
be changed.

· Threshold 1+/2+ - Clicking the Auto button sets this value to 1/2 of the Threshold max. This value
can be changed.

· Threshold 2+/3+ - Clicking the Auto button sets this value to 3/4 of the Threshold max. This value
can be changed.

The following additional columns are visible when 10-bin or 50 bin scoring is selected: 

· Bin X (where X ranges from 1-10 or 1-50 per scoring type) - Columns showing the percent of
scored values that fall in each scoring bin. The user sets the lower threshold for the last bin. The last
bin is the percent of cells whose component strength is greater than the threshold the user set. The
thresholds for the remaining bins are spaced evenly from 0. For example, the 49th bin has a lower limit
of (48 * threshold) / 49.
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17.8 Viewing the Colocalization Data Table

The Colocalization Data Tables are available when an algorithm contains a Colocalization step. Select
Colocalization Data in the Data Displayed list, then choose the desired options for each table. 

The following tables are included in  the
colocalization data:

Colocalization Table - Shows how much the
numerator components are colocated with the
denominator.

· Percent Stats - Shows the percent
colocalization (where all colocalization pixels
are positive within the selected denominator)
and the percent positivity of each selected
component in colocalization.

· Pixel Stats - Shows the actual pixel count for
the colocalization, component positivities,
and selected denominator.

In Channel Table - Shows the positivity of one
component within another for all selected
colocalization components.

· Percent Stats - Shows the percentage of
inter-component positivity.

· Pixel Stats - Shows the pixel count of the
component positivity.

Quant Table - Shows stats for the whole image
and colocalization region. 

Components - Select all or individual
components for which to display component
statistics. One column per numerator
component is shown.

Figure 100. View Editor (Colocalization Data)

Component Stats - Select the values to display for each component signal. See Component Stats
for descriptions of each option.

TMA Core Info - Select the options to include in the data table. See TMA Core Info  for descriptions
of each option.

Position Stats - Select which values to display for each segmented object. See Position Stats  for
descriptions of each option.

Shape Stats - Select the options to include in the data table. See Shape Stats  for descriptions of
each option.

Coordinate Units - Select the unit of measure for your table statistics, microns or pixels. This option is
only available for for imagery taken with Mantra, Vectra 3, and Vectra Polaris.
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17.9 Viewing the Count Data Table

The Count Data Table is available when an algorithm contains an Object Segmentation step. Select
Count Data in the Data Displayed list, then choose the desired options  under Table Contents. Each
option you select adds one or more data columns or rows to the table.

The following options are available for the Count
Data Table:

Components - Select all or individual
components for which to display component
statistics. Each selected component creates
one column for each component stat selected.

Tissue Categories - Select all or individual
tissue categories for which to display data. If
selected, a Tissue Category column displays in
the Count Data table to specify the Tissue
Category for each cell. This selection does not
display if there is only one Tissue Category
defined or if there is no Segment Tissue step in
the project.

Component Stats - Select the values to display
for each component signal. See Component
Stats  for descriptions of each option.

TMA Core Info - Select the options to include
in the data table. See TMA Core Info  for
descriptions of each option.

Position Stats - Select which values to display
for each segmented object. See Position
Stats  for descriptions of each option.

Shape Stats - Select the options to include in
the data table. See Shape Stats  for
descriptions of each option.

Coordinate Units - Select the unit of measure
for your table statistics, microns or pixels. This
option is only available for for imagery taken with
Mantra, Vectra 3, and Vectra Polaris.

Figure 101. View Editor (Count Data)
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17.10 Viewing the Quant Data Table

The Quant Data Table is available when an algorithm contains a Threshold or Colocalization step. Select
Quant Data in the Data Displayed list, then choose the desired options  under Table Contents. Each
option you select adds one or more data columns or rows to the table.

The following options are available for the Quant Data
Table:

Components - Select all or individual components for
which to display component statistics. Each selected
component creates one column for each component stat
selected.

Component Stats - Select the values to display for
each component signal. See Component Stats  for
descriptions of each option.

TMA Core Info - Select the options to include in the
data table. See TMA Core Info  for descriptions of
each option.

Position Stats - Select which values to display for each
segmented object. See Position Stats  for
descriptions of each option.

Shape Stats - Select the options to include in the data
table. See Shape Stats  for descriptions of each
option.

Coordinate Units - Select the unit of measure for your
table statistics, microns or pixels. This option is only
available for for imagery taken with Mantra, Vectra 3,
and Vectra Polaris.

Figure 102. View Editor (Quant Data)

17.11 Image Options

The Image Options below are available on the View Editor  when an image is selected in the Data
Displayed list. Select or clear the check boxes described below to show or hide maps or regions
on all images in the project. The buttons on the left side of the image display area also show or
hide the maps or regions. Show Score Colors is also accessible on the Score Settings panel. The
Equalize Display Histogram can only be shown or hidden here.

· Tissue Segmentation Map - Select to display the Tissue Segmentation Map on the image.
(Only for projects that include a Manual Classification or Segment Tissue step.)

· Nuclear Segmentation Map - Select to display the Nuclear Segmentation Map on the image.
(Only for projects that include a Segment Cells step.)

· Cytoplasm Segmentation Map - Select to display the Cytoplasm Segmentation Map on the
image. (Only for projects that include a Segment Cells step.)

· Membrane Segmentation Map - Select to display the Membrane Segmentation Map on the
image. (Only for projects that include a Segment Cells step.)
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· Show Score Colors - Select to display the Score Colors Map on the image. (Only for projects
that include a Score IHC or IF step.)

· Object Segmentation Map - Select to display the Object Segmentation Map on the image.
(Only for projects that include a Count Objects step.)

· Training Regions - Select to display the Training Regions on the image. (Only for projects that
include a Segment Tissue step.)

· Processing Regions - Select to display the Processing Regions on the image. 

· Equalize Display Histogram - Select to map the pixels so the image histogram has
approximately the same number of pixels assigned to each tonal value of the histogram. This
gives the best display of the whole dynamic range of dim and bright signals. If not selected, the
lowest 0.01% of the pixels are mapped to 0, the highest 0.01% are mapped to 255, and the
remaining pixels are linearly interpolated between those values. This prevents a few bright or
saturated pixels from skewing the display.

See Displaying the Extracted Data  for descriptions of other options available for each image type or
data table.

Shortcuts for the image views (Color, Component, and Composite) are available on the toolbar. To toggle
across displays, use the color, component, and composite buttons.

Figure 103 Image View Shortcuts
enable the quick toggle between

views and selection between
different component and

composite views.

Simulated Brightfield Views (Pathology Views)

When viewing fluorescence imagery, the  component button lets you display components in a simulated

brightfield mode (Pathology ViewsTM). Pathology Views renders fluorescence images in a manner that is
familiar to anyone trained in histopathology. displaying them as simulated H&E images or as simulated
DAB/Hematoxylin images.  Components are displayed as if you were looking at serial sections that are
single-stained.  The difference is that this method displays multiplexed stains on a single tissue section
with high contrast and perfect registration.

· Simulated H&E: Simulated Eosin (using the autofluorescence component) and simulated Hematoxylin
(using the DAPI component) are displayed against a white background. 

· Simulated DAB/Hematoxylin: Individual components are displayed as a simulated DAB stain with a
simulated Hematoxylin counterstain (from the DAPI signal) against a white background.
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To toggle between components,
click the component button located
in the upper right hand corner of
your screen . A drop-down list of all
available components will display. 
Select the component you would
like to display; the legend will
always display the currently shown
component.

You can also toggle from one
component to the next by using the
up and down arrows on your
keyboard.

For brightfield images, this button
allows you to select different
component views.

Figure 104 The component button
allows you to select simulated

brightfield views of fluorescence
images.

Fluorescence Composite Views

While inForm can open imagery containing up to 40 components, only 10 channels can be displayed at
time. When an image is first opened, inForm will default to displaying the Standard View, which is the
first 10 components designated in the scan protocol.

The composite button allows you to select
different composite views.

Please Note: inForm cannot open views
that were created using the Phenochart
software. You will need to create new
views using inForm. Views can be saved
as part of a project or algorithm.

Figure 105. Default
Composite View

Selection

The composite views editor allows you to select which components you would like to display. You can

edit existing views, create new views, and select which components to display per view. To access the

composite views editor, click the composite button and click Edit.
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Figure 106. Composite Views Editor

Editing Composite Views

Click Rename to change the name of this view.

To change which components are displayed you can select individual components from the Available
Components list displayed on the right half of the window. inForm can display up to 10 components. 
Change the color of each component by selecting any of the preset colors, or choose Custom to create
a custom color.

Click Add to create additional Views for display. You will first be prompted to name your view. After
adding a name, select OK. You can change the view name at a later time by selecting the view from the
Views list and clicking Rename. To change components, first click the checked boxes next to the name
of the components you wish to remove and then select the new components from the Available
Components list. Assign each component a desired color. There is no limit to the number of views that
can be created.

The display order of all Views can be changed. To change the location of a view, select the desired view
and click the Up and Down buttons.

To permanently remove a view, select the desired view and click the Remove button. To prevent
accidental deletion of a view, you will be prompted to click the OK button in the Removing Composite
View confirmation before a view is permanently deleted.

Viewing Composite Views

To toggle between Views, click the composite button. A drop-down list of all Views created will display.
Select the view name you want to display; the Legend shows which components are included within the
selected Composite View.
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Figure 107. The composite button
allows you to select which view to

display

You can also toggle between views by using the up and down keyboard arrows.

17.12 Component Stats

The data tables contain the options below.

· Min - Displays one column containing the minimum value of the component in each region. For
Cell Segmentation Data Table, displays one column for each cell compartment that was
segmented, and one column for the entire cell.

· Mean - Displays the mean of the component in the region. The summary line displays the
weighted mean value of the component across all regions, which is the average of the region
means, weighted by region size.

· Max - Displays the maximum value of the component in the region.

· Std Dev - Displays the standard deviation of the values for the component in the region. The
summary line displays the standard deviation of the individual means.

· Total - Displays the sum of the value of the component across all pixels in the region.

17.13 TMA Core Info

The data tables contain the options below.

· Show Core ID - If the image is of a core on a TMA slide scanned with a Vectra scanner, the
Sector, Row, Column and Field of the core display in the table. If there is no core information, the
columns contain zeros.

17.14 Slide Info

Exported Data tables will contain the Lab ID, Slide, ID, and Field ID for appropriate data formats.  These
fields are shown in the image name rather than the table display in inForm projects.

17.15 Position Stats

The data tables contain the options below. Units are in pixels.

· X Position and Y Position - The X and Y location of the center of the bounding box for the region.
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· Process Region ID - If process regions are defined for the image, displays the ID number of the
process region containing the tissue category. Displays #N/A if an object spans multiple process
regions.

· Distance from Process Region Edge (Pixels) - The distance, in pixels, from the center of this
region's bounding box to the nearest edge of the containing process region. Displays #N/A if the
distance cannot be determined.

· Category Region ID - If tissue is segmented, displays the Region ID of the tissue category the
segmented object is in. (Only available in the Cell Segmentation and Count Data Tables if tissue
has been segmented.)

· Distance from Tissue Category Edge (Pixels) - The distance, in pixels, from the segmented
object to the nearest edge of the tissue category. Note that if the distance is reported as #N/A,
this indicates that the distance is unknown or indeterminate, for example if a cell is in a tissue
region that abuts the edge of the image. The cell may be closer to the edge of the image than to
any other region in the image, so it cannot be determined whether the distance to an in-image
point would be nearer than a point that lies beyond the edge of the image. (Only available in the
Cell Segmentation and Count Data Tables if tissue has been segmented.)
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17.16 Shape Stats

The data tables contain the options below.

· Area (pixels) - The size, in pixels, of the region.

· Area (percent) - The region size as a percent of the total processed area. If there are no
processing regions, it is the total image area. Otherwise it is the total area of the processing
regions.

· Compactness - The compactness of the region. Compactness is the ratio of the area of the
region to the area of a circle (the most compact shape) having the same perimeter. A circle has a
compactness of 1. Objects that are elongated or irregular are less compact, as are objects with
irregular or reticulated edges.

· Minor Axis - The smaller of the two axes of the minimum area bounding box enclosing the region.

· Major Axis - The larger of the two axes of the minimum area bounding box enclosing the region.

· Axis Ratio - The ratio of the major axis / minor axis of the minimum area bounding box enclosing
the region.
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18 Exporting the Data
After analyzing the images, use the Export step to export images, component images, maps, and data
tables. Images are exported in the format selected in the Export Settings step. Data tables are exported

to tab-separated text files, which can be opened in Microsoft® Excel® and many other data analysis
programs. 

1. Click the Export button to display the Export
Settings panel. 

2. Click the Browse button to select or create the
desired Export Directory.

3. Select the Image Output Format you want to
export images to, either JPEG or TIFF. (Generally,
TIFFs retain more resolution and are usually larger.
JPEGs are compressed slightly and are often better
for emailing and publishing on the web.) Outputs
containing multiple image layers will be exported as
TIFFs even if you select JPEG. The outputs that may
contain multiple layers are labeled as “multi-image
TIFF”. 

4. From the Images to Export list, select the images
and maps to export. Images can be exported with or
without the maps. Exporting the images with maps
can be used with Review/Merge to view the
segmentation for all images in a batch. 

o The background for the Composite with Tissue

Segmentation Map, Composite with Cell
Segmentation Map, Composite with Scoring
Map, and Composite with All Segmentation
Maps images will be the most recently viewed
Composite View.  

o The Phenotype Map and Composite with

Phenotype Map are color images with one dot
representing each phenotyped cell. These
images will have a separate layer for each
Phenotype Schema. The Composite with
Phenotype Map image will include the
Associated View for each schema as a
background image.

See Appendix F: Composite Image and
Phenotype Map TIFF Specification .

Figure 108. Export Settings
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5. Select Pathology Views to export the components
as a set of single stain + hematoxylin counterstain
brightfield images.

6. Select the Component Images (multi-image TIFF)
option to save a multi-image TIFF file of component
data for analysis using third party analysis software.
The values in the Component images are in the units
selected in the Prepare Images step. 

See Appendix D: Akoya Biosciences TIFF File
Specification . 

7. The Tissue, Cell, and Object maps are exported in a
single, multi-image TIFF file. If there were processing
regions or regions of disinterest, a processing map is
also included. Select Segmentation Maps to export
one or more of these items. These images are
designed to be used by image processing tools; see
Appendix E: Segmentation Map TIFF
Specification  for more information.

NOTE:   In Adaptive Cell Segmentation, each
membrane object is assigned to a specific
cell, and its label will match the
corresponding nuclear label.  In all other cell
segmentation implementations, membrane is
a shared boundary, and the image will only
contain a binary map of membrane presence.

8. Select the desired Tables to Export. The tables available for export depend on which steps are
included in the algorithm or project. Data tables are exported to tab-separated text files, which

can be opened in Microsoft® Excel® and many other data analysis programs. 

9. In Table Fields to Export, select whether to export all available table data fields, or only the
fields that are visible in the table view. To select which fields are visible in the table, use the
View Editor (see Displaying the Extracted Data) .

10. Select File Name Options: If files are already saved in the selected export directory, select how
to name the new files. You can: 
- overwrite existing files if the new file names match, or 
- rename the new exported files to preserve any existing files in the export directory. 

11. If you want to replicate the directory structure of the source images to the export directory, enter
the number of directory levels to replicate in the Copy __ level(s) text box. For example, by
entering "2" in this field, data in a "CancerStudy\Sample001" directory would be exported to the
\<ExportDirectory>\CancerStudy\Sample001\ directory. This helps keep the exported images
organized. 

12. Click Export for Selected or Export for All to export the data.

The figure below shows a sample list of exported files.
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Figure 109. Exported Data Files
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19 Batch Processing
Batch Analysis processes a large number of images quickly and effectively, with just one click of the
batch Run button. Before beginning batch analysis, create and test an algorithm or project on a set of
images that is representative of the entire data set. Adjust the algorithm or project as necessary until the
images are processed as desired and then save the algorithm or project. 

Figure 110. Batch Analysis Tab

1. Click the Batch Analysis tab to configure the batch settings and select images for processing.
You are prompted to save the open project. Click Yes to save the open project or No to close
without saving. 

2. Algorithms that contain the Manual Classification step are not compatible with batch processing.
If the open project contains this step, the software will post a warning. Open a project that does
not contain steps that require user interaction, and then click the Batch tab.
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3. Select a Batch Algorithm or Project. When you first switch to the Batch panel, the Algorithm
settings are copied from the active project. You can run a batch using these settings, or click
the Browse button to select an Algorithm (.ifp) or Project (.ifr) file that contains the desired
settings. When loading a project, only the algorithm settings are used. The images from the
project are not loaded or processed.

4. If desired, select the Create separate directories for each item/image option to save the
exported files in a separate folder for each of the images or slides in the data set. This is
recommended for large batch processes that result in many data files and images.

5. Select the desired export settings to export images, component images, maps, and data tables.
Export settings are explained in detail in Exporting the Data .

6. Click the Add Images button to select images to process. Click the Add Slides button to
select slides scanned by Vectra 3 or Vectra Polaris; inForm will process all acquired
multispectral fields or inForm batch slide regions, depending on the algorithm selected.
Annotations that have been ignored or deleted will not be processed.. To load older slide imagery
from Vectra 2, hold the control button down before clicking Add Slides. If you need to change
the Vectra Data Directory you are looking at, select Change Browser Location… from the
slide browser’s gear menu.

7. If necessary, use the Remove Selected button to remove selected images or slides from the
batch or use the Remove All button to remove all of the images or slides from the batch.

8. Click the Run button. inForm processes the items one at a time and exports the specified data.

9. When the image processing is complete, click the Done button in the Batch Progress window.
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20 Merging the Data
Use the Review/Merge tab to combine the data of a completed batch run. Data tables from each field can
be merged into a single file. For example, all Cell Segmentation data from a set of batched images can
be merged into one Cell Segmentation data file.

1. After running a batch, click the Review/Merge Tab. 

2. The Batch directory defaults to the directory of the
current batch process, or the last directory used for
batch processing. Click the Browse button to choose
a different batch results directory.

3. The data sets that can be merged display in the list.
All data sets are selected by default. 

4. Review the list of data sets and select the data sets to
be reviewed:

· Select or clear the check marks in the list to include
or exclude specific data sets.

· Click the Include All button to select all data sets
in the list.

· Click the Include None button to clear the check
boxes for all data sets in the list.

5. When a data set is selected in the list, thumbnails of
the available exported images display at the bottom of
the window. Click a thumbnail to view the image in the
large image display area.

6. Review the images and optionally reprocess the data:

· Use the left or right arrow buttons next to the
Gallery thumbnails (or Merge hot keys listed
towards the bottom left) to scroll through the images
for each data set. 

· If the imagery contains areas that you would like to
exclude, you can draw regions of disinterest using
the toolbar.  

· If you would like to limit the data to a specific area
instead, you can draw processing regions.  

· Once your regions are drawn, click Re-process to
re-process the imagery using the new regions.

Figure 111. Review/Merge Tab

7. Accept or reject each data set by clicking the Yes or No button, or by using the Merge hot keys.

8. Review the images and optionally reprocess the data: When all data sets have been reviewed,
click the Merge button. Type a file name prefix to identify the new files as the merged files. The
merged data files are saved as tab separated text files in the batch directory with the specified
file name prefix followed by the name of the data table. Data from any excluded data sets are
included in the <prefix>_rejected_... files.
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21 Building Libraries
IMPORTANT: This feature works with images taken with Vectra software and with all Mantra™

images. It will not work  with fluorescence Nuance images.

There are three ways to extract the spectra from a stain or fluorophore using the Build Libraries tab:

1. Use a singly stained slide of a stain or fluorophore in the Stain Store.

Open a Digital Slide or Multispectral Field  of a singly stained slide, extract and then select an
existing stain or fluorophore in the Stain Store.

2. Use a singly stained slide of a new or custom stain or fluorophore.

Create a new stain or fluorophore in the Stain Store, open a Digital Slide or Multispectral Field of the
singly stained slide, extract and then select the new stain or fluorophore in the Stain Store.

3. Use a color image of a stain  in the Stain Store.

Open an RGB (color) image containing the new stain, convert the image to optical density (OD),
extract and then select an existing stain in the Stain Store.

Singly Stained Tissue Sections

The most precise and repeatable way of obtaining quantitative fluorescence data from tissue with multiple
fluorescence labels present is to measure and extract the signals from the individual labels in singly
stained tissue sections and store them for later use. Having an unstained tissue section is also useful for
obtaining the spectra of the autofluorescence in order to reduce or eliminate it from images of your
stained tissue.

This also applies to brightfield data obtained from slides with multiple brightfield stains applied to single
tissue sections: ideally you will also want to have slides available that have only single brightfield stains
applied to the tissue. Of course, the fluorescence technique itself allows for many more labels,
especially using Akoya Bioscience’s method of reducing or removing the confounding autofluorescence
signal from your slides. 

IMPORTANT: Akoya Biosciences imaging systems and software programs will give you optimal
results when the tissue sections have been stained well, using protocols that give
you consistent slides suitable for multilabel brightfield or fluorescence imaging.
The best results from any imaging system come from good samples. Consider
using high-quality, well-tested staining k its such as Akoya's Opal™ multiplex
reagent k its for fluorescence and a protocol developed for multilabel staining and
imaging.
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Figure 112. You should strive to utilize measured and extracted signals from singly stained slides that
you can store for later use. Left to right: multiplexed IHC stained tissue section, DAB-only stained tissue

section, hematoxylin-only stained tissue section, and Fast Red only stained tissue section.

Extracting a Stain or Fluorophore

Click the Build Libraries tab and then click the Browse button to load an image of a singly stained
sample. 

NOTE: When loading Digital Slides with inForm Project annotations, only the first annotation will be
loaded.

Once the image opens, you can use the Spectral Curves tool  and move your cursor over the
image and see the spectral curves on the right side of the window in real time. You can set the units
of the chart. Choose the stain or fluorophore from the drop-down list and click the Extract button.
Confirm that the image displayed (you can view the original Color image or the individual Component
image) is accurate, then click the Save to Store button.

30
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Figure 113. An opened DAPI image before the stain has been extracted.

Select the display color, add notes, and choose groups for your extracted stain or fluorophore before
saving it.
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Figure 114. Clicking Extract allows you to extract and save a measured single stain to the Stain Store, which
serves as your library of spectra for different stains and fluorophores.

When a brightfield image is displayed and extracted, you will only see one spectral curve to the right of
the image in the Build Libraries tab. However, when a fluorescence image is displayed, you will see as
many spectral curves as you had epi-fluorescence filter sets in use at the time of the image acquisition.

In brightfield, you may receive a message that more than one stain was detected in your particular
specimen. This is common for DAB, and has been seen in other IHC stains.  Confirm that your slide is
singly stained (without a counterstain); if so, it's safe to proceed.

To extract your next stain or fluorophore, click the Browse button to load a new image.  If you've left an
extracted stain or fluorophore unsaved, the system will prompt you before loading your next signly
stained sample.

Extracting a Custom Stain or Fluorophore

If you want to extract and save the spectra for a stain or fluorophore that does not appear in the Stain
Store (perhaps you are developing new stains or fluorophores), you can create a new custom stain or
fluorophore in the Stain Store.

Go to Tools > Stain Store Manager and click  Choose Which Types of Stains and Fluors Your Lab
Uses . Select the Other (User Specified) line under Family Name, then click the New button and
enter the Name of your new or custom stain or fluorophore. Choose whether the stain or fluorophore will
be imaged in brightfield or fluorescence and if it is a nuclear counterstain. Click OK and close the Stain
Store window.
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Figure 115. If you have a new stain or fluorophore that does not appear in the Stain Store, you can create a new
listing for one.

Select the Build Libraries tab and
click  the Load Image Browse
button. Select the image of your
singly stained slide, then chose
the name of your new/custom stain
or fluorophore in the Stain/Fluor
drop-down list.

For brightfield images, click the
Extract button, confirm the results
are accurate, then click the Save
to Store button to save the
extracted spectra to the Stain
Store.

For fluorescence images, when the
image opens, move your cursor
over the pure signal and observe
the curves that appear to the right
of the image. These display how
much of the signal appears within
each fluorescence emission ‘band’, Figure 116. In the Build Libraries tab, you can

select your new/custom stain or fluorophore in the
Stain/Fluor drop-down menu.
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corresponding to each of your epi-
fluorescence filters.

You will have as many curves as you have epi-fluorescence filters in use. The Akoya Biosciences

Mantra™ system that was used to acquire the image in Figure 76 had 5 filters, and thus 5 bands and 5
curves. From the drop-down menus, choose the Signal band where the fluor most strongly expresses
and a Dark band where the fluor does not express at all. Then click the Extract button.

Figure 117. You can use the curves to the right of your image that display the spectra under your cursor to select
the ‘Signal Band’ where the majority of the signal of your new/custom fluorophore appears, and also the ‘Dark

Band’ where there is little or no signal.

After the pure signal has been extracted, you will see a black-and-white image where the lighter pixels
represent the signal of your new/custom stain or fluorophore. Confirm that the image displayed (you can
view the original Color image or the black-and-white individual Component image) is accurate, then
click the Save to Store button.
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Figure 118. Once the spectra from your new/custom stain or fluorophore has been extracted, you can save it to
the Stain Store.

Extracting a Fluorophore with a Custom Filter

inForm has built-in settings for many manufacturers’ epi-
filter cubes. If you are using a custom filter, inForm
requires more information before extraction.

Click the Build Libraries tab and click  the Load Image
Browse button. Select the image of your singly stained
sample. Then select the fluorophore you wish to extract.

inForm will present two drop-down menus which have
been prefilled with the names of the bands used in the
image. Choose the Signal band where the fluor most
strongly expresses and a Dark band where the fluor
does not express at all. Note that your custom filter may
not be needed in these selections.

When you have made your selections, click the Extract
button. Confirm that the image displayed is accurate,
and then click the Save to Store button. Figure 119. Dark Band Drop-Down List
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Extracting a Stain from a Color Image

Occasionally you may have RGB images
from another source that you wish to
unmix using inForm. In this case you can
extract the pure signal from a color (RGB)
image of a singly-stained sample. The
image must be of high quality and not
contain multiple labels.

Select the Build Libraries tab and click
the Load Image Browse button.  If you are
loading an extremely large image, you
may be asked to bin it to reduce the size.

Select the color image (.BMP, .JPG, .TIF,
or .PNG file) of your singly stained slide
and then chose the name of the
corresponding stain  in the Stain drop-
down menu.

Using the Convert to OD tool,  select
the brightest white area in the image.
inForm will convert the image to optical
density, which is required in order to
properly quantify stain intensity.

Figure 120. When you open a color (RGB) image of a singly
stained slide, you need to select a white area in order to help

the software convert the image to optical density, which is
necessary in order to properly quantify stain intensity.

Click the Extract button and when the black-and-white image of the extracted pure signal appears,
confirm that the image displayed (you can view the original Color image or the black-and-white individual
Component image) is accurate and click  the Save to Store button.
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Figure 121. You can extract a pure signal from a color (RGB) image after it is converted to optical density, but
the resulting spectra will not be as detailed as the pure signal extracted using a multispectral .IM3 file. Note the
lack of a smooth spectral curve representing the Fast Red stain. Instead of information from many wavelengths,
a color (RGB) image only contains information for three broadly overlapping regions in the visib le wavelength

range.

Using Processing Regions

Sometimes you will get an error message when clicking the Extract button. If this occurs, you can help

the inForm algorithm extract the pure signal by using the Process Regions tool  to select areas
containing the pure signal for brightfield images and also to select areas with both the primary signal and
autofluorescence for fluorescence images.



Building Libraries 145

Figure 122. You may have a slide that contains small areas of your stain or fluorophore, and clicking the Extract
button results in an error. Click the ROI button (diagonal pencil over a green circle) and select areas to assist

the inForm extraction algorithm. You may need to select regions based on different criteria, depending on
whether your image is a brightfield or a fluorescence one.

For brightfield images, you might need to select several areas that mostly or only contain the signal that
you are interested in, avoiding large empty white areas. For fluorescence images, do not try to select
areas that just contain the signal that you are interested in. Select areas that contain both the signal and
autofluorescence, perhaps minimizing but not completely avoiding areas with large voids or no signal. Do

not hesitate to try selecting different areas: you can delete areas using the Delete button. 

You might also receive an error message if inForm detects the presence of more than one stain or
fluorophore in the sample). Although Akoya Biosciences highly recommends using singly stained slides,
perhaps you have a small amount of inadvertent contamination from other stains in your otherwise singly
stained slides. Below is an image containing a large amount of eosin and a much smaller amount of
hematoxylin. You can draw a region or regions around the tissue where just the eosin is present,
ignoring the rest of the image.
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Figure: 123. In the Build Libraries tab, you can select regions within your specimen that contain reasonably
pure spectra from a single stain. In this case pink eosin, avoiding areas where there are very small amounts of

b lue hematoxylin present.

inForm will extract what it believes to be the pure spectra and display the spectral curves to the right of a
black-and-white image. The black-and-white image represents the presence of the pure stain or
fluorophore in your sample. You can toggle back and forth amongst the Color and Component views in
order to check and verify proper selection using the View selector above the large displayed image.
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Figure 124. If there is enough of the pure spectra present for the stain or fluorophore that you chose from the
drop-down menu, inForm will show you the spectral curve that it has extracted and a b lack-and-white image

representing the presence of that stain or fluorophore.

Click the Extract button and when the black-and-white image of the extracted pure signal appears,
confirm that the image displayed is accurate and click the Save to Store button
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22 Frequently Asked Questions

I am trying to extract a pure hematoxylin signal from a singly stained slide, but
after I open the image that I took in Mantra in the Build Libraries tab in inForm, I
don’t see hematoxylin in the Stain drop-down menu. How can I add hematoxylin
to the choices?

The Stain drop-down list items in the Build Libraries tab
are populated from the Stain Store, as described in
Understanding the inForm Work Area  and Building
Libraries . 

You might not have selected hematoxylin as a stain that
your lab uses. Go to Tools > Stain Store Manager and
click  Choose Which Types of Stains and Fluors Your
Lab Uses.

Select Brightfield under Family Name and then select the
Hematoxylin check box on the right. 

Figure 125. You can add stains and
fluorophores to the Stain drop-down menu in the

inForm Build Libraries tab.

Close the Stain Store Manager and return to the inForm
Build Libraries tab. Hematoxylin will now appear in the
drop-down menu.

Of course, you can also measure new stains and
fluorophores that do not already exist in the inForm Stain
Store. See Building Libraries . 

Figure 126. Once you have selected a stain or
fluorophores in the Choose Which Types of

Stains and Fluors You Lab Uses window of the
Stain Store Manager, the stain or fluorophore will

appear in the Stain drop-down menu in the
inForm Build Libraries tab.

19
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23 Appendix A: Calculating Fractional Tissue
Area
Fractional tissue areas can be calculated from inForm data using an Excel® PivotTable. Examples of this
type of calculation are:

· Tumor load - tumor area / (tumor + stroma)

· Lung fibrosis - fibrosis area / (normal lung + normal collagen + fibrosis)

· Breast tissue lobular involution - acini area / (acini + inflammation + lobular stroma)

It is also possible to calculate tissue fractions where the numerator and denominator are different tissue
categories, such as:

· Kappa/lambda ratio in lymphoid tissue - kappa tissue area / lambda tissue area

This calculation can be performed per image or per slide with inForm (V2.0.1 or higher) and Vectra.

Initial Setup

These instructions assume that you already have an inForm algorithm capable of automatically
segmenting the tissue categories of interest, and that you have processed several images using the
algorithm and merged the tissue segmentation tables into a single table.

To compute tissue fraction by slide, you must have a column in the data table for slide ID. inForm
includes this column for Vectra images.

The instructions in this section are for Excel® 2010 and may need modification for other versions of

Excel®.

Create a PivotTable to Compute Fractional Tissue Area

To create the PivotTable:

1. Start Excel® and open the data file. In the Open dialog, select Text Files in the file type drop-
down list, then select the inForm data file. The file name should end with
“tissue_seg_data_summary.txt”. 

2. In the Text Import Wizard, if you are using a file from inForm V1.4, change the value for Start
import at row to 3. This skips the first two rows. For inForm V2.0 or higher, leave the value at 1.
Click the Finish to open the file.

3. In the Insert ribbon, click PivotTable. Leave the defaults: use the entire table and put the table
on a new worksheet. Click OK to create the PivotTable. A new, empty PivotTable opens. On the
right side, the PivotTable Field List shows all the fields in the source table.

4. Select the check box next to the name of the field to summarize by, usually Sample Name or
Slide ID. It could also be TMA row and column. The selected field is shown in the Row Labels
box and as a column in the pivot table.

5. In the PivotTable Field List, select the check box next to Tissue Category to add Tissue
Category to the Row Labels list.

6. Drag Tissue Category from Row Labels to Column Labels.
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7. Some tissue categories in the data may not be used in the tissue fraction calculation, for
example a Background category. In this case, click the drop-down list next to Column Labels
and de-select any categories that are not of interest.

8. In the PivotTable Field List, select the check box next to Area (pixel) to add Area (pixel) to the
Values box.

9. You should now have a PivotTable that shows total pixel area for each tissue category of interest
and a Grand Total. The table has one row for each Sample Name or Slide ID, depending on the
selection for Row Labels.

10. To display pixel area as a percent, right-click Grand Total and select Value Field Settings.
Select the tab Show Values As. In the drop-down list, select % of Row Total and click OK.

You should now have a pivot table that displays the percent of total area for each tissue category.
The values of interest can be read directly from the table. For example, a tumor category displays
the tumor load.

Compute a Ratio

The PivotTable does not easily display a ratio of two categories; it only shows each category as a
fraction of the total. Additional ratios can be added as new computed columns outside the pivot
table. Use explicit row/column identifiers in the formula, such as “D3”. Don’t use the

GETPIVOTDATA () function that Excel® provides if you click target cells. For example:

1. Click  the cell in the first empty column in the first data row. 

2. Type the desired formula such as “=C5/B5” and press Enter.

3. Select the entire range in the target column, starting with the cell just entered.

4. Type CTRL+D to fill the column range with the desired formula.

Saving the Table

You can save the entire Excel® workbook and/or export the PivotTable data as a text file for further
processing with other programs. If exporting the PivotTable, you may want to refine the table for
cleaner output. Below are some suggestions.

Remove the Grand Total Row at the Bottom

1. Open PivotTable Options by clicking the Options button at the left of the PivotTable Tools >
Options ribbon. 

2. In the Totals & Filters tab, deselect Show grand totals for columns.

Display Fractional Area

To display the tissue fraction as a decimal fraction rather than as a percent, click the drop-down list
next to the field name in the Values box. Select Value Field Settings. In the dialog box click
Number Format and set the desired formatting.
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Save as Tab-Separated Values

To save the file as tab-separated text:

1. In the File ribbon, choose Save As. 

2. Select Text (Tab delimited) in the Save as type drop-down list. To save as a CSV file, select
CSV (Comma delimited).

3. Type the desired file name, select the desired location, and click Save.

4. Two warning messages display. First, The selected file type does not support workbooks that
contain multiple sheets. Click the OK button. Then, “[FileName] may contain features that are
not compatible with Text (Tab delimited).” Click the Yes button.
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24 Appendix B: Auto-Processing Data
Received from Mantra Snap
New for inForm version 2.1 is auto-processing of data from the Mantra™ Quantitative Pathology Imaging
System. This allows you to capture (‘snap’) images using the Mantra workstation with the Mantra Snap
software program and have those images automatically processed in the inForm program that comes
with the workstation.

By default, each time you snap a picture using the Mantra instrument, the Mantra Snap program saves
your image to the location that you selected for your Destination folder. But Mantra Snap can also be
configured to automatically launch inForm and perform a pre-arranged operation, such as tissue and cell
segmentation and phenotyping, on each of your images—even while you continue to snap pictures.

Chose the Launch inForm Analysis option in the Post Processing editing area and the inForm program
will be launched, if it is not already running, after you snap a picture. If inForm is already running and an
algorithm is loaded, the Mantra image will be processed by inForm using that algorithm.

For example, you may be trying to develop a robust phenotyping algorithm on a set of slides or a slide
with a tissue microarray on it. You can take pictures using the Mantra instrument and Mantra Snap.
Taking the first image launches inForm, which you then use to develop an algorithm that you test by
taking more images using Mantra Snap. You can make changes to the algorithm based on the results
that inForm shows you, and then take more images with Mantra Snap, an iterative process.

After you have a robust algorithm or if you simply wish to apply the algorithm to many images as you
take them in Mantra Snap, you can select the Batch Process Using inForm option which will not bring
up the actual inForm user interface, but will run a specified algorithm (selected using the Browse…
button) on each picture you snap in the background.

Figure 127. A Mantra image was used to develop an inForm algorithm and then a second image taken on the
Mantra workstation. Immediately after clicking the Snap button, the second image has automatically been

opened in inForm and the open algorithm is being applied to the image.
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25 Appendix C: Phenotype Classification by
Multinomial Logistic Regression
inForm uses a training set, image features and machine learning to classify cells into user-defined
phenotypes. The user provides the training set. Image features are derived from texture analysis and cell

segmentation. The glmnet1 package from R2 creates the machine learning classifier. While the creation

of the classifier is complex, the result is a relatively simple multinomial logistic regression classifier3 with
softmax output. The classifier is applied to the features to assign phenotypes to cells.

This document presents the steps in this process.

Introduction

Phenotyping cells in an inForm image (or images) requires four steps:

1. Create a training set by marking up the image(s).

2. Create features from the image(s).

3. Train a classifier using features of the training set.

4. Apply the classifier to the full image(s).

The first step is controlled by the user. In the second step, inForm uses features from the cell
segmentation table and adds texture features similar to the ones used for tissue classification. In the
third step, the training set features are passed to glmnet which uses lasso regularization with cross-

validation to select features and create a model. Finally, the model is applied to the full feature table to
classify all cells.

Create a training set

The user interacts with inForm to create a training set containing representative samples of each
phenotype. This process is documented in Phenotyping Cells . The training set must contain at least
five examples from each phenotype.

Create features

inForm creates features for each cell in an image. The features come from two sources: cell
segmentation and component textures.

Cell segmentation features

The cell segmentation features consist of most of the columns in the full cell segmentation table. The
columns that are omitted, and the reasons for the omissions, are

· empty columns and columns containing only or predominantly a single value

· percents - these duplicate the non-percent data

· data specific to an image or the location of a cell within an image:

o Path

97
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o Sample Name

o Cell ID

o Cell X Position

o Cell Y Position

o Category Region ID

o Process Region ID

o Distance from Process Region Edge

o Lab ID

o Slide ID

o TMA Sector, Row, Column, Field

· Tissue Category - this might be informative but it is removed because the classifier requires
quantitative features

· Features which are exact linear combinations of other features; usually just Entire Cell Area

The number of cell segmentation features varies depending on how many components are in the image
and how many cell compartments were segmented. Each compartment contributes five morphological
features (area, compactness, minor axis length, major axis length, axis ratio) plus five features per
component (minimum, mean, maximum, standard deviation, total). If more than one compartment is
segmented, features will be created for Entire Cell as well. Thus with ncompartment > 1 compartments and

ncomponent components, the number of cell segmentation features will be approximately

(ncompartment + 1 ) * (5 + 5 * ncomponent ) - 1

With three compartments and five components, this gives (3 + 1) * (5 + 5 * 5 ) - 1 or 119 cell
segmentation features.

Refer to the inForm manual for detailed descriptions of the cell segmentation features.

Texture features

Texture features are created for each component of the image. The features are computed within a 16x16
pixel kernel placed at each possible location on a 4x4 grid across the image. The grid locations are
assigned to cells by matching the center points of the kernels with the cell segmentation masks. The
feature values for the kernels assigned to each cell are averaged to give a single value per cell for each
feature. There are 10 texture features, so this process gives 10 features per component for each cell.
With three compartments and five components, there are 50 texture features and 119 cell segmentation
features per cell, a total of 169 features.

inForm uses three kinds of texture features: spatial frequency measurements, co-occurrence features
and simple first- and second-order statistics.

Spatial frequency features

The spatial frequency features represent the relative intensity of four spatial frequency bands computed
with a two-dimensional Fast Fourier Transform. The full range of frequencies is divided into four equal
bands. The intensity within each band is summed and normalized by the total intensity of all frequencies.
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These make the FFT1, FFT2, FFT3 and FFT4 features. FFT1 represents the lowest frequency and FFT4
the highest.

Co-occurence features

Grey-level co-occurence features4 are commonly used for texture classification. They were originally

defined by Haralick et. al. (1973)5 . A detailed description of these features is beyond the scope of this
document; please refer to the references. In the language of the references, the features used by inForm
are Angular Second Moment (ASM), Entropy, Inverse Difference Moment (Homogeneity) and Contrast.
The texture features are spatially-invariant (computed in four directions) and use an offset distance of
one.

Simple statistics

The texture features include the mean and standard deviation of the component value in the kernel. To
some extent these features duplicate the mean and standard deviation features in the cell segmentation
table but they are computed differently and the values are not exactly the same.

Train a classifier

The preceding steps create a training set labeled with user-assigned phenotypes, and a feature vector for
each cell in the training set. These are given to the cv.glmnet function in the glmnet package to

create a multinomial logistic regression classifier.

cv.glmnet uses lasso regularization6 to select from the available features. Lasso regularization sets

some parameters of a regression model to zero, so it can be used for feature selection. The number of

zero parameters is controlled by a meta-parameter λ whose value is chosen by ten-fold cross-validation.

The value of λ is chosen which minimizes the cross-validation error.

The algorithm used to select features and create the classifier is complex (see Friedman et. al. (2010))
but the result is fairly simple. For each of the Κ phenotypes in the training set, glmnet constructs a

linear predictor  fi(X) = X * β i  from the available features X. Each β i is a vector whose length is the

number of features; lasso regularization forces many of the coefficients  βij to be zero. For the ith

phenotype, the probability that a cell with features X belongs to phenotype i is given by the softmax
function:

The phenotype for a cell is then taken to be the one with the highest probability, i.e. argmaxiP(i | X) The

confidence reported by inForm is the probability of the winning phenotype, P(i | X), expressed as a
percent.

Note that the confidence will always be between 1/Κ and 1. If all Κ phenotypes are nearly equally likely,
the confidence will be slightly greater than 1/Κ. If only one phenotype is likely, it will have confidence
near 1.

Apply the classifier

Given the β i parameters for each fi(X) and a set of features, it is straightforward to compute the fi(X) and

P(i | X) and select a phenotype. inForm uses the predict.cv.glmnet function of glmnet to perform

this computation and return the selected phenotype and confidence.
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Cells in the training set may be misclassified by the glmnet model. For training set cells, the model

classification is always overridden by the training set classification, and the confidence is set to exactly
1.
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26 Appendix D: Akoya Biosciences TIFF File
Specification
Background

This describes a TIFF format that Akoya Biosciences uses for its tissue images. The imagery may be a
simple RGB image, a set of components extracted from a field or region, or a whole-slide scan. In the
latter case, it may be a brightfield (BF) color RGB image or a multiband fluorescence (FL) image.

The goal is to use the same syntax and metadata for all these kinds of images, and minimize the
semantic distinctions where possible. Specifically, an extracted component represents signal attributed
to a stain or fluorescent dye in a sample. The signal values incorporate image preprocessing such as
normalization for exposure time and spectral unmixing when that technique is used.

Data format

The files are TIFF or BigTIFF images, depending on image size, with multiple images per file.

For images larger than about 2K x 2K pixels, tiled format is used, and the image is provided in several
resolutions (pyramidal tiled images).  Tile size is 512 x 512 pixels. Images smaller than 2K x 2K use
stripped format.

The highest resolution (baseline) image(s) appear first in the file. For each resolution there are N baseline
images where N depends on the contents. For BF images, N=1 and each image is an RGB image. For
FL images or unmixed component images, N = number of bands, which is usually > 1, and each image
is a grayscale image.

A thumbnail RGB image is provided, and this is a good image to use as an icon in graphical image lists.
This comes after the baseline images, meaning it is the second image in BF (RGB) images, and the
(N+1)st image for  FL images or unmixed component images.

Next come the reduced-resolution images (if present). The pyramid contains enough levels that the
image size is no larger than 2K x 2K at the coarsest resolution.

For whole-slide scans, there are two more non-tiled images after these: an optional RGB image of the
label, and a macro (low-resolution) RGB image of the whole slide. 

Overall, the arrangement is:

Table 1. Images

Description RGB/mono Title/Strip Resolution Notes

Baseline image Varies Varies Full Tiled if > 2K x 2K
RGB for BF, else mono

More full-resolution
images

Mono Varies Full If N > 1

Thumbnail RGB Stripped ~500 x 500  

Half-resolution images Varies Varies Half Only if baseline is tiled

Quarter, eighth, etc. Varies Varies Quarter,
eighth, etc.

Continues until 2K x 2K
or smaller
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Macro (overview) image
of whole slide

RGB Stripped ~2000 x 4000 Required for whole-slide
scans
Optional for simple RGB
images and extracted
components

Label image RGB Stripped ~500 x 500 Optional, whole-slide
scans

Detection

Readers can recognize Akoya tissue images via the contents of the “Software” TIFF tag (see below). 
The file suffix is .qptiff for whole slide scans. Some TIFF tags contain “PerkinElmer” for historical
reasons; they remain to retain 3rd party reader compatibility.

Metadata

Metadata is contained in two locations: within standard TIFF tags as listed in the table below, and within
the ImageDescription string, using a set of XML tags described below. These are provided for each image
(IFD) in the file, and describe that image rather than the baseline image or the scan as a whole. The
ScanProfile tag is only provided on the first, baseline image as it may be large.

Table 2. TIFF tags

TIFF Tag Optional? Description of contents

Software  Starts with “PerkinElmer-QPI”

ImageDescription  Further metadata in XML format (see next section)

ImageWidth  Width of the image in pixels

ImageLength  Height of the image in pixels

ResolutionUnit  Unit used for resolution and position (see below)

XResolution  Pixel X resolution (see below)

YResolution  Pixel Y resolution (see below)

XPosition Y Sample X location in ResolutionUnits. This is ULHC
location except for Macro image which reports its
image center.

YPosition Y Sample Y location in ResolutionUnits. This is ULHC
location except for Macro image which reports its
image center.

SampleFormat  Integer (1) for BF, FL; or float (3) for extracted
components

SMinSampleValue  Minimum signal value in the image

SMaxSampleValue  Maximum signal value in the image

BitsPerSample  8 (FL); 8, 8, 8 (RGB); or 32 (unmixed component)

SamplesPerPixel  1 (FL or unmixed component) or 3 (RGB)

NewSubfileType  0 for full-resolution images, 1 for reduced res images

TileWidth Y Tile width (512) if tiled format is used

TileLength Y Tile height (512) if tiled format is used

TileOffsets Y List of tile offsets, if tiled format is used

TileByteCounts Y Size of each (compressed) tile, if tiled format is used
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StripOffsets Y List of strip offsets, if tiled format is not used

RowsPerStrip Y Number of rows per strip, if tiled format is not used

StripByteCounts Y Size of each (compressed) strip, if tiled format is not
used

PlanarConfiguration  1 (chunky) for RGB images, 2 (planar) otherwise

PhotometricInterpretation  2 (RGB) for RGB images, 1 (BlackIsZero) otherwise

DateTime  Acquisition time

Compression  May be None, CCITT Group 3, PackBits, LZW, or
JPEG

JPEG fields Y JPEG fields are defined when JPEG compression is
used

ResolutionUnit, XResolution and YResolution are required fields in a valid TIFF file. When the true
resolution of the image is known, ResolutionUnit will be 3 (cm) and XResolution and YResolution will be
pixels/cm. When the true resolution is not known, ResolutionUnit will be 2 (inch) and XResolution and
YResolution will be 96 (pixels/inch).  Pixels from Akoya Biosciences instruments are always square so
XResolution and YResolution will always have the same value.

The TIFF spec is not explicit about the data type and value for SMinSampleValue and
SMaxSampleValue; the writer uses the same data type as the image pixels (byte or float).

Image Description contents

The ImageDescription tag contains a string in XML format. The string contains a top-level < PerkinElmer-
QPI-ImageDescription> element. Nested within this element are child elements with the tag names and
values as listed in the table below. Elements appear in the order listed. Values are stored as text content
of the element. Elements are required unless otherwise specified. See the example below.

Table 3. Image Description tags

Tag Optional? Contents

DescriptionVersion Version of the image description field itself, a single number.
This document describes version 2 of the field.

AcquisitionSoftware Software used to acquire the image

Identifier GUID in string format. This is an identifier for the image file
itself.

SlideID Y ID of the slide that this image was taken from.

Barcode Y Barcode text of the slide this image was taken from.

ComputerName Y Name of the computer on which the slide was scanned.

ImageType A string identifying the type of image within the file (Table 1),
with the following values:

· FullResolution
· ReducedResolution
· Thumbnail
· Overview
· Label

IsUnmixedComponent “True” for unmixed multispectral images, otherwise “False”.

ExposureTime Exposure time as an integer number of microseconds. 



160 Akoya Biosciences, Inc.

For unmixed images, this is the exposure time for the
dominant wavelength band for the component (FL); or the
brightest wavelength in the cube (BF).

SignalUnits A byte wwww tttt where the tttt nibble indicates the signal unit
type from the following: 

· – raw counts 
· – normalized (counts/second/gain/full-scale/binning)
· – OD (optical density)
· – dark-corrected counts

and the wwww nibble indicates how the signal is weighted
across the spectral bands (or colors):

· – average across all bands 
· – total summed signal across all bands
· – peak signal in highest-valued band

Thus, for example, a value of 68 (hex 44) encodes OD units
with peak-signal weighting.

Name Y Band name for FL whole slide scans, component name for
extracted components. Not present for RGB images

Color Y Color to use when rendering this band, as decimal r,g,b byte
triplet. Present for FL whole slide scans or extracted
components. Not present for RGB images.

Responsivity Y Instrument responsivity, if available, for FL whole-slide and
unmixed images. See below for details.

Objective Y Objective name, if known, otherwise not present.

ScanProfile Y Element containing scan and/or and unmix parameters. It is
valid XML whose contents are opaque to most readers. It is
only provided on the first (baseline) image, and is omitted from
all other IFDs.

ProtocolName Y Name of the acquisition protocol.

ValidationCode Used for internal data integrity checks – readers can ignore
this.

ImagingCycle Y Zero-based acquisition cycle for CODEX imagery

Biomarker Y String indicating target such as CD8, Ki67, etc.

ScaleFactor Y After allowing for bit-depth conversion, pixel values in this
dataset have been scaled by this factor. For example, if a 12-
bit image is stored in an 8-bit image, and counts were scaled
from 4095 to 255, this would be 1; if counts were scaled from
3102 to 255, ScaleFactor would be 1.3201. Default is 1.

AutofluorescenceSubtracte
d

Y String containing ‘true’ or ‘false’, indicating whether this dataset
has been subtraction-corrected by a background
(autofluorescence) image. Treated as ‘false’ by default.

LampType Y String with the FL lamp type
· Unknown (default)
· PriorLumen200
· PriorLumen220
· XCiteMultiBandLed
· PriorMimicLed
· SolaLed
· Colibri7

InstrumentType Y String with the instrument type, one of the following:
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· Unknown (default)
· Keyence700
· Keyence800
· AxioObserver
· Dmi8
· Polaris
· Vectra3

CameraType Y String with the camera sensor type, one of the following:
· SonyICX285AL
· HamamatsuC11440
· IMX265
· IMX421

ExcitationFilter Y Description of excitation filter with sub-elements listed below
If present, all its sub-elements must be provided.

    Name String with the filter public name

    Manufacturer String with the manufacturer or OEM supplier

    PartNo String with the manufacturer part number

    Bands Collection of bands each as described by sub-elements below

       Band Description of a band with sub-elements noted below

          Name String with the band name

          Cuton Cuton wavelength of this band in nm

          Cutoff Cutoff wavelength of this band in nm

          Active True if this band is excited, False if not

EmissionFilter Y Description of emission filter with sub-elements listed below. 
If present, all its sub-elements must be provided.

    Name String with the filter public name

    Manufacturer String with the manufacturer or OEM supplier

    PartNo String with the manufacturer part number

    Bands Collection of bands each as described by sub-elements below

       Band Description of a band with sub-elements noted below

          Name String with the band name

          Cuton Cuton wavelength of this band in nm

          Cutoff Cutoff wavelength of this band in nm

CameraSettings Y Description of the camera settings used for this image with
sub-elements listed below. 
If present, all its sub-elements must be provided

    Gain Gain factor, such as 1, 3, etc.

    Binning Binning extent, such as 1 for full-resolution, 2 for 2x2 binning

    OffsetCounts Offset count setting for the camera

    BitDepth Bit resolution used to read out the camera. This may differ from
the resolution used to store this image (for example, it may be
acquired with 12-bit resolution but saved in a QPTIFF file with
8-bit resolution)

    Orientation String containing one of the following values:
· ‘Normal’ (default)
· ‘Rotate180’
· ‘MirrorV’
· ‘MirrorH’
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    ROI Y Description of the sensor ROI contributing to the image.
Coordinates are sensor pixels before binning.
Even if the CameraSettings are provided, this field is optional

       X X origin of ROI. Left-most pixel in sensor array is 0.

       Y Y origin of ROI. Top-most pixel in sensor array is 0.

       Width Width of ROI

       Height Height of ROI

For whole slide images (BF and FL), SignalUnits will be 64 (hex 40) (raw counts, peak signal). For
unmixed images, SignalUnits will reflect the unmix settings.

Instrument Responsivity

The <Responsivity> tag is a container for a list of normalized instrument response values. This tag is
present for whole-slide FL images from Vectra Polaris and unmixed FL multispectral images originating
from Vectra 3 and Vectra Polaris.  

For whole-slide images, the <Responsivity> tag will contain one <Filter> tag. The < Filter> tag contents
will be different for each image within the TIFF file, reflecting the filter used to take the image. 

For unmixed component images, the <Responsivity> tag will contain one <Band> tag for each band in
the original image file. The <Band> tags are repeated for each unmixed component image.

The overview, thumbnail and label images do not have <Responsivity> tags.

Each <Filter> or <Band> tag describes the instrument responsivity for acquisitions using that filter or
band. The contents of the <Filter> and <Band> tags are described below.

Table 4: Contents of Filter and Band tags

Tag Contents

Name The name of the filter (whole-slide image) or band (component image) 

Response The instrument response to the reference artifact, normalized for exposure. This is raw

counts / (2bit depth × exposure time × gain × binning area), where bit depth is the bit
depth of the imagery, exposure time is in seconds, gain is the gain setting of the
camera, and binning area is 1 for 1×1, 4 for 2×2, etc.

Date The date and time of the reference image in UTC, ISO 8601 format.

FilterID Detailed description of the acquisition filter, as 
{ExcitationFilter band name}_
{ExcitationFilter manufacturer}:{ExcitationFilter part number} / 
{EmissionFilter manufacturer}:{EmissionFilter part number}

The {ExcitationFilter band name}_ prefix may be omitted if there is only a single
excitation band.

Sample ImageDescription

Sample ImageDescription for the DAPI band of a FL whole-slide image, containing a single <Filter> tag:

<?xml version="1.0" encoding="utf-8"?>
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< PerkinElmer-QPI-ImageDescription >
    <DescriptionVersion>1</DescriptionVersion>
    <AcquisitionSoftware>VectraScan 1.0.0</AcquisitionSoftware>
    <ImageType>FullResolution</ImageType>
    <Identifier>AABED946-BB58-44FB-95B3-48E177E3BB83</Identifier>
    <IsUnmixedComponent>False</IsUnmixedComponent>
    <ExposureTime>50</ExposureTime>
    <SignalUnits>64</SignalUnits>
    <Name>DAPI</Name>
    <Color>0,0,255</Color>
    <Responsivity>
      <Filter>
        <Name>DAPI</Name>
        <Response>30.7</Response>
        <Date>2015-10-22T13:10:18.0618849Z</Date>
        <FilterID>Semrock:FF02-409/LP-25 Emission / Semrock:FF01-377/50-25
Excitation</FilterID>
      </Filter>
    </Responsivity>
    <Objective>4x</Objective>
    <ScanProfile><!-- this will be a serialized scan protocol. It is valid
XML but otherwise opaque -->
    </ScanProfile>
    <ValidationCode>4281ff86778db65892c05151d5de738d</ValidationCode>
</ PerkinElmer-QPI-ImageDescription >



164 Akoya Biosciences, Inc.

27 Appendix E: Segmentation Map TIFF
Specification
inForm now exports the tissue segmentation map, the object / cell compartment label images, and a
process region label image in a single file. The file is a multi-image TIFF file where all images are 32-bit
images. The tissue segmentation map, if present, is the first image; the object or cell label images
follow, lastly the process region image, if present. Cell compartments come in order {nucleus,
cytoplasm, membrane} ; only segmented compartments are included.

Metadata about each image is stored as XML within the image’s ImageDescription tag.

Tissue Segmentation 

The tissue segmentation image is a class map; the value at each pixel is that pixel's tissue category ID.
In certain cases the class cannot be calculated, and for such pixels the value is 255. Category IDs begin
at 0.

The XML structure for the Tissue Segmentation Image Description is:

<?xml version="1.0" encoding="utf-16"?>
 <TissueClassMap>
  <Version>1</Version>
  <Entry>
   <Name>{first tissue class name}</Name>
   <Color>{alpha},{red},{green},{blue}</Color>
   <ID>{guid string}</ID>
  </Entry>
...
  <Entry>
    <Name>{last tissue class name}</Name>
    <Color>{alpha},{red},{green},{blue}</Color>
    <ID>{guid string}</ID>
  </Entry>
 </TissueClassMap>

The XML contains one <Entry> element for each tissue category. The position of the <Entry> element
corresponds to the category ID. Colors are specified as four decimal integers in the range 0-255.

Object and Cell Segmentation

The object and cell segmentation images are label images; the value of each pixel is the ID of the object
or cell which contains that pixel. The map will report 0 if no object was present; which may mean that the
area was background, or it may mean that a particular compartment was not found within that cell. The
object ID is the same as the ID reported in inForm tables. A label image can contain over 2 billion
objects.

The XML structure for both the Object and Cell Segmentation Image Descriptions is the same:

<?xml version="1.0" encoding="utf-16"?> 
 <SegmentationImage>
  <Version>1</version>
<CompartmentType>{type}</CompartmentType>  
 </SegmentationImage>
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 where {type} is Nucleus, Cytoplasm, or Membrane for cells, or "Object" for object segmentation.

Process Regions

The process region image is a label image; the value of each pixel is the ID of the process region which
contains that pixel. The map will report 0 if no region was present, which means that portion of the image
was not processed. The region ID is the same as the ID reported in inForm tables.

The XML structure for the Process Region Image Description is:

<?xml version="1.0" encoding="utf-16"?>
<ProcessRegionImage>
<Version>1</Version>
</ProcessRegionImage>



166 Akoya Biosciences, Inc.

28 Appendix F: Composite Image and
Phenotype Map TIFF Specification
inForm exports Composite Images, Composite with Phenotype Map images, and Phenotype Map
images as multi-image TIFFs where all images are 8-bit RGB images. The Composite Image has one
layer for each Fluorescence Composite View. The Composite with Phenotype Map and Phenotype Map
images have one layer for each Phenotyping Schema.

Metadata about each image layer is stored as XML within the image’s ImageDescription tag. The XML
structure for the Image Description is:

<?xml version="1.0" encoding="utf-16"?>
<ImageDescription>
 <Version>1</Version>
 <PhenotypeSchema>
  <Name>{phenotyping Schema name}</Name>
  <Phenotypes>
   <Entry>
    <Name>{phenotype name}</Name>
    <Color>{alpha},{red},{green},{blue}</Color>
   </Entry>
   { ...other entries }
  </Phenotypes>
 </PhenotypeSchema>
 <Composite>
  <Name>{composite view name}</Name>
  <Components>
   <Entry>
    <Marker>{marker name}</Marker>
    <Color>{alpha},{red},{green},{blue}</Color>
   </Entry>
  { ...other components }
  </Components>
 </Composite>
</ImageDescription>

The XML contains one <Entry> element in the <Phenotypes> block for each phenotype possibility in that
Phenotyping Schema, and one <Entry> element in the <Components> block for each component
included in that Fluorescence Composite View. Colors are specified as four decimal integers in the range
0-255.
If an image has no composite view, only the PhenotypeSchema block is included; if it has no phenotype
map, only the Composite block is included. 
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29 Appendix G: Adaptive Cell Segmentation
Tips
This section contains tips for Adaptive Cell Segmentation.

What is Adaptive Cell Segmentation?

Adaptive Cell Segmentation allows you to use algorithms that account for variations in staining and
background levels within and across images to identify cellular compartments from multiple image
planes. These features provide improved segmentation performance compared to previous versions of
inForm when images contain mixtures of cell types with very different nuclear morphologies. With inForm
2.4, you can segment individual immune and cancer cells in densely packed, complex morphologies,
including areas with lots of inflammation, for more accurate multi-parameter cell identification and spatial
analysis using the new cell segmentation capabilities of inForm®. 

With inForm version 2.4, now you can:

· Segment highly varying tumor and lymphocyte nuclei, when nuclei differ in size, density, and
homogeneity, and when there is background signal.

· More accurately segment individual nuclei in densely packed fields of lymphocytes and when cells
are a complex mix of immune and cancer cells, compared to previous versions of inForm.

· Include markers in addition to DAPI to identify nuclei.

· Optimize segmentation with a move-able real-time preview window.

Considerations Before Use

· Adaptive cell segmentation should only be used when commencing new projects.

· Projects developed and saved using inForm 2.3 that include cell segmentation cannot be opened
using inForm 2.4.

· If you want to apply new inForm 2.4 functionality to an existing project, save the project developed
using v2.3 with post-segmentation image analysis steps removed. Then it can be opened in
inForm 2.4.

Steps for Adaptive Cell Segmentation

Configure New Project

1. Select the Adaptive Cell Segmentation radio-button in the Find Features column.

NOTE: The classic Object-based cell segmentation algorithm is still available using inForm 2.4,
but the Counterstain-base option is no longer available.
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Figure 128. Configure Project - Adaptive Cell Segmentation

Choose Which Cellular Compartments to Segment

NOTE: As with previous versions, the adaptive cell segmentation algorithm can only detect cells
with nuclear signal.

1. If you choose to segment the membrane compartment, we highly recommend also segmenting
the cytoplasm. 

2. To reduce visual clutter, turn off the membrane and cytoplasm segmentation masks until after
optimizing the nuclear splitting.

Add Nuclear Stains

NOTE: We recommend choosing the strongest, most abundant nuclear component first. In
many cases, this will be the DAPI stain. 

1. Click the Add… button to add stains to be used for segmentation. 

2. Configure the DAPI signal by clicking the ‘…’ button.

o New with inForm 2.4, when you start a configuration, a live preview region displays in the

current image. This preview provides immediate feedback as you adjust parameters throughout
the segmentation steps. 

o The window area is set and cannot be changed, but it can be dragged to any area within the

tissue image. To zoom in on the window, use the scroll function of the mouse or select the
Zoom button.

o The Live Preview Window provides immediate feedback as segmentation parameters are

adjusted with each step. The dotted red circle indicates where to choose which cellular
compartments to segment. Red arrows indicate required selections for DAPI configuration.
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Figure 129. Live Preview - DAPI Configuration Window

a. Use the Typical Intensity Slider to adjust the threshold until you have detected all
pixels expressing nuclear signals. This step is ONLY to collect signal you believe is real
for the field-of-view at hand. 

NOTE: We recommend turning off all other stains during this step. It may be easier to
switch to the simulated brightfield pathology view. 

NOTE: Moving the Typical Intensity Slider left (lower value) collects more signal from
faint nuclei (see Figure 74). Moving slider right (higher value) collects less signal
(see Figure 75). Yellow boxes indicate regions of DAPI signal that may require
fine tuning to determine validity for serial section analysis. Red arrows indicate
settings requiring configuration for DAPI detection.

· Moving the slider left (lower value) collects more signal from faint nuclei.
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Figure 130. Slide Left - Lower Value - Settings Requiring Configuration

· Moving the slider right (higher value) collects less signal from faint nuclei.

Figure 131. Slider Right - Higher Value

3. If smaller nuclei are being missed, an adjustment to the Minimum Nuclear Size setting is
required - this can be adjusted in the Nuclear Component Splitting panel.

Multiple Nuclear Stains

With inForm 2.4, it is now possible to select more than one nuclear signal for segmentation. For
example, FoxP3, with strong staining, can at times cover the DAPI signal. With previous versions of
inForm, this could result in the cell not being detected. Using adaptive cell segmentation, you can have
the confidence that all cells expressing a nuclear stain are identified.

1. Click the Add button to add additional nuclear stains to be used for segmentation. 

2. Click the ‘…’ button to configure the stain.

NOTE:   It is possible to select more than one nuclear signal for segmentation. For example,
FoxP3, with strong staining, can at times block  the DAPI signal. Yellow circles indicate
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regions of FoxP3 signal. Red arrows indicate required selections for FoxP3
configuration.

a. Use the Typical Intensity (Relative) Slider to adjust the threshold until you have detected all
pixels expressing nuclear signals.

· Moving the slider right (higher values) reduces the amount of splitting.

· Moving the slider left (lower values) increases the amount of splitting.

Figure 132. Multiple Nuclear Stains

Split Nuclear Clusters into Individual Nuclei 

It is now possible to describe the quality of the nuclear stain. This will permit better splitting of cells,
especially when the nuclear stain is non-homogeneous with holes.

1. After you have identified all the nuclear stains and captured all pixels expressing nuclear signal,
use the Nuclear Component Splitting panel to adjust splitting parameters. 

2. Configure the nuclear splitting sensitivity by clicking the ‘…’ button.

NOTE:  Moving the Nuclear Splitting Settings Slider right (higher value) reduces the amount of
splitting (see Figure 77). Moving the slider left (lower value) increases the amount of
splitting (see Figure 78). Red arrows indicate the settings requiring configuration for
nuclear splitting.

a. Use the Nuclear Splitting Settings Slider to adjust the splitting threshold:

· Moving the slider right (higher values) reduces the amount of splitting.
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Figure 133. Slider Right - Higher Values

· Moving the slider left (lower values) increases the amount of splitting.

Figure 134. Slider Left - Lower Values

We recommend optimizing this step before identifying assist markers.

Select Membrane or Cytoplasm Stains to Aid Nuclear Segmentation

NOTE:  When cells are highly clustered, the use of membrane or cytoplasm stains may become
necessary to better split individual nuclei.

Add Membrane or Cytoplasm Stains

1. Select the Cytoplasm and Membrane check boxes. Choose stains that can best assist your
nuclear staining.

· We recommend adding the strongest and most specifically stained membrane components
first. The assist segmentation algorithm gives priority to nuclear splitting lines that are
attributed to image components higher up in the list of components to be segmented. Please
note, for successful segmentation, not all components need to be selected to aid nuclear
splitting.

· We recommend optimizing splitting before adding the next component.

NOTES:   With adaptive cell segmentation, having a ‘pan immune marker’ such as CD45 may
result in better identification of all immune cells.
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Cytoplasm segmentation does not take into account any signals from identified
cytoplasm components. Pixels to designate cytoplasm are identified based on
proximity to nuclear edge, within the user-selected distance, and inside of membrane
compartment.

Configure the Component

1. Click the ‘…’ button next to the first added stain.

2. Select the cellular compartment that will find the stain’s signal and then select the Use this
signal to assist in nuclear splitting check box.

NOTE:   A membrane stain can be used to both assist nuclear splitting and to segment the
membrane compartments. It places rings around segmented nuclei according to user-
selected parameters, as per Segment Cytoplasm .

3. Repeat for other added stains.

Split Using Membrane or Cytoplasm Stains

1. Use the Assisting Component Splitting panel to adjust parameters. This panel is only
available when the Use this signal to assist in nuclear splitting check box has been selected.

NOTE:  Moving the Assisting Component Splitting Settings Slider right (higher value) reduces
the amount of splitting. Moving the slider left (lower value) increases the amount of
splitting. Yellow boxes indicate tumor regions where nuclear splitting is affected by
assist marker; the stroma remains unaffected. Red arrows indicate settings requiring
configuration for the assisting component.

a. Use the Assisting Component Splitting Settings Slider to adjust the splitting threshold:

· Moving the slider right (higher values) reduces the amount of splitting.

Figure 135. Slider Right - Higher Value

· Moving the slider left (lower values) increases the amount of splitting.

175
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Figure 136. Slider Left - Lower Values

NOTE:  Adjustment of the splitting sensitivity will affect all markers you have selected
to assist in nuclear splitting.



Appendix G: Adaptive Cell Segmentation Tips 175

Further Refinement of Nuclear Shapes 

1. In the Other Settings panel, it is possible to further refine the nuclear segmentation results. This
setting is “on” by default.

· Any nuclei with an empty hole can be filled in by increasing the ‘Fill Holes Smaller Than’
value.

· We generally recommend selecting the Refine cells after segmentation option, which rounds
out sharp edges on the nuclear segmentation mask in addition to compacting the nuclear
compartment slightly.

Segment Cytoplasm 

1. Adjust the Cytoplasm Thickness setting to define the distance (in pixels) from the boundary of
each cell’s nucleus to the out boundary of its cytoplasm.

NOTE: The Cytoplasm Settings panel is only available when the Cytoplasm compartment has
been selected for segmentation.

· With many samples, we find a Cytoplasm Thickness setting of 6 (pixels) works well, but
adjust accordingly. This distance should be adjusted on visual inspection of the results, so
that cytoplasm segmentation approximately matches the average size of cells.

Segment Membrane

NOTE: The Membrane Settings panel is only available when the Membrane compartment has
been selected for segmentation.

1. Set the Membrane Search Distance. 

a. Adjust the Membrane Search Distance to define the distance (in pixels) from the boundary
of each cell’s nucleus to search for membrane signals.

· The Membrane Segmentation algorithm will detect or define the membrane compartment
based on detected peak signals between the edge of the nucleus and the Membrane
Search Distance. If no significant peak signal is detected, the membrane is set to the
nearest stop point:

o (a) Membrane Search Distance

o (b) Neighboring Cell Membrane 

o (c) Cytoplasm Thickness, if Cytoplasm segmentation was selected. If Cytoplasm

Segmentation is not selected, (c) becomes half of the search distance.

· When segmenting the membrane compartment, we strongly recommend selecting the
cytoplasm for segmentation. The default membrane segment will collapse to the nucleus
if no peak signals are found, with a distance determined by the Cytoplasm Thickness.
This is particularly helpful with lymphocytes with no membrane signal, or have a small
cytoplasm compartment.
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· The interface requires that the Membrane Search Distance is set larger than the
Cytoplasm Thickness, so the algorithm can search for signal over larger distances, but
collapse back to a smaller nuclear size if no signals are found.

Figure 137.Membrane Search Distance
and Cytoplasm Thickness

· With many samples, we find a Membrane Search Distance of 20 (pixels) works well, but
adjust accordingly.

2. Configure the Membrane.

a. Click the ‘…’ button.

NOTE:   It is now possible to describe the quality of the membrane stain. This will permit
better splitting of cells, especially when the membrane stain is discontinuous or
non-specific.

b. Use the slider to adjust the membrane detection threshold:

· Moving the slider to the right (higher value) collects less signal.

· Moving the slider to the left (lower value) collects more signal from weaker membrane
signals.

Figure 138. Membrane Detection Threshold

Please follow the youtube link below to watch a video demonstrating each step of the
inForm 2.4 adaptive cell segmentation process:

https://www.youtube.com/watch?v=VAX92f2ar-M&feature=youtu.be

https://www.youtube.com/watch?v=VAX92f2ar-M&feature=youtu.be
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Additional Tips and Tricks

1. What signals are used when configuring the splitting threshold?

· The Nuclear Component Splitting panel only uses stains configured for the nuclear
compartment.

· The Assisting Component Splitting panel only uses stains where the Use this signal
to assist in nuclear splitting check box is selected.

2. Only when a user chooses to segment the cytoplasm and membrane will the membrane and
cytoplasm settings show. We recommend having the cytoplasm component selected when
segmenting the membrane as this helps to increase the search distance for the membrane stain
ridge.

3. How does the Minimum Nuclear Size found in the Nuclear Component Splitting and Assisting
Component Splitting panels differ?

· The Minimum Nuclear Size found in Nuclear Component Splitting plays two roles:

o Before any splitting occurs, any individual islands of nuclear pixels that are smaller

than this value are discarded.

o When splitting based on nuclear components (i.e., splitting due to a valley in DAPI

intensity), no individual splits are made that create nuclei smaller than this value.

· The Minimum Nuclear Size found in Assisting Component Splitting has one role:

o When splitting based on membrane/cytoplasm components (i.e., splitting due to a

peak in membrane intensity), no individual splits are made that create nuclear
smaller than this value. If no membrane signal is found overlaying a particular
island of nuclear pixels, this parameter does not matter, defaulting to settings in
the Nuclear Component Splitting. 

o If the nuclear signal is patchy, you might want to keep the minimum size in

Nuclear Component Splitting large to avoid getting a large tumor nucleus split
into many tiny nuclei. At the same time, if you’re confident in the membrane
staining, you could make the minimum size in Assisting Component Splitting
much smaller so you’re allowed to split very dense immune cells into smaller
objects using the membrane signal. That way you can keep your larger tumor cells
from being over-split while the immune cells can be more aggressively split by
membrane-assist.
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30 inForm® Software End User License
Agreement
The follow ing is an agreement (the "Agreement") betw een you and Akoya Biosciences, Inc., 100 Campus Drive, 6th Floor,

Marlborough, MA 01752 ("Akoya") for softw are know n as Research Use Only inForm®, including any updates, upgrades or

enhancement provided by Akoya and any and all accompanying documentation (collectively, the "Softw are"). 

AKOYA IS WILLING TO LICENSE THE SOFTWARE TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT ALL OF

THE TERMS CONTAINED IN THIS AGREEMENT. PLEASE READ THE TERMS CAREFULLY BEFORE USING THE SOFTWARE,

AS INSTALLING AND/OR USING THE SOFTWARE WILL INDICATE YOUR AGREEMENT TO THEM. IF YOU DO NOT AGREE

TO ALL OF THE TERMS AND CONDITIONS IN THIS AGREEMENT, AKOYA IS NOT WILLING TO LICENSE THE SOFTWARE

TO YOU, AND YOU (1) MAY NOT USE THE SOFTWARE AND (2) MUST CONTACT AKOYA WITHIN THREE (3) DAYS OF

RECEIPT TO ARRANGE FOR THE RETURN OF THE SOFTWARE. BY INSTALLING AND/OR USING THE SOFTWARE, YOU

ALSO REPRESENT AND WARRANT THAT YOU HAVE THE AUTHORITY TO AGREE TO AND BE BOUND BY THE TERMS OF

THE AGREEMENT.

1. Single Use License.  The Softw are is licensed to you and not sold, and you acknow ledge that there is no transfer of title

or ow nership of the Softw are to you.  Subject to the terms and conditions of this Agreement and your payment of the license

fees for the Softw are, Akoya hereby grants to you a restricted, non-exclusive, non-transferable, non-assignable, non-

sublicensable and revocable single-use license to use, for your internal research purposes only, the executable code

version of the Softw are and the accompanying documentation in hard copy or electronic format.  Akoya grants no other

licenses hereunder, except for the Research Use Only inForm® Softw are set forth above. Nothing in this Agreement shall be

construed as a general internal use license. For the avoidance of doubt, no right to use inForm® in Diagnostic Applications is

granted under this Agreement. Akoya RESERVES ALL RIGHTS NOT EXPRESSLY GRANTED BY THIS AGREEMENT.

2. Specific Restrictions.  As betw een the parties, Akoya ow ns all right, title and interest, including all existing or future

copyrights, trademarks, tools, know -how , and processes, in and to the Softw are and any copies, modif ications, alterations

or derivative w orks thereof.  You shall have no title to or ow nership of the Softw are. As betw een the parties, Akoya shall

retain all rights to market, license and/or sell the Softw are. The Softw are (including accompanying documentation) constitutes

the unpublished confidential information and trade secrets of Akoya.  You (i) acknow ledge, and agree not to contest, Akoya's

rights in the Softw are; and (ii) agree not to disclose and to take reasonable steps to protect any and all confidential

information of Akoya regarding the Softw are or that is otherw ise disclosed to you in connection w ith this Agreement.  You

agree that you are responsible for ensuring your employees and agents are prohibited from taking any action otherw ise

prohibited to you under this Agreement and to notify Akoya promptly and in w riting of the circumstances surrounding any

possession, use or know ledge of the Softw are or any part thereof know n to you w hich is prohibited hereunder. You

recognize that the covenants contained in this Agreement are reasonable and necessary to protect the legitimate interests of

Akoya, that Akoya w ould not have entered into this Agreement in the absence of such covenants, and that your breach or

threatened breach of such covenants shall cause Akoya irreparable harm and signif icant injury, the amount of w hich shall be

extremely diff icult to estimate and ascertain, thus making any remedy at law  or in damages inadequate. Therefore, you agree

that Akoya shall be entitled, w ithout the necessity of posting any bond or security, to the issuance of injunctive relief by any

court of competent jurisdiction enjoining any breach or threatened breach of such covenants and for any other relief such

court deems appropriate. This right shall be in addition to any other remedy available to Akoya at law  or in equity.

3. Ownership of Software.  As betw een the parties, Akoya ow ns all right, title and interest, including all existing or future

copyrights, trademarks, tools, know -how , and processes, in and to the Softw are and any copies, modif ications, alterations

or derivative w orks thereof.  You shall have no title to or ow nership of the Softw are. As betw een the parties, Akoya shall

retain all rights to market, license and/or sell the Softw are. The Softw are (including accompanying documentation) constitutes

the unpublished confidential information and trade secrets of Akoya.  You (i) acknow ledge, and agree not to contest, Akoya's

rights in the Softw are; and (ii) agree not to disclose and to take reasonable steps to protect any and all confidential

information of Akoya regarding the Softw are or that is otherw ise disclosed to you in connection w ith this Agreement.  You

agree that you are responsible for ensuring your employees and agents are prohibited from taking any action otherw ise

prohibited to you under this Agreement and to notify Akoya promptly and in w riting of the circumstances surrounding any

possession, use or know ledge of the Softw are or any part thereof know n to you w hich is prohibited hereunder. You

recognize that the covenants contained in this Agreement are reasonable and necessary to protect the legitimate interests of
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Akoya, that Akoya w ould not have entered into this Agreement in the absence of such covenants, and that your breach or

threatened breach of such covenants shall cause Akoya irreparable harm and signif icant injury, the amount of w hich shall be

extremely diff icult to estimate and ascertain, thus making any remedy at law  or in damages inadequate. Therefore, you agree

that Akoya shall be entitled, w ithout the necessity of posting any bond or security, to the issuance of injunctive relief by any

court of competent jurisdiction enjoining any breach or threatened breach of such covenants and for any other relief such

court deems appropriate. This right shall be in addition to any other remedy available to Akoya at law  or in equity.

4. Termination.  The license granted in Section 1 above is effective until terminated.  This Agreement is conditioned upon

your continued compliance w ith the terms and conditions hereof and w ill terminate automatically w ithout notice from Akoya if

you fail to comply w ith any term or condition of this Agreement.  Furthermore, Akoya may terminate this Agreement at any

time upon thirty (30) days’ notice.  Upon termination of this Agreement, your license to use the Softw are or any part thereof

shall immediately terminate, and you shall immediately destroy all copies of the Softw are (including all accompanying

documentation) and any other confidential and proprietary information you have received during or in connection w ith this

Agreement. Termination of this Agreement by Akoya shall not entitle you to a refund of any fees paid for the license of the

Softw are.

5. Limited Warranty.  The sole and exclusive w arranty applicable to softw are and f irmw are products provided by Akoya

for use w ith a processor is as follow s: Akoya w arrants that such softw are and f irmw are w ill substantially conform to

Akoya's documentation and program manuals current at the time of shipment to you w hen properly installed on the

processor. The limited w arranty set forth above shall not apply if  the claimed problem or issue is caused by: the malfunction

of computer hardw are or softw are not provided by Akoya; your negligence or fault; your failure to follow  the instructions set

forth in the documentation; changes in the hardw are or other softw are not authorized by Akoya; modif ications or changes to

the Softw are not made or suggested by Akoya; or your failure to implement and maintain a proper backup and recovery

system. Your exclusive remedy under this Section 5 shall be, at Akoya's option, the replacement or correction of the problem

or issue causing the non-conformance w ith the above w arranty as promptly as possible follow ing notice of such non-

conformity, or a refund of the price paid for the Softw are.

6. No Other Warranties.  EXCEPT FOR THE LIMITED WARRANTY STATED IMMEDIATELY ABOVE AND TO THE MAXIMUM

EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, AND

AKOYA EXPRESSLY DISCLAIMS ANY AND ALL IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION ANY WARRANTY

OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT OF THIRD PARTY RIGHTS. 

AKOYA DOES NOT REPRESENT OR WARRANT THAT THE RESULTS OR THE USE OF THE SOFTWARE WILL BE CORRECT,

ACCURATE OR RELIABLE, WILL MEET YOUR REQUIREMENTS, OR THAT THE SOFTWARE WILL OPERATE UNINTERRUPTED

OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. Some jurisdictions do not allow  the exclusion

of implied w arranties, so the above disclaimer may not apply to you. YOU ASSUME ALL RISK ASSOCIATED WITH THE USE,

RESULTS, AND PERFORMANCE OF THE SOFTWARE. 

7. Limitation of Liability. IN NO EVENT SHALL AKOYA, ITS AFFILIATES OR SUPPLIERS, OR THEIR RESPECTIVE

EMPLOYEES, OFFICERS OR AGENTS, BE LIABLE FOR ANY DAMAGES ARISING OUT OF THE DELIVERY, INSTALLATION,

PERFORMANCE, OR USE OR INABILITY TO USE THE SOFTWARE, INCLUDING WITHOUT LIMITATION INCIDENTAL, SPECIAL,

CONSEQUENTIAL, PUNITIVE, EXEMPLARY, INDIRECT OR DIRECT DAMAGES (INCLUDING WITHOUT LIMITATION DAMAGES

FOR LOSS OF PROFITS, LOSS OF DATA, RE-RUN TIME, INACCURATE INPUT, WORK DELAYS, BUSINESS INTERRUPTION OR

ANY OTHER COMMERCIAL DAMAGES OR LOSSES), WHETHER IN AN ACTION IN CONTRACT, TORT (INCLUDING

NEGLIGENCE AND STRICT LIABILITY) OR OTHERWISE, AND EVEN IF AKOYA HAS BEEN ADVISED OF THE POSSIBILITY OF

SUCH DAMAGES, AND REGARDLESS OF WHETHER ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE.  AKOYA’S

AGGREGATE LIABILITY ARISING OUT OF OR RELATING TO THIS AGREEMENT, FOR ANY AND ALL DAMAGES THAT YOU

MIGHT INCUR (REGARDLESS OF THE FORM OF ACTION GIVING RISE TO SUCH LIABILITY, WHETHER IN CONTRACT, TORT

OR OTHERWISE) SHALL NOT EXCEED THE PRICE PAID BY YOU FOR THE LICENSE OF THE SOFTWARE.  Some jurisdictions

do not allow  the exclusion or limitation of liability for consequential or incidental damages. In such jurisdictions, our liability is

limited to the greatest extent permitted by law , or the amount you paid for your purchase, w hichever is less.

8. U.S. Government End Users.  The Softw are qualif ies as commercial computer softw are for purposes of the Federal

Acquisition Regulations (FAR) §52.227-19 and the Department of Defense Supplement to the FAR (DFARS) §52.227.7013.  If
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the Softw are is acquired by a civilian government agency, it is furnished w ith only the minimum Restricted Rights provided by

FAR 52.227-19.  If  the Softw are is acquired by a military agency, it is furnished w ith only the minimum Restricted Rights

provided by DFARS 52.227-7013(c)(1)(ii).

9. Miscellaneous.  This Agreement contains the entire agreement of the parties w ith respect to the subject matter hereof

and supersedes any proposal or prior agreement, w ritten or oral, and any other communications betw een the parties relating

to the subject matter hereof.  No modif ication or w aiver of any provision of this Agreement shall be effective unless in w riting

and signed by the parties.  No delay or failure on the part of any party in exercising any right under this Agreement shall

impair any such right or any remedy of such party, nor shall it be construed to be a w aiver of any continuing breach or

default under this Agreement. No action, regardless of form, arising out of the transactions contemplated herein may be

brought by either party more than one (1) year after the cause of action has accrued. In the event any provision of this

Agreement is held to be unenforceable, the remaining provisions of this Agreement w ill remain in full force and effect.  This

Agreement shall be governed by the law s of the State of Delaw are w ithout regard to principles of conflicts of law s.  Any

disputes relating hereto shall be adjudicated only in any court of competent jurisdiction in the State of Delaw are, and you

hereby consent to the exclusive jurisdiction of those courts. This Agreement shall not be governed by the United Nations

Convention on Contracts for the International Sale of Goods, the application of w hich is expressly excluded.  You may not

assign or otherw ise transfer this Agreement or any of your rights or obligations therein w ithout the prior w ritten consent of

Akoya.  You may not use the Softw are for any unlaw ful purpose nor export or re-export the Softw are except as authorized

by law .

10. TIFF module: This softw are uses the LibTIFF 4.0.6 library (http://remotesensing.org/libtif f /) 

The TIFF module used is Copyright © 1988-1997 Sam Leff ler Copyright © 1991-1997 Silicon Graphics, Inc. 

Permission to use, copy, modify, distribute, and sell this softw are and its documentation for any purpose is hereby granted

w ithout fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the softw are and

related documentation, and (ii) the names of Sam Leff ler and Silicon Graphics may not be used in any advertising or publicity

relating to the softw are w ithout the specif ic, prior w ritten permission of Sam Leff ler and Silicon Graphics. 

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE,

INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR

CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR

PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING

OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

11. This software uses the Vigra 1.6.0 library (http://hci.iwr.uni-heidelberg.de/vigra/)

This softw are includes machine-executable object code generated by a source language processor from the Vigra libraries

covered by the VIGRA license. These libraries have not been modif ied by Akoya and all rights are reserved by the copyright

holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its suitability for any

purpose.

The Vigra library is Copyright © 2008, Ulrich Kothe, Heidelberg Collaboratory for Image Processing

The VIGRA License

=================

(identical to the MIT X11 License)

Permission is hereby granted, free of charge, to any person obtaining a copy of this softw are and associated documentation

 f iles (the "Softw are"), to deal in the Softw are w ithout restriction, including w ithout limitation the rights to use, copy, modify,
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merge, publish, distribute, sublicense, and/or sell copies of the Softw are, and to permit persons to w hom the Softw are is

furnished to do so, subject to the follow ing conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Softw are.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND EXPRESS OR IMPLIED, INCLUDING BUT NOT

LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN

NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,

WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE

SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

12. This software uses the Boost 1.53.0 library (http://www.boost.org/ )

This softw are includes machine-executable object code generated by a source language processor from the Boost libraries

covered by the Boost license. These libraries have not been modif ied by Akoya and all rights are reserved by the copyright

holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its suitability for any

purpose.

The Boost license is reproduced below :

Boost Softw are License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the softw are and

accompanying documentation covered by this license (the "Softw are") to use, reproduce, display, distribute, execute, and

transmit the Softw are, and to prepare derivative w orks of the Softw are, and to permit third-parties to w hom the Softw are is

furnished to do so, all subject to the follow ing:

The copyright notices in the Softw are and this entire statement, including the above license grant, this restriction and the

follow ing disclaimer, must be included in all copies of the Softw are, in w hole or in part, and all derivative w orks of the

Softw are, unless such copies or derivative w orks are solely in the form of machine-executable object code generated by a

source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT

LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-

INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE

FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN

CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

13. This software uses the Quan 1.0.0 library (https://lists.sourceforge.net/lists/listinfo/quan-matters)

This softw are includes machine-executable object code generated by a source language processor from the Quan libraries

covered by the Boost license. These libraries have not been modif ied by Akoya and all rights are reserved by the copyright

holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its suitability for any

purpose.

14. This software uses the CommandLine 1.6.0.0 library (http://commandline.codeplex.com)

This softw are makes use of the CommandLine libraries. These libraries have not been modif ied by Akoya and all rights are

reserved by the copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as

to its suitability for any purpose.  The libraries are covered by the MIT License.
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The MIT License is reproduced below :

The MIT License (MIT)

Copyright (c) 2005 - 2012 Giacomo Stelluti Scala

Permission is hereby granted, free of charge, to any person obtaining a copy of this softw are and associated documentation

files (the "Softw are"), to deal in the Softw are w ithout restriction, including w ithout limitation the rights to use, copy, modify,

merge, publish, distribute, sublicense, and/or sell copies of the Softw are, and to permit persons to w hom the Softw are is

furnished to do so, subject to the follow ing conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Softw are.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT

LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN

NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,

WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE

SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

15. This software uses the log4net libraries (http://logging.apache.org)

This softw are makes use of the log4net libraries. These libraries have not been modif ied by Akoya and all rights are reserved

by the copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its

suitability for any purpose.  The libraries are covered by the Apache License.

The Apache License is reproduced below :

Apache License

Version 2.0, January 2004

http://w w w .apache.org/licenses/

 TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

 1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of

this document.

"Licensor" shall mean the copyright ow ner or entity authorized by the copyright ow ner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under

common control w ith that entity. For the purposes of this definition, "control" means (i) the pow er, direct or indirect, to cause

the direction or management of such entity, w hether by contract or otherw ise, or (ii) ow nership of f if ty percent (50%) or

more of the outstanding shares, or (iii) beneficial ow nership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modif ications, including but not limited to softw are source code,

documentation source, and configuration f iles.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not

limited to compiled object code, generated documentation, and conversions to other media types.
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"Work" shall mean the w ork of authorship, w hether in Source or Object form, made available under the License, as indicated

by a copyright notice that is included in or attached to the w ork (an example is provided in the Appendix below ).

"Derivative Works" shall mean any w ork, w hether in Source or Object form, that is based on (or derived from) the Work and

for w hich the editorial revisions, annotations, elaborations, or other modif ications represent, as a w hole, an original w ork of

authorship. For the purposes of this License, Derivative Works shall not include w orks that remain separable from, or merely

link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any w ork of authorship, including the original version of the Work and any modif ications or additions

to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright

ow ner or by an individual or Legal Entity authorized to submit on behalf of the copyright ow ner. For the purposes of this

definition, "submitted" means any form of electronic, verbal, or w ritten communication sent to the Licensor or its

representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue

tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work,

but excluding communication that is conspicuously marked or otherw ise designated in w riting by the copyright ow ner as "Not

a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of w hom a Contribution has been received by

Licensor and subsequently incorporated w ithin the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a

perpetual, w orldw ide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative

Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or

Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a

perpetual, w orldw ide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to

make, have made, use, offer to sell, sell, import, and otherw ise transfer the Work, w here such license applies only to those

patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of

their Contribution(s) w ith the Work to w hich such Contribution(s) w as submitted. If  You institute patent litigation against any

entity (including a cross-claim or counterclaim in a law suit) alleging that the Work or a Contribution incorporated w ithin the

Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for

that Work shall terminate as of the date such litigation is f iled.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, w ith or

w ithout modif ications, and in Source or Object form, provided that You meet the follow ing conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modif ied f iles to carry prominent notices stating that You changed the f iles; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and

attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative

Works; and

(d) If the Work includes a "NOTICE" text f ile as part of its distribution, then any Derivative Works that You distribute must

include a readable copy of the attribution notices contained w ithin such NOTICE file, excluding those notices that do not

pertain to any part of the Derivative Works, in at least one of the follow ing places: w ithin a NOTICE text f ile distributed as part

of the Derivative Works; w ithin the Source form or documentation, if  provided along w ith the Derivative Works; or, w ithin a

display generated by the Derivative Works, if  and w herever such third-party notices normally appear. The contents of the

NOTICE file are for informational purposes only and do not modify the License. You may add Your ow n attribution notices

w ithin Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that

such additional attribution notices cannot be construed as modifying the License.
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You may add Your ow n copyright statement to Your modif ications and may provide additional or different license terms and

conditions for use, reproduction, or distribution of Your modif ications, or for any such Derivative Works as a w hole, provided

Your use, reproduction, and distribution of the Work otherw ise complies w ith the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherw ise, any Contribution intentionally submitted for inclusion in

the Work by You to the Licensor shall be under the terms and conditions of this License, w ithout any additional terms or

conditions. Notw ithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement

you may have executed w ith Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names

of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing

the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law  or agreed to in w riting, Licensor provides the Work (and each

Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either

express or implied, including, w ithout limitation, any w arranties or conditions of TITLE, NON-INFRINGEMENT,

MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the

appropriateness of using or redistributing the Work and assume any risks associated w ith Your exercise of permissions

under this License.

8. Limitation of Liability. In no event and under no legal theory, w hether in tort (including negligence), contract, or otherw ise,

unless required by applicable law  (such as deliberate and grossly negligent acts) or agreed to in w riting, shall any

Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any

character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages

for loss of goodw ill, w ork stoppage, computer failure or malfunction, or any and all other commercial damages or losses),

even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to

offer, and charge a fee for, acceptance of support, w arranty, indemnity, or other liability obligations and/or rights consistent

w ith this License. How ever, in accepting such obligations, You may act only on Your ow n behalf and on Your sole

responsibility, not on behalf of any other Contributor, and only if  You agree to indemnify, defend, and hold each Contributor

harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such

w arranty or additional liability.

16. This software uses the bzip2 program and libbizip2 libraries (http://www.bzip.org)

This softw are makes use of the bzip2 program and associated libbzip2 libraries. The program and libraries have not been

modif ied by Akoya and all rights are reserved by the copyright holder. This softw are is provided "as is" w ithout express or

implied w arranty, and w ith no claim as to its suitability for any purpose.  The libraries are covered by the follow ing license.

The bzip2 license is reproduced below :

This program, "bzip2", the associated library "libbzip2", and all documentation, are copyright (C) 1996-2006 Julian R Sew ard. 

All rights reserved.

Redistribution and use in source and binary forms, w ith or w ithout modif ication, are permitted provided that the follow ing

conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the follow ing disclaimer.

2. The origin of this softw are must not be misrepresented; you must not claim that you w rote the original softw are.  If  you

use this softw are in a product, an acknow ledgment in the product documentation w ould be appreciated but is not required.

3. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original softw are.
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4. The name of the author may not be used to endorse or promote products derived from this softw are w ithout specif ic prior

w ritten permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT

NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Julian Sew ard, Cambridge, UK.

jsew ard@bzip.org

bzip2/libbzip2 version 1.0.4 of 20 December 2006

17. This software uses the libjpeg-turbo 1.5.0 library  (http://libjpeg-turbo.virtualgl.org)

This softw are makes use of the libjpeg-turbo library. This library has not been modif ied by Akoya and all rights are reserved

by the copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its

suitability for any purpose. The library is covered by the libjpeg-turbo License. Additionally libjpeg-turbo incorporates parts of

libjpeg w hich is covered by the BSD license.

The libjpeg-turbo license is reproduced below :

Redistribution and use in source and binary forms, w ith or w ithout modif ication, are permitted provided that the follow ing

conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the follow ing disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the follow ing disclaimer

in the documentation and/or other materials provided w ith the distribution.

- Neither the name of the libjpeg-turbo Project nor the names of its contributors may be used to endorse or promote products

derived from this softw are w ithout specif ic prior w ritten permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS", AND ANY EXPRESS OR

IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR

TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

 The BSD for libjpeg license is reproduced below :

The authors make NO WARRANTY or representation, either express or implied, w ith respect to this softw are, its quality,

accuracy, merchantability, or f itness for a particular purpose.  This softw are is provided "AS IS", and you, its user, assume

the entire risk as to its quality and accuracy.

This softw are is copyright (C) 1991-2010, Thomas G. Lane, Guido Vollbeding.
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All Rights Reserved except as specif ied below .

Permission is hereby granted to use, copy, modify, and distribute this softw are (or portions thereof) for any purpose, w ithout

fee, subject to these conditions:

(1) If  any part of the source code for this softw are is distributed, then this README file must be included, w ith this copyright

and no-w arranty notice unaltered; and any additions, deletions, or changes to the original f iles must be clearly indicated in

accompanying documentation.

(2) If  only executable code is distributed, then the accompanying documentation must state that "this softw are is based in

part on the w ork of the Independent JPEG Group".

(3) Permission for use of this softw are is granted only if  the user accepts full responsibility for any undesirable

consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any softw are derived from or based on the IJG code, not just to the unmodif ied library.  If  you use

our w ork, you ought to acknow ledge us.

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating to this

softw are or products derived from it.  This softw are may be referred to only as "the Independent JPEG Group's softw are".

We specif ically permit and encourage the use of this softw are as the basis of commercial products, provided that all

w arranty or liability claims are assumed by the product vendor.

18. This software uses the zlib1 1.2.8 library (http://www.zlib.net)

This softw are makes use of the zlib1 library. This library has not been modif ied by Akoya and all rights are reserved by the

copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its suitability

for any purpose. The library is covered by the zlib1 License.

The zlib 1 license is reproduced below :

(C) 1995-2012 Jean-loup Gailly and Mark Adler

This softw are is provided 'as-is', w ithout any express or implied w arranty.  In no event w ill the authors be held liable for any

damages arising from the use of this softw are.

Permission is granted to anyone to use this softw are for any purpose, including commercial applications, and to alter it and

redistribute it freely, subject to the follow ing restrictions:

1. The origin of this softw are must not be misrepresented; you must not claim that you w rote the original softw are. If  you use

this softw are in a product, an acknow ledgment in the product documentation w ould be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original softw are.

3. This notice may not be removed or altered from any source distribution.

19. This software may use the RServeCLI2 library (https://github.com/SurajGupta/RserveCLI2)

Original w ork Copyright (c) 2011 Oliver M. Haynold and other contributors.

Modif ied w ork Copyright (c) 2013 Suraj Gupta

All rights reserved.
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 Redistribution and use in source and binary forms, w ith or w ithout modif ication, are permitted provided that the follow ing

conditions are met:

  * Redistributions of source code must retain the above copyright notice, this list of conditions and the follow ing disclaimer.

  * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the follow ing disclaimer

in the documentation and/or other materials provided w ith the distribution.

  * Neither the name of the copyright holder(s) nor the names of its contributors may be used to endorse or promote products

derived from this softw are w ithout specif ic prior w ritten permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER(S) BE LIABLE FOR ANY DIRECT,

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

OF THE POSSIBILITY OF SUCH DAMAGE.

Should you have any question concerning this Agreement, you may contact Akoya by writing to Akoya

Biosciences, 100 Campus Drive, 6th Floor, Marlborough, MA 01752. You may also call +1 855-896-8401.
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Index

- 0 -

0-3+ (4-bin), scoring     104

- A -

About inForm     7

Adaptive Cell Segmentation     82

Defining Cytoplasm     87

Defining Membrane     87

Detecting Nuclear Pixels     83

Refining Nuclear Shapes     87

Selecting Segmentation Components     83

Splitting Nuclear Clusters     85

Adding images to a project     47

Algorithm     11, 46

Definition     11

Opening     46

Saving     46

Auto scale     91

Available Images Window     27

- B -

Batch processing     133

- C -

Calculating Fractional Tissue Area     149

Categories, adding     68

Cell segmentation (classic method)     89

Cell segmentation data, viewing     117

Cell segmentation, overview     82

Cell segmention, adaptive     82

Classifying Tissue    

automatically     68

manually     65

Colocalization     80

Colocalization data, viewing     121

Color Image view     110

Compartment     102

Component data    

Viewing     109

Component for scoring     102

Component units     61

component view     111

Components for training     70

Composite Image, viewing     114

Contact Akoya Biosciences     18

Count data, viewing     122

Counting objects     107

Cytoplasm, segmenting    

adaptive cell segmentation method     87, 94

classic cell segmentation method     94

- D -

Data    

Displaying extracted     109

Exporting     130

Merging     135

Viewing tables     115

Down-sample     53

Drawing Processing Regions     51

Drawing training regions     69

- E -

Editing masks     75

Excel     149

Export settings     130

Exporting the data     130

Extracted Data, viewing     109

- F -

Features     8

Fifty-bin, scoring     106

Fixed scale     91

Fractional Tissue Area, calculating     149

- I -

ID number     51

IF scoring     102

IHC scoring     102

Image    

Displaying     109
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Image    

Format     52

Viewing     49

Image analysis tasks, summary of     40

Images    

Adding to a project     47

Adding to a training set     73

Opening     47

Opening in a project     47

inForm window     19

Inner distance to nucleus     94

Installing inForm     12

Introduction to inForm     7

- K -

Key Terms     11

- L -

License, activating     13

- M -

Masks, editing/re-training     75

Membrane, segmenting    

adaptive cell segmentation method     87

classic cell segmentation method     96

Merging the data     135

Minimum size     94

- N -

New project     41

New Project Window     28

Nuclear Clusters, splitting     85

Nuclear Pixels, detecting     83

Nuclei, segmenting     90

- O -

Object-based approach     90

Objects, counting     107

Online documentation     12

Open    

Algorithm     46

Project     44

Opening images     47

Opening images in a project     47

Outer distance to nucleus     94

- P -

Percent total area     149

PivotTable     149

Pixel-based approach     90

Positivity, scoring     103

Printed documentation     12

Processing Regions     47

Deleting     51

Drawing     51

Project     11

Adding images     47

Creating New     41

Definition     11

Open     44

Opening images     47

- Q -

Quant data, viewing     123

- R -

Region ID number     51

Removing images from a project     47

Re-training     75

- S -

Sample format     53

Saving    

algorithms     46

Scale Views Based on Selected Images     111

Scale Views Equally for All Images in the Project    
111

Scale Views for each Image Individually     111

Scaling Image Selection window     111

Score data, viewing     119

Scoring IHC or IF     102

Scoring type     102
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Segmenting adaptive cell segmentation components  

 
 83

Segmenting cells     82

Segmenting membrane     96

Segmenting nuclei     90

Segmenting tissue     68

Select Reported Units     61

Sorting tables     115

Specifications     8

Spectral library    

viewing     60

Spectral Library window     29

Spectral Region     11

Splitting Nuclear Clusters into Individual Nuclei     85

Support, Technical     18

Supported image formats     7

- T -

Tables, viewing     115

Technical Support     18

Ten-bin, scoring     105

Threshold     77

Threshold maximum     102

Tissue    

automatically classifying     68

manually classifying     65

Tissue Category    

Definition     11

For scoring     102

Tissue segmentation     68

Tissue segmentation data, viewing     116

Tissue Segmenter, definition     11

Tissue Segmenter, training     70

Training regions, drawing     69

Training Set    

Adding images     73

Training the tissue segmenter     70

Transferring the license     13

- U -

Units    

library     30

User interface     19

- V -

View Editor     25

- W -

Weighting     61

Welcome     6
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